Multiple Choice Questions, COPA - Semester-1

Dr.V.Nagaradjane

December 27, 2017
# Contents

1 **Semester 1**

1.1 **Basic hardware and software**
1.1.1 History of computers .................................................. 1
1.1.2 Types of computer ....................................................... 3
1.1.3 Advantages of computers ............................................. 4
1.1.4 Application of computers ............................................ 5
1.1.5 Concept of hardware and software .................................. 5
1.1.6 Computer hardware .................................................... 5
1.1.7 Output devices ......................................................... 8
1.1.8 Central Processing Unit (CPU) ....................................... 10
1.1.9 Computer software .................................................... 16

1.2 **Computer Administration** ............................................. 24
1.2.1 Booting error signals ................................................ 25
1.2.2 BIOS settings ......................................................... 25
1.2.3 Installation of windows operating system ....................... 26
1.2.4 Common computer problems and solutions ....................... 26

1.3 **MS DOS and Linux** ................................................... 28
1.3.1 MS DOS ............................................................... 28
1.3.2 Internal DOS commands .............................................. 28
1.3.3 External DOS Commands .......................................... 30
1.3.4 Output redirection in MS DOS ..................................... 32
1.3.5 Wild cards in MS DOS .............................................. 32
1.3.6 Open Source Software (OSS) ...................................... 32
1.3.7 Linux shell commands .............................................. 33
1.3.8 Special characters in Linux ........................................ 37

1.4 **MS Word** ............................................................... 39
1.4.1 Introduction to various application in MS Office ............... 39
1.4.2 Features of MS Word ............................................... 39
1.4.3 Office button in MS Word ........................................ 40
1.4.4 Menus and toolbars in MS Word .................................. 40
1.4.5 Creating & saving a document in MS Word ..................... 49
1.4.6 Inserting objects in MS Word ..................................... 51
1.4.7 Inserting Macros in MS Word ..................................... 51
1.4.8 Creating mail merge in MS Word .................................. 52
1.4.9 Creating templates in MS Word ................................... 53
1.4.10 Page setup & printing in MS Word ............................... 53

1.5 **MS Excel** .............................................................. 56
1.5.1 Data types in MS Excel ............................................. 56
1.5.2 Cell referencing ....................................................... 57
1.5.3 Categories of functions in MS Excel ................................ 57
1.5.4 Sorting in MS Excel .................................................. 64
1.5.5 Filtering in MS Excel ................................................ 65
1.5.6 Validation in MS Excel .................................................. 65
1.5.7 Charting in MS Excel .................................................... 65
1.5.8 Data tables in MS Excel ............................................... 66
1.5.9 Pivot table .............................................................. 66
1.5.10 Goal seek in MS Excel .............................................. 67
1.5.11 Scenarios in MS Excel ............................................... 67
1.6 Powerpoint ............................................................... 69
1.6.1 Introduction to PowerPoint ......................................... 69
1.6.2 Advantages of Powerpoint ......................................... 69
1.6.3 Creating Slide Shows ............................................... 69
1.6.4 Fine tuning the presentation ....................................... 70
1.6.5 Good presentation techniques ..................................... 71
1.7 OpenOffice ............................................................... 73
1.7.1 Introduction to Open Office ....................................... 73
1.7.2 Image properties ..................................................... 73
1.7.3 Image types .......................................................... 74
1.7.4 Editing of images ..................................................... 75
1.8 Database Management Systems ................................. 77
1.8.1 Data, Information and Database ................................. 77
1.8.2 Overview of popular databases systems .................... 77
1.8.3 Rules for designing good tables .................................. 80
1.8.4 Integrity rules and constraints in a table ..................... 81
1.8.5 Relationships in tables ............................................. 81
1.8.6 Introduction to various types of Queries and their uses .... 82
1.8.7 Designing Access Reports and Forms ......................... 83
1.8.8 Macros in MS Access .............................................. 85
1.9 Networking ............................................................... 86
1.9.1 Computer Networks, Necessity and Advantages ............. 86
1.9.2 Client Server and peer to Peer networking concepts ....... 86
1.9.3 Concept of Proxy Server and proxy firewall server ......... 87
1.9.4 Network topologies ................................................ 87
1.9.5 Network components ............................................. 88
1.9.6 Network Cables ..................................................... 89
1.9.7 Wireless networks .................................................. 89
1.9.8 Bluetooth technology ............................................. 90
1.9.9 OSI 7 Layer Model ................................................ 90
1.9.10 Various Network protocols ..................................... 91
1.9.11 Logical and Physical Addresses ............................... 94
1.9.12 Classes of Networks ............................................. 94
1.9.13 Network Security & Firewall .................................. 94
1.9.14 DHCP Server ....................................................... 95
1.9.15 Internet ............................................................. 95
1.9.16 Introduction to the Internet ..................................... 95
1.9.17 Introduction to WWW ........................................... 96
1.9.18 Web Browsers ..................................................... 96
1.9.19 Internet servers ................................................... 97
1.9.20 Search engines .................................................... 97
1.9.21 Domain naming Systems ....................................... 97
1.9.22 E-mail ............................................................. 98
1.9.23 Video chatting tools ............................................. 99
1.9.24 VOIP .............................................................. 100
1.9.25 Social Media ........................................................ 100
Chapter 1
Semester 1

1.1 Basic hardware and software

1.1.1 History of computers

1. Logarithm was invented by ___________.
   (a) John Napier
   (b) Edmund Gunter
   (c) Blaise Pascal
   (d) Charles Babbage

2. Mechanical calculator was invented by ___________.
   (a) John Napier
   (b) Edmund Gunter
   (c) Blaise Pascal
   (d) Charles Babbage

3. Slide rule was invented by ___________.
   (a) John Napier
   (b) Edmund Gunter
   (c) Blaise Pascal
   (d) Charles Babbage

4. First general purpose computer was invented by ___________.
   (a) John Napier
   (b) Edmund Gunter
   (c) Blaise Pascal
   (d) Charles Babbage

5. The first computer was invented by Charles Babbage was called ___________.
   (a) slide rule
   (b) difference engine
   (c) ENIAC
   (d) calculator

6. ___________ is called father of modern computers.
   (a) John Napier
   (b) Edmund Gunter
   (c) Blaise Pascal
   (d) Charles Babbage

7. Difference engine used ___________ for input.
   (a) punched card
   (b) DVD
   (c) hard disk
   (d) floppy disk

8. Difference engine provided its output through ___________.
   (a) printer
   (b) curve plotter
   (c) card punching machine/ bell
   (d) all of them

9. The computer which worked on continuously changing quantities (like electricity, water flow, etc.) for input were called ___________.
   (a) ENIAC
   (b) logarithm
   (c) analog computer
   (d) mainframe computer

10. Analog computer was invented by ___________.
     (a) John Napier
     (b) Sir William Thomson
     (c) Blaise Pascal
     (d) Charles Babbage

11. Computers like Colossus, were used for ___________ German military communication during World War II.
     (a) decrypting
     (b) scrambling
     (c) randomizing
     (d) encrypting

12. Theoretical definition of a general purpose computer was provided by ___________.
     (a) Allen Turing
     (b) John Napier
     (c) Blaise Pascal
     (d) Edmund Gunter

13. The first general purpose computer, which fulfilled Turing’s definition of a general purpose computing machine was ___________.
     (a) slide rule
     (b) ENIAC
     (c) logarithm
     (d) Colossus

14. The first generation computer was called ___________.
15. First generation computer (named ENIAC) was designed and fabricated by
(a) John Napier
(b) Endmund Gunter
(c) Blaise Pascal
(d) J.P. Eckert & J.W. Mauchy

16. First generation computer (named ENIAC) was designed and fabricated at
(a) University of Pennsylvania, USA
(b) University College, London
(c) University of California, Berkeley, USA
(d) Cambridge University, UK

17. First generation computer (named ENIAC) was created in the year
(a) 1945
(b) 1959
(c) 1965
(d) 1971

18. First generation computer (named ENIAC) used __________ technology for processing data.
(a) transistor
(b) Integrated Circuit (IC)
(c) vacuum tube
(d) Very Large Scale Integration (VLSI)

19. First generation computer (named ENIAC) used more than ______ kW of electric power.
(a) 200
(b) 1000
(c) 2000
(d) 3000

20. First generation computer (named ENIAC) used __________ for input.
(a) punched card
(b) paper tape
(c) magnetic tape
(d) all of them

21. First generation computer (named ENIAC) used __________ for output.
(a) punched card
(b) paper tape
(c) magnetic tape
(d) all of them

22. __________ language was used to program first generation computer (named ENIAC).
(a) C
(b) machine language
(c) C++
(d) Java

23. Second generation computer was created in the year __________.
(a) 1945
(b) 1959
(c) 1965
(d) 1971

24. Second generation computer used __________ technology for processing data.
(a) transistor
(b) Integrated Circuit (IC)
(c) vacuum tube
(d) Very Large Scale Integration (VLSI)

25. Second generation computer used __________ for main memory.
(a) DVD
(b) magnetic core
(c) hard disk
(d) CD

26. Second generation computer used __________ for input.
(a) magnetic disk
(b) magnetic tape
(c) both a & b
(d) neither a nor b

27. Second generation computer used __________ for output.
(a) magnetic disk
(b) magnetic tape
(c) both a & b
(d) neither a nor b

28. __________ language was used to program second generation computer.
(a) FORTRAN
(b) COBOL
(c) both a & b
(d) neither a nor b

29. Third generation computer was created in the year __________.
(a) 1945
(b) 1959
(c) 1965
(d) 1971

30. Third generation computer used __________ technology for processing data.
(a) transistor
(b) Integrated Circuit (IC)
(c) vacuum tube
(d) Very Large Scale Integration (VLSI)

31. Third generation computer used __________ for input.
(a) magnetic disk
(b) magnetic tape
(c) keyboard
(d) all of them
32. Third generation computer used ___________ for output.
   (a) magnetic disk  
   (b) magnetic tape  
   (c) monitor  
   (d) all of them

33. ___________ language was used to program third generation computer.
   (a) FORTRAN-II to IV, COBOL  
   (b) BASIC, PASCAL  
   (c) PL/1, ALGOL-60  
   (d) all of them

34. Fourth generation computer was created in the year ___________.
   (a) 1959  
   (b) 1965  
   (c) 1971  
   (d) 1980

35. Fourth generation computer used ___________ technology for processing data.
   (a) Integrated Circuit (IC)  
   (b) vacuum tube  
   (c) Very Large Scale Integration (VLSI)  
   (d) Ultra Large Scale Integration (ULSI)

36. Fourth generation computer used ___________ for input.
   (a) magnetic disk  
   (b) magnetic tape  
   (c) keyboard  
   (d) all of them

37. ___________ language was created during the advent of fourth generation computers.
   (a) C  
   (b) C++  
   (c) both a & b  
   (d) neither a nor b

38. In fourth generation computers, ___________ were used for secondary storage of data.
   (a) floppy disk  
   (b) hard disk  
   (c) tape drive  
   (d) all of them

39. ___________ generation computers first earned the name of Personal Computer (PC).
   (a) first  
   (b) second  
   (c) third  
   (d) fourth

40. Productivity tools like Wordstar, Lotus, DBASE, FOXPRO, etc. flourished during the era of ___________ generation computers.
   (a) first  
   (b) second  
   (c) third  
   (d) fourth

41. Internet was created during the era of ___________ generation computers.
   (a) second  
   (b) third  
   (c) fourth  
   (d) fifth

42. Fifth generation computer was created in the year ___________.
   (a) 1959  
   (b) 1965  
   (c) 1971  
   (d) 1980

43. Fifth generation computer used ___________ technology for processing data.
   (a) Integrated Circuit (IC)  
   (b) vacuum tube  
   (c) Very Large Scale Integration (VLSI)  
   (d) Ultra Large Scale Integration (ULSI)

44. Fifth generation computer used ___________ for input.
   (a) mouse  
   (b) keyboard  
   (c) scanner/light pen  
   (d) all of them

45. ___________ language created during the advent of fifth generation computers.
   (a) Java  
   (b) C#  
   (c) both a & b  
   (d) neither a nor b

46. In fifth generation computers, ___________ were used for secondary storage of data.
   (a) floppy disk  
   (b) hard disk  
   (c) CD/DVD drive  
   (d) all of them

47. Several new forms of personal computer, viz., laptop, notebook, ultrabook, tablet PC, smartphones, Chromebook, Raspberry PI, were created during the era of ___________.
   (a) second  
   (b) third  
   (c) fourth  
   (d) fifth

1.1.2 Types of computer

48. Personal computer is otherwise called ___________.
   (a) micro-computer  
   (b) desktop  
   (c) both a & b  
   (d) neither a nor b

49. In a personal computer, multiple users ___________.
   (a) can login and work at different times  
   (b) cannot work simultaneously  
   (c) can work simultaneously  
   (d) can work at different times

Prepared by: Dr.V Nagarajane
(b) cannot login and work at the same time
(c) although multiple users are supported, only one person can login at given time
(d) all of them

50. The computer having better graphics capacity, more main memory, more processing power and more storage compared to personal computer is called

(a) tablet PC
(b) Raspberry Pi
(c) workstation computer
(d) smartphone

51. The computer used for professional works like CAD/CAM, animation, desktop publication, high power gaming, etc. is called

(a) tablet PC
(b) Raspberry Pi
(c) workstation computer
(d) smartphone

52. A computer which supports concurrent login for 100 or 200 persons is called

(a) mini-computer
(b) micro-computer
(c) tablet PC
(d) laptop

53. A computer which supports concurrent login for thousands of users is called

(a) mainframe computer
(b) micro-computer
(c) tablet PC
(d) laptop

54. _______________ computer has enormous processing power, memory and storage and supports thousands of concurrent logins.

(a) mainframe computer
(b) micro-computer
(c) cloud computer
(d) laptop

55. A collection of computers used for online data storage through the Internet is called

(a) mainframe computer
(b) micro-computer
(c) cloud computer
(d) laptop

56. A computer having large processing power, used for scientific research, simulation of experiments, nuclear research, high power number crunching, etc. is called

(a) smartphone
(b) micro-computer
(c) workstation computer
(d) supercomputer

57. The most common type of computer used at homes and offices is called

(a) Personal Computer (PC)
(b) super computer
(c) main frame computer
(d) mini computer

58. In computers, PC is expanded as

(a) Process Computer
(b) Progressive Computer
(c) Personal Computer
(d) Plus Computer

59. Personal computer is otherwise called

(a) super computer
(b) main frame computer
(c) mini computer
(d) micro-computer

60. A micro-computer/PC permits working of ______________ at the same time.

(a) many users
(b) one user
(c) hundreds of users
(d) thousands of users

61. Laptops, tabs, mobile phones, raspberry PI, etc. are classified under

(a) super computer
(b) main frame computer
(c) mini computer
(d) micro-computer

1.1.3 Advantages of computers

62. The main advantage of computer is

(a) speed
(b) large storage capacity
(c) ease of creating programs for new jobs
(d) all of them

63. CAD stands for

(a) Computer Analog Design
(b) Computer Aided Dialog
(c) Computer Aided Design
64. CAM stands for _________________.
   (a) Computer Analog Manufacture
   (b) Computer Aided Monitoring
   (c) Computer Aided Maintenance
   (d) Computer Aided Manufacturing

65. CAD/CAM help in reduction of ______________ required for manufacture while maintaining high quality and precision.
   (a) time
   (b) money
   (c) both a & b
   (d) neither a nor b

66. Mission critical operations (like rocket launching, control of space vehicles) are possible through _______________ computers.
   (a) real time
   (b) main frame
   (c) super
   (d) mini

67. Real time computers have ______________ lag in processing input signals.
   (a) zero
   (b) lengthy
   (c) lot of
   (d) heavy

1.1.5 Concept of hardware and software

72. All the physical components of a computer are collectively called ________________.
   (a) software
   (b) hardware
   (c) malware
   (d) junkware

73. The component which makes a computer to work through commands is called ________________
   (a) software
   (b) hardware
   (c) malware
   (d) junkware

74. Software ______________ be touched.
   (a) cannot
   (b) can
   (c) may
   (d) would

75. Hardware ______________ be touched.
   (a) cannot
   (b) can
   (c) may
   (d) would

76. Hardware ________________ electric power for working.
   (a) consumes
   (b) does not consume
   (c) generates
   (d) creates

77. Hardware ______________ space.
   (a) does not occupy
   (b) occupies
   (c) does not require
   (d) does not need

78. Software ________________.
   (a) consumes power through hardware
   (b) is inferred through the working of hardware
   (c) controls the hardware
   (d) all of them

1.1.6 Computer hardware

79. A computer has ________________.
   (a) input unit
   (b) Central Processing Unit (CPU)
   (c) output unit
   (d) all of them

80. Keyboard, mouse, scanner, stylus, light pen, etc. are classified under ________________ unit.
   (a) input
   (b) central processing
   (c) output
   (d) none of them

81. Monitor (VDU), printer, plotter, etc. are classified under ________________ unit.
   (a) input
82. All the processing work of computer takes place in ____________.
(a) input unit
(b) Central Processing Unit (CPU)
(c) output unit
(d) none of them

83. ____________ produces output/results after processing the input data.
(a) input unit
(b) Central Processing Unit (CPU)
(c) output unit
(d) all of them

84. ____________ is called the ‘Brain of Computer’.
(a) input unit
(b) Central Processing Unit (CPU)
(c) output unit
(d) all of them

85. Processor, main memory (RAM), hard disk, CD/DVD drive, CMOS, BIOS chip, etc. are housed inside _____________.
(a) input unit
(b) Central Processing Unit (CPU)
(c) output unit
(d) all of them

86. ____________ contains slots for fixing/ connecting processor, main memory (RAM), hard disk, CD/DVD drive, CMOS, BIOS chip, etc.
(a) Mother board
(b) bread board
(c) key board
(d) dash board

Input units

87. Common keyboards used in India have ____________ layout of keys.
(a) English US
(b) English UK
(c) either a or b
(d) neither a nor b

88. The longest/largest button on keyboard is ____________.
(a) space bar
(b) enter
(c) backspace
(d) tab

89. The ____________ button removes a character to the left of cursor position.
(a) space bar
(b) enter
(c) backspace
(d) tab

90. The ____________ button ends current line of input.
(a) space bar
(b) enter
(c) backspace
(d) tab

91. The ____________ button moves the cursor to the next predetermined stop location.
(a) space bar
(b) enter
(c) backspace
(d) tab

92. The ____________ button toggles capital letter for input.
(a) caps lock
(b) print screen
(c) scroll lock
(d) pause/break

93. The ____________ button takes a screen shot and copies it to clipboard or saves it to a file.
(a) caps lock
(b) print screen
(c) scroll lock
(d) pause/break

94. The ____________ button stops or resumes the boot process.
(a) caps lock
(b) print screen
(c) scroll lock
(d) pause/break

95. ____________ button keeps the scroll mode on or off.
(a) caps lock
(b) print screen
(c) scroll lock
(d) pause/break

96. The group of number keys and basic arithmetic operators placed on the left side of a keyboard is called ____________.
(a) number pad
(b) note pad
(c) arrow keys
(d) cursor controls

97. The ____________ key toggles number pad on or off.
(a) num lock
(b) caps lock
(c) scroll lock
(d) Esc

98. The ____________ keys can move the cursor up, down, left or right.
(a) num lock
(b) arrow
(c) scroll lock
(d) Esc

99. The ____________ key moves out of current screen or terminates current operation.
(a) num lock
(b) arrow
(c) scroll lock
(d) Esc

100. The ____________ key helps to access alternate character of each key (e.g. ! by pressing 1, @ by pressing 2, etc.).
(a) num lock
(b) arrow
(c) shift
(d) Esc
101. The ________ keys are placed to the left and right of space bar.
(a) Ctrl 
(b) Windows button 
(c) Alt 
(d) all of them

102. The ________ key opens context menu.
(a) Ctrl 
(b) Windows button 
(c) Alt 
(d) function key

103. The series of keys named F1 ... F12 are called ________.
(a) function keys 
(b) scroll keys 
(c) number keys 
(d) navigation keys

104. Function keys are placed at the ________ of keyboard.
(a) bottom (b) right 
(c) top (d) left

105. The Insert, Delete, Home, End, Page Up and Page Down keys are placed above ________.
(a) arrow keys 
(b) number lock 
(c) function keys 
(d) scroll lock

106. A second enter key is available in ________ area of keyboard.
(a) arrow keys 
(b) number lock 
(c) function keys 
(d) scroll lock

107. Most of the shortcut keys are designed to use ________ key along with one or two characters.
(a) Ctrl 
(b) Alt 
(c) both a & b 
(d) none of them

108. ________ opens the start menu.
(a) Windows key 
(b) Ctrl 
(c) Alt 
(d) F1

109. ________ opens help.
(a) Windows key 
(b) Ctrl 
(c) Alt 
(d) F1

110. The function keys are arranged in 3 groups of ________ keys in a group.
(a) 2 
(b) 3 
(c) 4 
(d) 5

Mouse

111. The ________ helps to move the cursor on screen and point at specific icons.
(a) scanner 
(b) mouse 
(c) keyboard 
(d) printer

112. Normally, pressing the ________ button of mouse once or twice on an icon opens the program associated with that icon.
(a) left 
(b) right 
(c) centre 
(d) bottom

113. Normally, pressing the ________ button of mouse opens a context menu.
(a) left 
(b) right 
(c) centre 
(d) bottom

114. Normally, ________ button of mouse doubles as a scroller.
(a) left 
(b) right 
(c) centre 
(d) bottom

115. The computer can be configured to open a program on ________ the icon using mouse.
(a) single clicking 
(b) double clicking 
(c) both a & b 
(d) neither a nor b

116. Mouse may have ________ for sensing movement.
(a) ball 
(b) light sensor 
(c) either a or b 
(d) neither a nor b

Other input devices

117. A device which can process characters and drawings on paper and convert them to digital images (or editable objects) for computers is called ________.
(a) scanner 
(b) digital tablet 
(c) light pen 
(d) printer

118. A device which converts handwriting to computer input is called ________.
(a) scanner 
(b) digital tablet 
(c) light pen 
(d) printer

119. A stylus used to provide input through CRT monitor is called ________.
(a) scanner
1.1.7 Output devices

Monitor/ VDU

120. ___________ is the most common output device for a computer.
(a) monitor
(b) printer
(c) both a & b
(d) neither a nor b

121. VDU is expanded as ____________.
(a) Visual Display Unit
(b) Virtual Display Unit
(c) Visual Deception Unit
(d) Visual Display University

122. In computer monitors, CRT stands for ____________.
(a) Cadmium Ray Tube
(b) Cathode Ray Tube
(c) Cathode Ray Twist
(d) Cathode Rim Tube

123. Cathode Ray Tube (CRT) monitor supports ____________ input.
(a) LASER printer
(b) line printer
(c) light pen
(d) plottet

124. Cathode Ray Tube (CRT) monitor has ____________ level of power consumption amongst monitors.
(a) highest
(b) lowest
(c) zero
(d) least

125. LCD is expanded as ____________.
(a) Linear Crystal Display
(b) Liquid Crystal Dialog
(c) Liquid Crystal Display
(d) Liquid Canister Display

126. LED is expanded as ____________.
(a) Linear Emitting Diode
(b) Light Emitting Diode
(c) Liquid Emitting Diode
(d) Light Emitting Display

127. The display of LCD monitor is ____________ than that of LED monitor.
(a) lighter
(b) heavier
(c) brighter
(d) duller

128. Plasma monitor is suitable for ____________.
(a) large displays (> 32”)
(b) small displays
(c) display of mobile phone
(d) display of watches

129. TFT is expanded as ____________.
(a) Tiny Film Transistor
(b) Thin Film Transistor
(c) Thin Floppy Transistor
(d) Thin Film Transmission

130. The density of pixels in a monitor surface is called ____________.
(a) revolution
(b) reaction
(c) resolution
(d) relation

131. The number of pixels per inch of monitor length is called ____________.
(a) LPI (Lines Per Inch)
(b) DPI (Dots Per Inch)
(c) SPI Sides Per Inch
(d) PPI (Pixels Per Inch)

132. Height to width ratio of a monitor screen is called ____________.
(a) aspect ratio
(b) length ratio
(c) width ratio
(d) diagonal ratio

133. Generally, CRT monitors had aspect ratio of ____________.
(a) 16:9
(b) 4:3
(c) 16:10
(d) 1:1

134. LCD, LED, TFT and Plasma monitors have aspect ratio of ____________.
(a) 16:9
(b) 16:10
(c) both a & b
(d) neither a nor b

135. The monitor having pixel resolution of 1280 × 720 has aspect ratio of ____________.
(a) 16:9
(b) 16:10
(c) 4:3
(d) 1:1

136. The monitor having pixel resolution of 800 × 600 has aspect ratio of ____________.
(a) 16:9
(b) 16:10
(c) 4:3
(d) 1:1

137. The monitor having pixel resolution of 1280 × 800 has aspect ratio of ____________.
(a) 16:9
(b) 16:10
(c) 4:3
(d) 1:1

138. The monitor having pixel resolution of 1920 × 1080 has aspect ratio of ____________.
139. In monitors, **HD** stands for
(a) Hyper Density
(b) High Direct
(c) Hot Definition
(d) High Definition

**140.** Display resolution of $1920 \times 1080$ pixels is called __________ display.
(a) 480p
(b) 576p
(c) 720p
(d) Full High Definition (FHD)

141. Full High Definition (FHD) of displays corresponds to __________ (vertical pixel resolution).
(a) 480p
(b) 576p
(c) 720p
(d) 1080p

142. Display resolution of $1280 \times 720$ pixels is called __________.
(a) 480p
(b) 576p
(c) 720p
(d) Full High Definition (FHD)

143. Display resolution of $768 \times 576$ pixels is called __________.
(a) 480p
(b) 576p
(c) 720p
(d) Full High Definition (FHD)

144. Display resolution of $720 \times 480$ pixels is called __________.
(a) 480p
(b) 576p
(c) 720p
(d) Full High Definition (FHD)

145. The notation $H Di$ for display resolution denotes __________.
(a) 1080p Interlaced
(b) 720p Interlaced
(c) 576p Interlaced
(d) 480p Interlaced

146. The method of displaying screen contents using even rows for half a second and odd rows for another half second is called __________ of video.
(a) progressive scanning
(b) interlacing
(c) deinterlacing
(d) reducing

147. The method of displaying screen contents using even rows for half a second and odd rows for another half second is called __________ of video.
(a) progressive video
(b) interlacing
(c) deinterlacing
(d) reducing

148. The $p$ in display resolutions of $1080p, 720p, 576p$ & $480p$ stands for __________.
(a) progressive video
(b) interlacing
(c) deinterlacing
(d) reducing

149. The method of painting each row of video frame from top to bottom is called __________.
(a) progressive video
(b) interlacing
(c) deinterlacing
(d) reducing

150. The method of painting odd rows during the first pass and even rows during the second pass is called __________.
(a) progressive video
(b) interlacing
(c) deinterlacing
(d) reducing

**Printer**

151. The device that produces hard copies on paper is called __________.
(a) monitor
(b) scanner
(c) tablet
(d) printer

152. Paper copy of a document is called __________.
(a) light copy
(b) hard copy
(c) soft copy
(d) hot copy

153. Digital copy of a document stored in secondary storage device (like hard disk, floppy disk, CD, DVD, pen drive, SD card, etc.) is called __________.
(a) light copy
(b) hard copy
(c) soft copy
(d) hot copy

154. The type of printer which hits the paper to produce print is called __________.
(a) monitor
(b) scanner
(c) non-impact type printer
(d) impact type printer
155. The type of printer which does not hit the paper to produce print is called
___________.
(a) monitor  (b) scanner  
(c) non-impact type printer  (d) impact type printer
156. Dot matrix printer belongs to __________ category.
(a) monitor  (b) scanner  
(c) non-impact type printer  (d) impact type printer
157. Dot matrix printer, line printer, chain printer, golf ball printer and daisy wheel printer belong to __________ category.
(a) monitor  (b) scanner  
(c) non-impact type printer  (d) impact type printer
158. LASER printer, ink jet printer, thermal printer and plotter belong to __________ category.
(a) monitor  (b) scanner  
(c) non-impact type printer  (d) impact type printer
159. In LASER printer, the LASER beam produces ________ charge on paper, which makes the toner powder to adhere to the charged area.
(a) (-)ve  (b) (+)ve  
(c) neutral  (d) none of them
160. In ink jet printer, __________ colour cartridges are used to produce colour/black print.
(a) Red, Blue & Green (RBG)  (b) Cyan, Magenta, Yellow & black (CMYK)  
(c) Red, Green & Blue (RGB)  (d) VIBGYOR
161. In ink jet printer, CMYK stands for __________.
(a) Cream, Magenta, Yellow & black  (b) Crimson, Magenta, Yellow & black  
(c) Cyan, Magenta, Yellow & black  (d) Cyan, Mango, Yellow & black
162. The type of printer used for printing on large size papers (A0, A1, etc.) is called __________.
(a) monitor  (b) scanner  
(c) mouse  (d) plotter
163. Thermal printer uses __________ coated paper, which turns black when heat is applied.
(a) chromium  (b) BisPhenol A  
(c) nickel  (d) toner powder
1.1.8 Central Processing Unit (CPU)
164. CPU is expanded as __________.
(a) Central Power Unit  (b) Critical Processing Unit  
(c) Central Processing Unit  (d) Cerebral Processing Unit
165. The symbol µP denotes __________ of a computer.
(a) mighty processor  (b) micro presenter  
(c) million power  (d) micro-processor
166. __________ is casually called the “Brain of Computer”.
(a) CPU  (b) monitor  
(c) keyboard  (d) mouse
167. The main components housed in CPU are __________.
(a) micro-processor  (b) Mother Board, Random Access Memory (RAM)  
(c) Secondary storage devices (hard disk, CD/DVD drive, floppy disk drive, etc.)  (d) all of them
168. In the CPU of a computer, __________ delivers power supply to all the components at appropriate voltages.
(a) Hard Disk  (b) Mother Board  
(c) Switch Mode Power Supply (SMPS)  (d) DVD drive
169. The chip carrying out all processing works in a computer is called __________.
(a) micro-processor (µP)  (b) keyboard  
(c) BIOS chip  (d) RAM
170. The part of micro-processor which performs number crunching and logical comparisons is called __________.
(a) Arithmetic and Logic Unit (ALU)  (b) Register
171. ALU stands for ________.
(a) Arithmetic and Logic University
(b) Arithmetic and Local Unit
(c) Arithmetic and Logic Unit
(d) Analysis and Logic Unit

172. The part of micro-processor used for storing values needed for next cycle of processing is called ________.
(a) Arithmetic and Logic Unit (ALU)
(b) Register
(c) clock
(d) timer

173. The part of micro-processor holding data which is needed for forthcoming cycles of processing is called ________.
(a) Arithmetic and Logic Unit (ALU)
(b) Register
(c) Cache
(d) timer

174. The part of micro-processor which maintains a clock and induces each cycle of processing through a pulse is called ________.
(a) Arithmetic and Logic Unit (ALU)
(b) Register
(c) Cache
(d) timer

175. The number of floating point operations carried out by a micro-processor in one second is called ________.
(a) FLOPS
(b) timer
(c) clock
(d) frequency

176. The number of cycles of operations performed by a processor per second is called its ________.
(a) bus speed
(b) connection speed
(c) clock speed
(d) baud rate

177. Whereas clock speed is the gross number of operations performed by a processor per second, FLOPS represents ________ of processor per second.
(a) wasted time
(b) effective out turn
(c) wasted cycles
(d) clock speed

178. A floating point operation may require ________ clock cycle to complete.
(a) just one
(b) less than one
(c) zero
(d) more than one

179. Intel Pentium processor was preceded by Intel ________ processor.
(a) Core 2 duo
(b) 80486/ 486
(c) Core i3
(d) Core i5

Main memory (or) Primary Storage or Random Access Memory

180. The storage which handles data required for the processor (by fetching data from or saving data to secondary storage) is called ________.
(a) main memory
(b) primary storage/ volatile storage
(c) Random Access Memory (RAM)
(d) all of them

181. Main memory ________ data after power off.
(a) retains
(b) remembers
(c) does not keep
(d) keeps all

182. Since main memory loses data after power off, it is called ________.
(a) data storage
(b) volatile storage
(c) power storage
(d) secondary storage

183. RAM is expanded as ________.
(a) Right Access Memory
(b) Random Active Memory
(c) Random Access Memory
(d) Random Access Meter

184. SRAM stands for ________.
(a) Static Random Access Memory
(b) Stable Random Access Memory
(c) Static Read Access Memory
(d) Static Random Arithmetic Memory

185. DRAM stands for ________.
(a) Draft Random Access Memory
(b) Direct Random Access Memory
(c) Disk Random Access Memory
(d) Dynamic Random Access Memory

186. FPM DRAM stands for ________.
(a) First Page Mode Dynamic Random Access Memory
(b) Fast Page Mode Dynamic Random Access Memory
(c) Fill Page Mode Dynamic Random Access Memory

187. EDO DRAM stands for (a) Extended Disk Out Dynamic Random Access Memory (b) Expanded Data Out Dynamic Random Access Memory (c) Extended Data Out Dynamic Random Access Memory (d) Extended Data Onboard Dynamic Random Access Memory

188. SDRAM stands for (a) Synchronous Dynamic Random Access Memory (b) Simple Dynamic Random Access Memory (c) Synchronous Double Random Access Memory (d) Syntax Dynamic Random Access Memory

189. DDR SDRAM stands for (a) Double Data Rate Synchronous Dynamic Random Access Memory (b) Double Data Rate Simple Dynamic Random Access Memory (c) Double Data Rate Synchronous Double Random Access Memory (d) Double Data Rate Syntax Dynamic Random Access Memory

190. RDRAM stands for (a) Resultant Random Access Memory (b) Reactive Random Access Memory (c) Rational Random Access Memory (d) Rambus Random Access Memory

191. VRAM stands for (a) Visual Random Access Memory (b) Video Random Access Memory (c) Virtual Random Access Memory (d) Vintage Random Access Memory

192. MPDRAM stands for (a) Major Port Dynamic Random Access Memory (b) Multi-Point Dynamic Random Access Memory (c) Multi-Port Dynamic Random Access Memory (d) Multi-Port Data Random Access Memory

193. SGRAM stands for (a) Synchronous Graphics Random Access Memory (b) Syntax Graphics Random Access Memory (c) Simple Graphics Random Access Memory (d) Synchronous Gross Random Access Memory

194. In a desktop computer, the board containing micro-processor, RAM and other components is called (a) graphics (b) mother (c) white (d) black

195. CMOS in motherboard is expanded as (a) Customary Metal Oxide Semiconductor (b) Complementary Mineral Oxide Semiconductor (c) Complete Metal Oxide Semiconductor (d) Complementary Metal Oxide Semiconductor

196. CMOS is a type of RAM, which is constantly powered by (a) UPS battery (b) CMOS battery (c) AC main (d) AA battery

197. In motherboard, BIOS is expanded as (a) Beginner Input Output System (b) Bit Input Output System (c) Basic Input Output System (d) Basic Input Output Syntax

198. In motherboard, CNR stands for (a) Communication & Network Riser (b) Contact & Network Riser (c) Communication & Network Ripper (d) Complementary & Networking Riser

199. In motherboard, AGP stands for (a) Automated Graphics Port (b) Accelerated Graphics Point (c) Audio Graphics Port (d) Accelerated Graphics Port

200. In motherboard, PATA stands for (a) Peripheral Advanced Technology Attachment (b) Port Advanced Technology Attachment (c) Parallel Advanced Technology Attachment (d) Part Advanced Technology Attachment

201. In motherboard, SATA stands for (a) Serial Advanced Technology Attachment (b) Synchronous Advanced Technology Attachment (c) Synaptic Advanced Technology Attachment (d) Systematic Advanced Technology Attachment

202. In motherboard, (a) Southbridge (b) Eastbridge (c) Northbridge (d) Westbridge
203. In motherboard, the ________ chipset takes care of data transfer to and from the secondary storage devices (like hard disk, CD/DVD drive, etc.).
(a) Southbridge  (b) Eastbridge  (c) Northbridge  (d) Westbridge

204. Secondary storage units

Secondary storage is otherwise called
(a) auxiliary storage  (b) permanent storage  (c) both a & b  (d) main memory

205. Data store in secondary storage is ________
(a) volatile  (b) lost after power off  (c) is deleted after every reboot  (d) permanent (available till deletion)

206. Secondary storage devices are ________ in speed when compared to RAM.
(a) faster  (b) slower  (c) equal  (d) none of them

207. Hard disk uses ________ for data storage and retrieval.
(a) LASER beam acting on light sensitive layer  (b) magnetic disk mounted in spindle  (c) flash memory  (d) plastic magnetic plate

208. CD/DVD drive uses ________ for data storage and retrieval.
(a) LASER beam acting on light sensitive layer  (b) magnetic disk mounted in spindle  (c) flash memory  (d) plastic magnetic plate

209. SD card, mini SD card and micro SD card use ________ for data storage and retrieval.
(a) LASER beam acting on light sensitive layer  (b) magnetic disk mounted in spindle  (c) flash memory  (d) plastic magnetic plate

210. Floppy disk uses ________ for data storage and retrieval.
(a) LASER beam acting on light sensitive layer  (b) magnetic disk mounted in spindle  (c) flash memory  (d) plastic magnetic plate

211. SD card is expanded as ________
(a) Secure Digital Card  (b) Mini Secure Digital Card  (c) Micro Secure Digital Card  (d) Major Secure Digital Card

212. Mini SD card is expanded as ________
(a) Secure Digital Card  (b) Mini Secure Digital Card  (c) Micro Secure Digital Card  (d) Major Secure Digital Card

213. Micro SD card is expanded as ________
(a) Secure Digital Card  (b) Mini Secure Digital Card  (c) Micro Secure Digital Card  (d) Major Secure Digital Card

214. PCMCIA stands for ________.
(a) Protected Computer Memory Card International Association  (b) Personal Computer Memory Card International Association  (c) Personal Complementary Memory Card International Association  (d) Pen drive Computer Memory Card International Association

Storage capacities

215. The smallest storage unit permitting storage of 0 and 1 is called ________
(a) bit  (b) nibble  (c) byte  (d) kilo byte

216. One bit can store ________ range of values.
(a) 0 or 1  (b) 0 to 255  (c) 0 to 512  (d) 0 to 1024

217. 4 bits of memory is called ________
(a) bit  (b) nibble  (c) byte  (d) kilo byte

218. Nibble is a storage unit consisting of ________ bits.
(a) 8  (b) 16  (c) 4  (d) 64

219. 8 bits of memory is called ________
(a) bit  (b) nibble  (c) byte  (d) kilo byte

220. Byte is a storage unit consisting of ________ bits.
(a) 8  (b) 16  (c) 4  (d) 64

221. 1024 bits of storage is called ________.
(a) bit  (b) nibble  (c) byte  (d) kilo byte

222. Kilo Byte (KB) is a storage unit consisting of ________ bits.
223. $2^{20}$ (1048576) bits of storage is called
(a) byte
(b) Kilo Byte (KB)
(c) Mega Byte (MB)
(d) Tera Byte (TB)

224. 1024 KB of storage is called
(a) byte
(b) Kilo Byte (KB)
(c) Mega Byte (MB)
(d) Tera Byte (TB)

225. 1 MB = ___________ KB.
(a) 1024 ($2^{10}$)
(b) 1048576 ($2^{20}$)
(c) 1073741824 ($2^{30}$)
(d) 1099511627776 ($2^{40}$)

226. 1 MB = ___________ bits.
(a) 1024 ($2^{10}$)
(b) 1048576 ($2^{20}$)
(c) 1073741824 ($2^{30}$)
(d) 1099511627776 ($2^{40}$)

227. 1024 MB of storage is called
(a) byte
(b) Kilo Byte (KB)
(c) Mega Byte (MB)
(d) Tera Byte (TB)

228. 1 TB = ___________ MB.
(a) 256
(b) 512
(c) 1024
(d) 2048

229. 1024 TB = 1 ___________
(a) Mega Byte (MB)
(b) Tera Byte (TB)
(c) Peta Byte (PB)
(d) Exa Byte (EB)

230. 1 PB = 1024 ___________
(a) Mega Byte (MB)
(b) Tera Byte (TB)
(c) Peta Byte (PB)
(d) Exa Byte (EB)

231. 1024 PB = 1 ___________
(a) Mega Byte (MB)
(b) Tera Byte (TB)
(c) Peta Byte (PB)
(d) Exa Byte (EB)

232. 1 EB (Exa Byte) = 1024 ___________
(a) Mega Byte (MB)

233. The storage capacity of a Compact Disk (CD) is ___________
(a) 800MB
(b) 4.7GB
(c) 512MB
(d) 1TB

234. The storage capacity of a Digital Versatile Disk (DVD) is ___________
(a) 800MB
(b) 4.7GB
(c) 512MB
(d) 1TB

235. The storage capacity of a common hard disk is ___________
(a) 256MB
(b) 512GB
(c) 1TB
(d) any one of a, b or c

236. The storage capacity of a Secure Digital (SD) card/ Mini SD card/ Micro SD card or pen drive can be in the range of ___________
(a) 1 bit to 8 bits
(b) 4 bits to 8 bits
(c) 2GB to 128GB
(d) 1 MB to 1024MB

Storage capacities of devices

Switch Mode Power Supply (SMPS)

237. The unit which splits power supply to various voltages required for the units of a computer is called ___________
(a) transformer
(b) Switch Mode Power Supply (SMPS)
(c) transistor
(d) transducer

238. Full form for SMPS in computer is ___________
(a) Sync Mode Power Supply
(b) Switch Mode Power Supply
(c) Stake Mode Power Supply
(d) Switch Mode Power Socket

239. In a desktop computer, ___________ produces radio frequency interference.
(a) SMPS
(b) Micro-Processor ($\mu P$)
(c) RAM
(d) Mouse
CPU Ports

240. The opening provided in the front panel or rear panel of a CPU for connecting peripherals is called _____________.
   (a) socket       (b) pin
   (c) port         (d) part

241. External devices/ peripherals like keyboard and mouse can be connected to a computer using ___________ ports.
   (a) PS/2        (b) USB
   (c) both a & b  (d) neither a nor b

242. External dialup MODEM can be connected to a computer using ___________ port.
   (a) RS232/ serial
   (b) PS/2
   (c) VGA
   (d) LPT

243. Monitor is connected to a computer using ___________ port.
   (a) RS232/ serial
   (b) PS/2
   (c) VGA
   (d) LPT

244. Old style (SIMPLEX) printer (like dot matrix printer) may be connected to a computer using ___________ port.
   (a) RS232/ serial
   (b) PS/2
   (c) VGA
   (d) LPT

245. Modern (DUPLEX) printer (like LASER jet, inkjet printers) may be connected to a computer using ___________ port.
   (a) RS232/ serial
   (b) PS/2
   (c) VGA
   (d) LPT

246. Broadband connection may be connected through ___________ port.
   (a) RJ45/ Ethernet
   (b) USB
   (c) PS/2
   (d) VGA

247. Printer, fax machine, scanner, webcam, external DVD writer, external hard disk, etc. can be connected to computer using ___________ port.
   (a) RJ45        (b) USB
   (c) PS/2       (d) VGA

248. Audio input, microphone and speaker output can be connected to computer using ___________.
   (a) 3.5mm jack  (b) RJ11
   (c) RJ45        (d) LPT

249. Joystick can be connected to computer using ___________ port.
   (a) 3.5mm jack  (b) RJ11
   (c) RJ45        (d) Game

250. PS/2 stands for ___________.
   (a) Registered Jack 11
   (b) Registered Jack 45
   (c) Personal System 2
   (d) Recommended Standard 232

251. RJ11 stands for ___________.
   (a) Registered Jack 11
   (b) Registered Jack 45
   (c) Personal System 2
   (d) Recommended Standard 232

252. RJ45 stands for ___________.
   (a) Registered Jack 11
   (b) Registered Jack 45
   (c) Personal System 2
   (d) Recommended Standard 232

253. RS232 stands for ___________.
   (a) Registered Jack 11
   (b) Registered Jack 45
   (c) Personal System 2
   (d) Recommended Standard 232

254. RJ45 port is otherwise called ___________.
   (a) Ethernet
   (b) LPT
   (c) USB
   (d) Firewire

255. IEEE 1394 port is otherwise called ___________.
   (a) Ethernet
   (b) LPT
   (c) USB
   (d) Firewire

256. LPT stands for ___________.
   (a) Registered Jack 11
   (b) Registered Jack 45
   (c) Line Printer Terminal
   (d) Recommended Standard 232

257. USB stands for ___________.
   (a) Registered Jack 11
   (b) Registered Jack 45
   (c) Line Printer Terminal
   (d) Universal Serial Bus

258. High definition graphics output may be taken from ___________ port of a PC.
   (a) 3.5mm jack
   (b) HDMI
   (c) RJ45
   (d) LPT

259. HDMI stands for ___________.

Prepared by: Dr.V.Nagaradjane
1.1.9 Computer software

260. The component of computer which is not physically accessible, but can be realized through its working is called _________.
    (a) hardware    (b) software
    (c) RAM         (d) port

261. ________ decides how hardware should work.
    (a) hardware    (b) software
    (c) RAM         (d) port

262. ________ helps to hardware to produce output based on given input.
    (a) Game port   (b) software
    (c) IEEE 1392   (d) SMPS

263. The operating system & driver software are categorized under ________ software.
    (a) system      (b) application
    (c) malware     (d) junkware

264. The software tools required for various types of productive works like preparation of documents, spreadsheets, playing audio/video, browsing Internet, etc. are are categorized under ________ software.
    (a) system      (b) application
    (c) malware     (d) junkware

265. Operating system identifies and controls hardware in coordination with _________.
    (a) power cable (b) mouse
    (c) SMPS        (d) BIOS

266. Operating system uses a special software called ________ to initialize, operate and control hardware.
    (a) conductor   (b) Ethernet controller
    (c) driver      (d) SMPS

267. ________ schedules processor time in such a way as to allow the user to feel that may programs are running at the same time.
    (a) application software    (b) operating system
    (c) virus                    (d) malware

268. ________ schedules processor time and handles concurrency and parallel processing using multiple processor cores.
    (a) application software    (b) virus
    (c) malware                 (d) operating system

269. ________ allocates memory for each program and frees memory when it is no longer needed for a program.
    (a) application software    (b) virus
    (c) malware                 (d) operating system

270. The core of the operating system which controls all hardware and application software, but does not directly interact with the users is called _________.
    (a) kernel       (b) shell
    (c) sap          (d) heart

271. A layer of application software available for the user to interact with operating system kernel is called _________.
    (a) kernel       (b) shell
    (c) sap          (d) heart

272. ________ is an operating system.
    (a) Mac OS X
    (b) Microsoft Windows
    (c) Unix/ Linux/ Free BSD/ Solaris, BeOS
    (d) all of them

Windows

273. MS DOS stands for _________.
    (a) MicroSoft Disk Operating System
    (b) MiniSoft Disk Operating System
    (c) MicroSoft Disk Operating Standard
    (d) MicroSoft Dirty Operating System

274. MS DOS was first released in the year _________.
    (a) 1970        (b) 1981
    (c) 1985        (d) 2000

275. Development of MS DOS was stopped in the year _________.
    (a) 1970        (b) 1981
    (c) 1985        (d) 2000

276. Windows 1.0 was released in the year _________.
    (a) 1970        (b) 1981
    (c) 1985        (d) 2000
277. Windows 1.0, Windows 3.1, Windows 95, Windows 98 and Windows Me were based on ______ kernel.
(a) LINUX
(b) UNIX
(c) NT (New Technology)
(d) MS DOS

(a) LINUX
(b) UNIX
(c) NT (New Technology)
(d) MS DOS

279. The New Technology (NT) kernel based Windows NT was released in ______.
(a) 1981 (b) 1993
(c) 2000 (d) 2010

Mac OS X

280. First version of Mac OS was released in the year ______.
(a) 1981 (b) 1984
(c) 1993 (d) 2000

281. ______ was the first commercial operating system to support Graphical User Interface (GUI).
(a) Windows (b) UNIX
(c) Linux (d) Mac OS

282. The latest version of Mac OS X is based on free UNIX kernel called ______.
(a) Darwin
(b) Cygwin
(c) Solaris
(d) Berkeley Software Distribution

283. The mobile version of Mac OS X, used in iPhone, iPad, iWatch, iPod, etc., is called ______.
(a) Android
(b) Firefox OS
(c) iOS
(d) Blackberry OS

Linux

284. Linux kernel was developed by
(a) Richard Stallman
(b) Linus Torvalds
(c) Bill Gates
(d) Steve Jobs

285. First release of Linux kernel took place in the year ______.
(a) 1981 (b) 1984
(c) 1991 (d) 1993

286. Linux is distributed under an open source license called ______.
(a) GNU GPL (GNU Not Unix General Public License)
(b) Apache license
(c) Berkeley Software Distribution (BSD) license
(d) Microsoft End User License Agreement (EULA)

287. Linux operating system was inspired by ______ operating system.
(a) Windows (b) Unix
(c) Mac OS (d) iOS

288. Linux kernel supports ______ for Graphical User Interface (GUI) based desktop.
(a) GNOME
(b) KDE
(c) Enlightenment
(d) all of them

289. ______ is a version of Linux kernel modified to run on mobile phones/ tablets/ other devices.
(a) Android (b) Firefox OS
(c) Tizen (d) all of them

290. ______ are the shell environments commonly supported by Linux.
(a) Bourne Again Shell (bash)
(b) Korn Shell (ksh)
(c) C Shell (csh)
(d) all of them

UNIX

291. UNIX was one of the first operating systems to support ______.
(a) multi-tasking
(b) Internet
(c) email
(d) all of them

292. UNIX operating system was developed at ______.
(a) AT&T Bell Labs
(b) Carnegie Milan University
(c) CERN
(d) NASA

293. UNIX was developed in the year ______.
(a) 1970 (b) 1984
(c) 1985 (d) 1993
294. ______ was a member of the team that developed UNIX operating system.
   (a) Ken Thompson  
   (b) Dennis Ritchie  
   (c) M.D. McIlhary, J.F. Ossanna  
   (d) all of them

295. POSIX stands for ______.
   (a) Power Operating System Interface  
   (b) Portable Operating System Interface  
   (c) Portable Operating System Internet  
   (d) Portable Overall System Interface

296. SUS stands for ______.
   (a) Simple UNIX Standard  
   (b) Single Universal Standard  
   (c) Single UNIX Standard  
   (d) Single UNIX Supplement

297. ______ shell is supported by UNIX kernel.
   (a) Bourne  
   (b) Korn  
   (c) C  
   (d) all of them

298. Early versions of UNIX supported a graphical user environment called ______.
   (a) KDE  
   (b) CDE  
   (c) GNOME  
   (d) none of them

299. CDE stood for ______.
   (a) Common Desktop Environment  
   (b) Command Desktop Environment  
   (c) Common Desktop Entry  
   (d) Common Directory Environment

Overview of operating systems

300. ______ operating system has the largest number of installations for desktop computers.
   (a) Windows  
   (b) Android  
   (c) Mac OS X  
   (d) UNIX

301. Considering mobile phones as small computers, ______ is the most dominant operating system.
   (a) Windows mobile  
   (b) iOS  
   (c) Android  
   (d) BlackBerry OS

302. Linux is repackaged for specific user requirements by ______.
   (a) Fedora/ Red Hat  
   (b) SUSE  
   (c) Debian/ Ubuntu  
   (d) all of them

Features of Windows operating system

303. The graphical work environment provided by Windows is called ______.
   (a) Desktop  
   (b) Laptop  
   (c) My Documents  
   (d) Downloads

304. The Shortcuts visible on the Desktop of Windows are called ______.
   (a) clipboard  
   (b) desktop icons  
   (c) download icons  
   (d) document icons

305. The thin strip (usually placed at bottom) of Windows desktop, containing several important icons, is called ______.
   (a) menu bar  
   (b) title bar  
   (c) status bar  
   (d) task bar

306. The special button at the left edge of task bar, used to open many programs and settings, is called ______.
   (a) stop menu  
   (b) popup menu  
   (c) start menu  
   (d) file menu

307. Task bar in Windows desktop contains ______.
   (a) start menu  
   (b) quick launch icons, system tray  
   (c) list of running programs  
   (d) all of them

308. The collection of icons placed on the right side of task bar (representing background tasks and their statuses, date, time, volume control, network status icon, etc.) is called ______.
   (a) system tray  
   (b) start menu  
   (c) quick launch icon  
   (d) file menu

309. The list of programs currently running in the desktop environment is displayed in the ______.
   (a) menu bar  
   (b) title bar  
   (c) status bar  
   (d) task bar

Directory structure of Windows operating system

310. The installation drive (usually C:) contains a folder named ______ to store user specific data.
   (a) temp  
   (b) Program Files  
   (c) users
311. The $\text{c} : \backslash \text{user}$ folder contains a sub-folder bearing the name of each user to save user specific data.
(a) sub-folder  (b) file
(c) movie  (d) music

312. For a user named *krish*, the folder $C : \backslash \text{users}\backslash krish$ is called ____________.
(a) movies folder  (b) home folder
(c) documents folder  (d) Windows folder

313. For a user named *buvan*, typical home directory would be ____________.
(a) $C : \backslash \text{ProgramFiles}$  (b) $C : \backslash \text{Windows}$
(c) $C : \backslash \text{users}\backslash buvan$  (d) $C : \backslash \text{Windows}\backslash \text{Temp}$

314. The ____________ folder inside a user's home directory contains desktop icons.
(a) Desktop  (b) My Documents/ Documents
(c) Pictures  (d) Music

315. ____________ is the default folder for saving document files created by a user.
(a) Desktop  (b) My Documents/ Documents
(c) Pictures  (d) Music

316. ____________ is the default folder for music related to a user.
(a) Desktop  (b) My Documents/ Documents
(c) Pictures  (d) Music

317. ____________ is the default folder for image and drawing files related to a user.
(a) Desktop  (b) My Documents/ Documents
(c) Pictures  (d) Music

318. ____________ is the default folder to save content downloaded from the Internet.
(a) Downloads  (b) My Documents/ Documents
(c) Pictures  (d) Music

319. ____________ is the default folder for videos related to a user.
(a) Downloads  (b) Videos
(c) Pictures  (d) Music

---

**Features of Windows Explorer**

320. The shortcut for opening Windows Explorer is ____________.
(a) Windows+E  (b) Windows+R
(c) Windows+F  (d) Windows+L

321. In Windows Explorer, a file may be renamed by right clicking and selecting rename or by pressing ____________ key.
(a) F2  (b) F3
(c) F1  (d) F4

322. In Windows Explorer, ____________ is the shortcut to copy a file.
(a) Ctrl+X  (b) Ctrl+C
(c) Ctrl+V  (d) Ctrl+A

323. In Windows Explorer, ____________ is the shortcut to cut a file.
(a) Ctrl+X  (b) Ctrl+C
(c) Ctrl+V  (d) Ctrl+A

324. In Windows Explorer, ____________ is the shortcut to paste a file, which has already been cut or copied.
(a) Ctrl+X  (b) Ctrl+C
(c) Ctrl+V  (d) Ctrl+A

325. In Windows Explorer, ____________ is the shortcut to select all files and folders in the current directory.
(a) Ctrl+X  (b) Ctrl+C
(c) Ctrl+V  (d) Ctrl+A

326. To create Desktop shortcut for a file or program, right click on the file and choose ____________ menu in Windows Explorer.
(a) Send To $\rightarrow$ Desktop  (b) Send To $\rightarrow$ Drive name
(c) Send To $\rightarrow$ Compressed/Zipped archive  (d) Send To $\rightarrow$ Bluetooth Device

327. To compress a file, right click on the file and choose ____________ menu in Windows Explorer.
(a) Send To $\rightarrow$ Desktop  (b) Send To $\rightarrow$ Drive name
(c) Send To $\rightarrow$ Compressed/Zipped archive  (d) Send To $\rightarrow$ Bluetooth Device

328. To write a file or folder in an empty CD or DVD, right click on the file and choose ____________ menu in Windows Explorer.
(a) Send To $\rightarrow$ Desktop  (b) Send To $\rightarrow$ Drive name
(c) Send To $\rightarrow$ Compressed/Zipped archive  (d) Send To $\rightarrow$ Bluetooth Device

---

Prepared by: Dr. V. Nagaradjane
329. To share a file from a bluetooth enabled computer to a bluetooth enabled device, right click on the file and choose ________ menu in Windows Explorer.
   (a) Send To – > Desktop
   (b) Send To – > Drive name
   (c) Send To – > Compressed/Zipped archive
   (d) Send To – > Bluetooth Device

330. To delete a file, right click on the file and choose ________ menu in Windows Explorer.
   (a) Delete
   (b) Rename
   (c) Properties
   (d) Decompress/ Unzip

331. To view details of a file, right click on the file and choose ________ menu in Windows Explorer.
   (a) Delete
   (b) Rename
   (c) Properties
   (d) Decompress/ Unzip

332. To uncompress a zip file, right click on the file and choose ________ menu in Windows Explorer.
   (a) Delete
   (b) Rename
   (c) Properties
   (d) Decompress/ Unzip

333. In Windows, deleted file goes to ________.
   (a) Control Panel
   (b) Music
   (c) Recycle Bin
   (d) Documents

334. Pressing ________ keys in Windows Explorer will permanently delete a file (by-passing Recycle Bin).
   (a) Shift+Delete
   (b) Alt+Delete
   (c) Ctrl+Delete
   (d) Enter+Delete

Shortcut keys in Windows

335. To get Windows help, press ________ key.
   (a) F2
   (b) F3
   (c) F5
   (d) F1

336. To rename a file in Windows Explorer, press ________ key.
   (a) F2
   (b) F3
   (c) F5
   (d) F1

337. To search and find a file, press ________ key.
   (a) F2
   (b) F3
   (c) F5
   (d) F1

338. To refresh the display, press ________ key.
   (a) F2
   (b) F3
   (c) F5
   (d) F1

339. To move through various panes in Windows Explorer, press ________ key.
   (a) F6
   (b) F3
   (c) F5
   (d) F1

340. To lock computer display, press ________ keys.
   (a) Windows+R
   (b) Windows+M/ Windows+D
   (c) Windows+P
   (d) Windows+L

341. To run a command, press ________ keys.
   (a) Windows+R
   (b) Windows+M/ Windows+D
   (c) Windows+P
   (d) Windows+L

342. To minimize all windows and show the desktop, press ________ keys.
   (a) Windows+R
   (b) Windows+M/ Windows+D
   (c) Windows+P
   (d) Windows+L

343. To start print manager, press ________ keys.
   (a) Windows+R
   (b) Windows+M/ Windows+D
   (c) Windows+P
   (d) Windows+L

344. To open control panel, press ________ keys.
   (a) Windows+C
   (b) Windows+M/ Windows+D
   (c) Windows+P
   (d) Windows+L

345. To open accessibility features in Windows, press ________ keys.
   (a) Windows+K
   (b) Windows+V
   (c) Windows+I
   (d) Windows+A

346. To open keyboard settings, press ________ keys.
   (a) Windows+K
   (b) Windows+V
   (c) Windows+I
   (d) Windows+A

347. To open mouse settings, press ________ keys.
   (a) Windows+K
   (b) Windows+V
   (c) Windows+I
   (d) Windows+A
348. To start clipboard settings, press _______ keys.
(a) Windows+K  (b) Windows+V  (c) Windows+I  (d) Windows+A

349. To toggle caps lock on or off, press _______ keys.
(a) Windows+S  (b) Windows+F  (c) Windows+E  (d) Windows+A

350. To start open Windows/File Explorer, press _______ keys.
(a) Windows+K  (b) Windows+V  (c) Windows+E  (d) Windows+A

351. To close current program, press _______ keys.
(a) Alt+F4  (b) Alt+Tab  (c) Alt+Down arrow  (d) Alt+Space

352. To open the menu for shutdown, restart, hibernate Windows, etc., press _______ keys on Desktop.
(a) Alt+F4  (b) Alt+Tab  (c) Alt+Down arrow  (d) Alt+Space

353. To move from one program window to another, press _______ keys.
(a) Alt+F4  (b) Alt+Tab  (c) Alt+Down arrow  (d) Alt+Space

354. To open pop down menu list, press _______ keys.
(a) Alt+F4  (b) Alt+Tab  (c) Alt+Down arrow  (d) Alt+Space

355. To access system menu for a window, press _______ keys.
(a) Alt+F4  (b) Alt+Tab  (c) Alt+Down arrow  (d) Alt+Space

356. To access system menu for a child window, press _______ keys.
(a) Alt+F4  (b) Alt+Tab  (c) Alt+Space

357. To view properties of selected window, press _______ keys.
(a) Alt+Enter  (b) Alt+Left Arrow  (c) Shift+Delete

358. To move back to previous folder in Windows/File Explorer, press _______ keys.
(a) Alt+Enter  (b) Alt+Left Arrow  (c) Shift+Delete  (d) Shift+F10

359. To permanently delete a file, press _______ keys.
(a) Alt+Enter  (b) Alt+Left Arrow  (c) Shift+Delete  (d) Shift+F10

360. To open context menu (similar to right clicking using mouse), press _______ keys.
(a) Alt+Enter  (b) Alt+Left Arrow  (c) Shift+Delete  (d) Shift+F10

361. To disable Autorun for newly inserted media, keep pressing _______ key while inserting the media.
(a) Alt  (b) Ctrl  (c) Shift  (d) Space

362. To move from one child window to another, press _______ keys.
(a) Ctrl+Tab  (b) Ctrl+F4  (c) Ctrl+Esc  (d) Ctrl+Shift+Esc

363. To close a child window, press _______ keys.
(a) Ctrl+Tab  (b) Ctrl+F4  (c) Ctrl+Esc  (d) Ctrl+Shift+Esc

364. To display start menu, press _______ keys.
(a) Ctrl+Tab  (b) Ctrl+F4  (c) Ctrl+Esc  (d) Ctrl+Shift+Esc

365. To open task manager, press _______ keys.
(a) Ctrl+Tab  (b) Ctrl+F4  (c) Ctrl+Esc  (d) Ctrl+Shift+Esc

Prepared by: Dr. V. Nagaradjane
Using scanner, printer and webcam

366. To run a peripheral unit like scanner, printer or webcam, appropriate ______ needs to be installed first.
(a) driver (b) connector (c) conductor (d) resistor

367. On connecting a device with pre-installed driver, Windows ________
(a) rejects the device (b) displays unknown hardware message (c) initializes the device and makes it ready to work (d) does not care about the new device

368. Scanned images may be acquired using ______ software.
(a) scanner specific (b) MS Paint (c) Photoshop (d) all of them

369. Printer settings permit selection of appropriate ______ of paper.
(a) size (b) orientation (portrait or landscape) (c) thickness (in GSM) (d) all of them

370. A web camera is normally suitable for ______.
(a) low resolution images (b) streaming videos during video conferencing (c) both a & b (d) none of them

371. Web camera is normally ______ for high resolution photography.
(a) recommended (b) not suitable (c) used (d) suitable

372. Voice Over Internet Protocol (VOIP) programs like ________ make use of web camera.
(a) Skype (b) Hangouts/ Yahoo messenger (c) WhatsApp/ Viber (d) all of them

Answers (1 - 372)

1. (a) 2. (c) 3. (b) 4. (d) 5. (b) 6. (d) 7. (a) 8. (d) 9. (c) 10. (b) 11. (a) 12. (a) 13. (b) 14. (b) 15. (d) 16. (a) 17. (a) 18. (c) 19. (a) 20. (d) 21. (d) 22. (b) 23. (b) 24. (a) 25. (b) 26. (c) 27. (c) 28. (c) 29. (c) 30. (b) 31. (d) 32. (d) 33. (d) 34. (c) 35. (c) 36. (d) 37. (c) 38. (d) 39. (d) 40. (d) 41. (c) 42. (d) 43. (d) 44. (d) 45. (c) 46. (d) 47. (d) 48. (c) 49. (d) 50. (c) 51. (c) 52. (a) 53. (a) 54. (a) 55. (c) 56. (d) 57. (a) 58. (c) 59. (d) 60. (b) 61. (d) 62. (d) 63. (c) 64. (d) 65. (c) 66. (a) 67. (a) 68. (b) 69. (d) 70. (d) 71. (d) 72. (b) 73. (a) 74. (a) 75. (b) 76. (a) 77. (b) 78. (d) 79. (d) 80. (a) 81. (c) 82. (b) 83. (b) 84. (b) 85. (b) 86. (a) 87. (c) 88. (a) 89. (c) 90. (b) 91. (d) 92. (a) 93. (b) 94. (d) 95. (c) 96. (a) 97. (a) 98. (b) 99. (d) 100. (c) 101. (d) 102. (b) 103. (a) 104. (c) 105. (a) 106. (b) 107. (c) 108. (a) 109. (d) 110. (c) 111. (b) 112. (a) 113. (b) 114. (c) 115. (c) 116. (c) 117. (a) 118. (b) 119. (c) 120. (c) 121. (a) 122. (b) 123. (c) 124. (a) 125. (c) 126. (b) 127. (d) 128. (a) 129. (b) 130. (c) 131. (d) 132. (a) 133. (b) 134. (c) 135. (a) 136. (c) 137. (b) 138. (a) 139. (d) 140. (d) 141. (d) 142. (c) 143. (b) 144. (a) 145. (a) 146. (b) 147. (b) 148. (a) 149. (a) 150. (b) 151. (d) 152. (b) 153. (c) 154. (d) 155. (c) 156. (d) 157. (d) 158. (c) 159. (a) 160. (b) 161. (c) 162. (d) 163. (b) 164. (c) 165. (d) 166. (a) 167. (d) 168. (c) 169. (a) 170. (a) 171. (c) 172. (b) 173. (c) 174. (d) 175. (a) 176. (c) 177. (b) 178. (d) 179. (b) 180. (d) 181. (c) 182. (b) 183. (c) 184. (a) 185. (d) 186. (b) 187. (c) 188. (a) 189. (a) 190. (d) 191. (b) 192. (c) 193. (a) 194. (b) 195. (d) 196. (b) 197. (c) 198. (a) 199. (d) 200. (c) 201. (a) 202. (c) 203. (a) 204. (c) 205. (d) 206. (a) 207. (b) 208. (a) 209. (c) 210. (d) 211. (a) 212. (b) 213. (c) 214. (b) 215. (a) 216. (a) 217. (b) 218. (c) 219. (c) 220. (a) 221. (d) 222. (a) 223. (c) 224. (c) 225. (a) 226. (b) 227. (d) 228. (c) 229. (c) 230. (b) 231. (d) 232. (c) 233. (a) 234. (b) 235. (d) 236. (c)
237. (b) 238. (b) 239. (a) 240. (c) 305. (d) 306. (c) 307. (d) 308. (a)
241. (c) 242. (a) 243. (c) 244. (d) 309. (d) 310. (c) 311. (a) 312. (b)
245. (b) 246. (a) 247. (b) 248. (a) 313. (c) 314. (a) 315. (b) 316. (d)
249. (d) 250. (c) 251. (a) 252. (b) 317. (c) 318. (a) 319. (b) 320. (a)
253. (d) 254. (a) 255. (d) 256. (c) 321. (a) 322. (b) 323. (a) 324. (c)
257. (d) 258. (b) 259. (b) 260. (b) 325. (d) 326. (a) 327. (c) 328. (b)
261. (b) 262. (b) 263. (a) 264. (b) 329. (d) 330. (a) 331. (c) 332. (d)
265. (d) 266. (c) 267. (b) 268. (d) 333. (c) 334. (a) 335. (d) 336. (a)
269. (d) 270. (a) 271. (b) 272. (d) 337. (b) 338. (c) 339. (a) 340. (d)
273. (a) 274. (b) 275. (d) 276. (c) 341. (a) 342. (b) 343. (c) 344. (a)
277. (d) 278. (c) 279. (b) 280. (b) 345. (d) 346. (a) 347. (c) 348. (b)
281. (d) 282. (a) 283. (c) 284. (b) 349. (a) 350. (c) 351. (a) 352. (a)
285. (c) 286. (a) 287. (b) 288. (d) 353. (b) 354. (c) 355. (d) 356. (c)
289. (d) 290. (d) 291. (d) 292. (a) 357. (a) 358. (b) 359. (c) 360. (d)
293. (a) 294. (d) 295. (b) 296. (c) 361. (c) 362. (a) 363. (b) 364. (c)
297. (d) 298. (c) 299. (a) 300. (a) 365. (d) 366. (a) 367. (c) 368. (d)
301. (c) 302. (d) 303. (a) 304. (b) 369. (d) 370. (c) 371. (b) 372. (d)
1.2 Computer Administration

1. The power on process of a computer is called ______.  
(a) waking up  
(b) boot strapping  
(c) formatting  
(d) installing

2. The test performed by computer to identify the hardware peripherals and units attached to it is called ______.  
(a) Power On Self Test  
(b) Disk Defragmenting  
(c) formatting  
(d) scandisk

3. In booting of computer, POST is expanded as ______.  
(a) Power On Self Test  
(b) Disk Defragmenting  
(c) formatting  
(d) scandisk

4. Primary boot process is otherwise called ______.  
(a) POST  
(b) loading of operating system  
(c) installation  
(d) formatting

5. Full form of BIOS is ______.  
(a) Bare Input Output System  
(b) Basic Intermediate Operating System  
(c) Banned Input Output System  
(d) Basic Input Output System

6. Essential settings like date, time, boot order, etc. needed for BIOS at boot time are stored in ______.  
(a) POST  
(b) CMOS  
(c) Hard Disk  
(d) DVD

7. In computer mother board, CMOS stands for ______.  
(a) Corroded Metal Oxide Semiconductor  
(b) Contact Metal Oxide Semiconductor  
(c) Complementary Metal Oxide Semiconductor  
(d) Complementary Metal Oxide Syntax

8. CMOS is a ______.  
(a) RAM  
(b) ROM  
(c) EPROM  
(d) EEPROM

9. Memory which can be written only once is called ______.  
(a) RAM  
(b) ROM  
(c) EPROM  
(d) EEPROM

10. Memory which can be erased and reprogrammed is called ______.  
(a) RAM  
(b) ROM  
(c) EPROM  
(d) EEPROM

11. Memory which can be erased using electric current and reprogrammed is called ______.  
(a) RAM  
(b) ROM  
(c) EPROM  
(d) EEPROM

12. ROM stands for ______.  
(a) Random Ordinary Memory  
(b) Read Only Memory  
(c) Read Ordinary Memory  
(d) Read Only Mail

13. EPROM stands for ______.  
(a) Erasable Partition Read Only Memory  
(b) Erasable Pointer Read Only Memory  
(c) Extended Programmable Read Only Memory  
(d) Erasable Programmable Read Only Memory

14. EEPROM stands for ______.  
(a) Electrically Erasable Programmable Read Only Memory  
(b) Extremely Erasable Programmable Read Only Memory  
(c) Effectively Erasable Programmable Read Only Memory  
(d) Extended Erasable Programmable Read Only Memory

15. ______ keeps CMOS is in power on condition.  
(a) Hard disk  
(b) RAM  
(c) SMPS  
(d) CMOS Battery (CR2032)

16. After booting process, BIOS helps in ______.  
(a) data transfer  
(b) processing  
(c) graphics  
(d) cloud storage

17. First part of boot loader accessed from BIOS chip is called ______.  
(a) intermediate boot loader  
(b) tertiary boot loader  
(c) secondary boot loader  
(d) primary boot loader

18. On completion of POST, the computer emits ______.  
(a) foul odour  
(b) music  
(c) beep  
(d) water

19. The second part of boot loader responsible for booting the operating system is called ______.  
(a) intermediate boot loader  
(b) tertiary boot loader  
(c) secondary boot loader
Q. Bank [COPA Semester - 1]

20. GRUB stands for ________________.
(a) GRand Unified Boot Loader
(b) Generic Unified Boot Loader
(c) Grand United Boot Loader
(d) Great Unified Boot Loader

21. In booting a computer, MBR stands for
(a) Master Boot Reader
(b) Multi Boot Record
(c) Meta Boot Record
(d) Master Boot Record

22. In booting a computer, BOOTMGR stands for ________________.
(a) Best Master
(b) Boot Man
(c) Boot Manager
(d) Boot Mirage

23. In booting a computer, NTLDR stands for ________________.
(a) Next Technology LoaDeR
(b) New Technology LoaDeR
(c) New Terminal LoaDeR
(d) New Talent LoaDeR

24. In booting a computer, UEFI stands for ________________.
(a) Unified Extensible Firmware Interface
(b) United Extensible Firmware Interface
(c) Universal Extensible Firmware Interface
(d) Uniform Extensible Firmware Interface

25. In booting a computer, ESP stands for ________________.
(a) EFI System Package
(b) EFI Sorted Partition
(c) EFI System Partition
(d) EFI Self Partition

1.2.1 Booting error signals

26. The type of error signal depends upon ________________ of the computer.
(a) power switch
(b) manufacturer of the BIOS chip
(c) type of monitor
(d) type of keyboard

27. 1 short beep during POST denotes ________________ of computer.
(a) normal boot
(b) error code displayed on screen
(c) power problem
(d) mother board problem

28. 1 short and 1 long beeps during POST denotes ________________ of computer.
(a) normal boot
(b) error code displayed on screen
(c) power problem
(d) mother board problem

1.2.2 BIOS settings

34. CMOS is a type of ________________.
(a) ROM
(b) DVD
(c) CD
(d) RAM

35. CMOS is kept powered on using ________________.
(a) AA battery
(b) AAA battery
(c) CMOS battery (CR2032)
(d) wet cell battery

36. When CMOS battery fails, all BIOS settings are ________________.
(a) remembered
(b) lost
(c) maintained
(d) kept stored

37. BIOS settings may be accessed by pressing ________________ key immediately after switching power supply on.

Prepared by: Dr. V. Nagarajane
38. Usually, date, time, drive options, memory details, etc. are accessible under ______ menu of BIOS settings.
   (a) Advanced  (b) Main  (c) Power  (d) Boot

39. Usually, processor configuration, onboard settings of motherboard, USB configuration, etc. are accessible under ______ menu of BIOS settings.
   (a) Advanced  (b) Main  (c) Power  (d) Boot

40. Usually, power options are accessible under ______ menu of BIOS settings.
   (a) Advanced  (b) Main  (c) Power  (d) Boot

41. Usually, UEFI settings, order of boot media, etc. are accessible under ______ menu of BIOS settings.
   (a) Advanced  (b) Main  (c) Power  (d) Boot

42. Passwords for user and administrator of BIOS may be accessed using ______ menu of BIOS settings.
   (a) Advanced  (b) Security  (c) Power  (d) Boot

43. Options for saving or discarding changes and exiting BIOS settings is accessible from ______ menu of BIOS settings.
   (a) Advanced  (b) Security  (c) Power  (d) Exit

1.2.3 Installation of windows operating system

44. After inserting the Windows installation media (like CD, DVD or pen drive), ______ message is displayed.
   (a) Press any key to boot from CD/ DVD ...  (b) Press Ctrl+Alt+Delete  (c) Press left button of mouse  (d) Press centre button of mouse

45. When Windows loads during installation, ______ are to be chosen first.
   (a) keyboard layout  (b) language selection for installation  (c) both a & b  (d) neither a nor b

46. When the menu for managing hard disk partitions is displayed, ______ options help to create, delete and format partitions.
   (a) New  (b) Delete  (c) Format  (d) all of them

47. After choosing a suitable partition for installation of Windows, ______ delete that partition.
   (a) select partition and press Next button  (b) press Ctrl+Alt+Delete  (c) Switch off power supply

48. During installation of Windows, the computer ______ after copying files, installing features.
   (a) reboots  (b) keeps on processing  (c) keeps on beeping  (d) plays music

49. During installation of Windows, user names and passwords are entered ______ the operating system gets fully ready.
   (a) before  (b) after  (c) only after  (d) subsequent to

50. After completing installation of Windows, ______ are to be installed for making the computer safe and productive.
   (a) anti-virus  (b) Office package  (c) Adobe Reader and other application software packages  (d) all of them

1.2.4 Common computer problems and solutions

51. For many problems, ______ the computer solves the troubles.
   (a) rebooting  (b) selling off  (c) condemning  (d) cursing

52. If the computer is very slow, ______.
   (a) unplug Internet connection  (b) open task manager (Ctrl+Shift+ESC or Ctrl+Alt+Delete)  (c) right click and end runaway programs  (d) try any one or all the techniques

53. When the computer exhibits unpredictable behaviour, ______.
(a) remove all peripherals except keyboard, mouse and monitor and reboot
(b) identify the erring peripheral by connecting each peripheral one by one
(c) try system restore to a previous date
(d) all of them

54. When the PC does not boot, try
(a) verify power cables
(b) check whether green LED on mother board glows
(c) switch on SMPS power switch, if any, and verify whether the SMPS fan runs
(d) all of them

55. If a computer emits beeps and halts, do _________ to make the computer work again.
(a) remove RAM, clean and refix
(b) remove VGA cable and reconnect
(c) remove CMOS battery (CR2032) and replace it with new one
(d) all or any one of them

56. If computer displays the error message "Insert boot media", do _________
(a) modify BIOS settings to boot from hard disk
(b) configure the BIOS to boot from alternate installation media like CD/DVD
(c) reboot to try whether secondary boot process starts
(d) all of them

57. When boot is halted due to wrong BIOS settings, _________
(a) press DEL, F2 or ESC key to enter BIOS settings
(b) set correct date and time
(c) set correct boot order
(d) all of them

58. If a computer does not switch on, do _________
(a) check power cables
(b) check whether SMPS is running
(c) switch on SMPS, if it has any switch
(d) all of them

59. If a computer losses BIOS settings after each power off, do _________
(a) replace CMOS battery (CR2032)
(b) sell off the computer
(c) switch off the computer
(d) clean the computer

60. If printer does not work in a computer, do _________
(a) check PC to printer connection
(b) check whether appropriate driver has been installed for the printer
(c) start print spooler service from control panel
(d) all of them

61. If a PC displays access violation error and reboots in the middle of working,
(a) check the RAM chip
(b) replace the RAM chip and try whether the problem continues
(c) both a & b
(d) neither a nor b

62. If the Internet connection is very slow, do _________
(a) disable automatic software updates
(b) stop cloud storage services like drop box, one drive, iCloud, etc. from syncing on slow connection
(c) stop messenger services which have opened at boot time
(d) all of them

63. If a program does not install or closes just after install screen opens, do _________
(a) check whether the program is compatible to the operating system (64 bit or 32 bit)
(b) right click on setup program and choose Run as Administrator
(c) try to run the program in compatibility mode
(d) all of them

64. When there is a paper jam in printer, do _________
(a) switch off printer
(b) open the lid
(c) gently remove the jammed paper
(d) all of them

Answers (373 - 436)

1. (b) 2. (a) 3. (a) 4. (a) 5. (d) 6. (b) 7. (c) 8. (a) 9. (b) 10. (c) 11. (d) 12. (b) 13. (d) 14. (a) 15. (d) 16. (a) 17. (d) 18. (c) 19. (c) 20. (a) 21. (d) 22. (c) 23. (b) 24. (a) 25. (c) 26. (b) 27. (a) 28. (d) 29. (b) 30. (c) 31. (a) 32. (a) 33. (b) 34. (d) 35. (c) 36. (b) 37. (d) 38. (b) 39. (a) 40. (c) 41. (d) 42. (b) 43. (d) 44. (a) 45. (c) 46. (d) 47. (b) 48. (a) 49. (a) 50. (d) 51. (a) 52. (d) 53. (d) 54. (d) 55. (d) 56. (d) 57. (d) 58. (d) 59. (a) 60. (d) 61. (c) 62. (d) 63. (d) 64. (d)
1.3 MS DOS and Linux

1.3.1 MS DOS

1. MS DOS stands for ________________.
   (a) MicroSoft Disk Operating System
   (b) MicroSecond Disk Operating System
   (c) MicroSoft Dirty Operating System
   (d) Microsoft Disk Opening System

2. MS DOS was first released in the year ____________.
   (a) 1969 (b) 1972 (c) 1981 (d) 2000

3. All development activities on MS DOS ceased in the year ____________.
   (a) 1969 (b) 1972 (c) 1981 (d) 2000

4. The last version of MS DOS was ____________.
   (a) 7.0 (b) 8.0 (c) 9.0 (d) 10.0

5. MS DOS executable files normally have ____________ extension.
   (a) .EXE (b) .COM (c) .BAT (d) all of them

6. The commands loaded to main memory along with MS DOS operating system are called ____________ DOS commands.
   (a) internal (b) external (c) useless (d) unwanted

7. The commands stored in a disk and loaded to main memory only when first invoked are called ____________ DOS commands.
   (a) internal (b) external (c) useless (d) unwanted

8. If a file has .BAT extension and contains a list of commands to be executed, the file is called a ____________ file.
   (a) database (b) temporary (c) batch (d) shell script

1.3.2 Internal DOS commands

9. Typical first line in a DOS batch file is ____________.
   (a) @ECHO OFF (b) DIR (c) MD (d) RD

10. The list of directories in which external DOS commands will be searched is called ____________.
    (a) WINDIR (b) PATH (c) HOME (d) VER

11. Of the following alternatives, ____________ command displays current value of path variable.
    (a) CLS %PATH%
    (b) PROMPT %PATH%
    (c) PAUSE %PATH%
    (d) ECHO %PATH%

12. A new folder (e.g., C: \ USERS\COPA\BIN) may be appended to PATH variable using the command ____________.
    (a) SET PATH=%PATH%;C: \ USERS\COPA\BIN
    (b) export PATH=$PATH;C: \ USERS\COPA\BIN
    (c) CLS %PATH%;C: \ USERS\COPA\BIN
    (d) PAUSE %PATH%;C: \ USERS\COPA\BIN

13. To clear screen contents, ____________ command is used.
    (a) VER (b) DIR (c) CLS (d) VOL

14. ____________ command displays version number of MS DOS.
    (a) VER (b) DIR (c) CLS (d) VOL

15. ____________ command displays the list of files and directories.
    (a) VER (b) DIR (c) CLS (d) VOL

16. ____________ command displays volume label of given drive.
    (a) VER (b) DIR (c) CLS (d) VOL

17. ____________ command displays current date and gets new date for resetting.
    (a) DATE (b) TIME (c) COPY (d) COPY CON < file.txt >

18. DATE command should be run as ____________ to set new date.
    (a) unknown user (b) guest user (c) ordinary user (d) Administrator

19. Recommended format for entering new date using DATE command (in Indian locale) is ____________.
    (a) yyy-ddd-mmm (b) yy-dd-mm (c) dd-mm-yy (d) yyy-mm-dd

20. ____________ command displays current date and gets new date for resetting.
21. ___________ command displays current time and gets new time for resetting.
   (a) DATE
   (b) TIME
   (c) COPY
   (d) COPY CON < file.txt >

22. TIME command should be run as ___________ to set new time.
   (a) unknown user
   (b) guest user
   (c) ordinary user
   (d) Administrator

23. Recommended format for entering new date using TIME command (in Indian locale) is ___________.
   (a) hh:mm:ss
   (b) mm:ss:hh
   (c) ss:mm:hh
   (d) mm:hh:ss

24. ___________ command creates a text file (named file.txt) and saves keyboard input to that file.
   (a) DATE
   (b) TIME
   (c) COPY
   (d) COPY CON < file.txt >

25. To end the input to the command COPY CON < file.txt > and to save text to that file, enter ___________.
   (a) Ctrl+Z Ctrl+C Enter
   (b) Ctrl+X Ctrl+C Enter
   (c) Ctrl+Z Ctrl+C Shift
   (d) Ctrl+Z Ctrl+C X Enter

26. To display the contents of a file (e.g., FILE.TXT) on the screen, issue the command ___________.
   (a) MDISK FILE.TXT
   (b) DEL FILE.TXT
   (c) TYPE FILE.TXT
   (d) MOVE FILE.TXT ..

27. To create copy of an existing file (F1.TXT) in a new name (F2.TXT), issue the command ___________.
   (a) COPY F1.TXT F2.TXT
   (b) DEL F1.TXT F2.TXT
   (c) REN F1.TXT F2.TXT
   (d) ATTRIB +H F1.TXT F2.TXT

28. To create a copy of one file in a new name, ___________ command is used.
   (a) MOVE
   (b) REN
   (c) COPY
   (d) MDISK

29. To delete a file, ___________ DOS command is used.
   (a) MOVE
   (b) DEL
   (c) COPY
   (d) MDISK

30. Issuing the DOS command DEL ** deletes ___________.
    (a) last file in the current directory
    (b) parent directory
    (c) current directory
    (d) all files in current directory

31. To change from one directory to another, ___________ DOS command is used.
    (a) CD
    (b) MD
    (c) RD
    (d) ATTRIB

32. ___________ command may also be used in place of the DOS command CD.
    (a) CHDIR
    (b) MKDIR
    (c) RMDIR
    (d) ERASE

33. ___________ command may also be used in place of the DOS command MD.
    (a) CHDIR
    (b) MKDIR
    (c) RMDIR
    (d) ERASE

34. ___________ command may also be used in place of the DOS command RD.
    (a) CHDIR
    (b) MKDIR
    (c) RMDIR
    (d) ERASE

35. ___________ command may also be used in place of the DOS command DEL.
    (a) CHDIR
    (b) MKDIR
    (c) RMDIR
    (d) ERASE

36. To create a directory, ___________ DOS command may be used.
    (a) CD/ CHDIR
    (b) MD/ MKDIR
    (c) RD/ RMDIR
    (d) DEL/ ERASE

37. To remove a directory, ___________ DOS command may be used.
    (a) CD/ CHDIR
    (b) MD/ MKDIR
    (c) RD/ RMDIR
    (d) DEL/ ERASE

38. Issuing ___________ command causes commands in a batch file to be hidden.
    (a) ECHO OFF
    (b) ECHO ON
    (c) PAUSE
    (d) PROMPT

39. Issuing ___________ command causes commands in a batch file to be visible.
    (a) ECHO OFF
    (b) ECHO ON
    (c) PAUSE
    (d) PROMPT

40. To display the value of PATH environment variable, ___________ of the following commands is useful.
    (a) SET %PATH%
    (b) PAUSE %PATH%
41. The environment variable in DOS contains the list of folders in which commands would be searched.
   (a) PATH (b) CLASSPATH  
   (c) WINDIR (d) HOME

42. The environment variable in DOS contains the name of home directory for current user.
   (a) PATH (b) CLASSPATH  
   (c) WINDIR (d) HOME

43. To rename a file (X.TXT) to a new name (Y.TXT), which of the following commands would be suitable?
   (a) COPY X.TXT Y.TXT  
   (b) REN X.TXT Y.TXT  
   (c) MKDIR X.TXT  
   (d) DEL X.TXT Y.TXT

44. To hold the processing of commands till any key is pressed, _______ DOS command is used.
   (a) SLEEP  
   (b) PROMPT  
   (c) PAUSE  
   (d) SET

45. To change the command prompt in MS DOS, _______ command is used.
   (a) SLEEP  
   (b) PROMPT  
   (c) PAUSE  
   (d) SET

46. To set value for an environment variable in MS DOS, _______ command is used.
   (a) SLEEP  
   (b) PROMPT  
   (c) PAUSE  
   (d) SET

47. To create a remarks line (which is ignored during processing) in MS DOS, _______ command is used.
   (a) REM  
   (b) PROMPT  
   (c) PAUSE  
   (d) SET

48. _______ command closes the MS DOS session.
   (a) CLS  
   (b) PAUSE  
   (c) EXIT  
   (d) REM

1.3.3 External DOS Commands

49. The command (removed in the latest version of MS DOS) adds given string to the end of PATH environment variable.
   (a) SORT  
   (b) APPEND  
   (c) MOVE  
   (d) ASSIGN

50. The _______ command changes given drive to a new name.
   (a) SORT  
   (b) APPEND  

51. The _______ command changes file attributes like archive, hidden or read-only.
   (a) ATTRIB  
   (b) APPEND  
   (c) MOVE  
   (d) ASSIGN

52. To hide a file (say FILE.TXT), _______ DOS command is used.
   (a) ATTRIB -A FILE.TXT  
   (b) ATTRIB -A FILE.TXT  
   (c) ATTRIB -H FILE.TXT  
   (d) ATTRIB +H FILE.TXT

53. To unhide a file (say FILE.TXT), _______ DOS command is used.
   (a) ATTRIB -A FILE.TXT  
   (b) ATTRIB -A FILE.TXT  
   (c) ATTRIB +H FILE.TXT  
   (d) ATTRIB -H FILE.TXT

54. To set archive attribute to file (say FILE.TXT), _______ DOS command is used.
   (a) ATTRIB -A FILE.TXT  
   (b) ATTRIB +A FILE.TXT  
   (c) ATTRIB -H FILE.TXT  
   (d) ATTRIB +H FILE.TXT

55. To remove archive attribute from file (say FILE.TXT), _______ DOS command is used.
   (a) ATTRIB -A FILE.TXT  
   (b) ATTRIB +A FILE.TXT  
   (c) ATTRIB -H FILE.TXT  
   (d) ATTRIB -H FILE.TXT

56. To set a file (say FILE.TXT) to read-only mode, _______ DOS command is used.
   (a) ATTRIB -A FILE.TXT  
   (b) ATTRIB +A FILE.TXT  
   (c) ATTRIB +R FILE.TXT  
   (d) ATTRIB -R FILE.TXT

57. To set a file (say FILE.TXT) to read/write (i.e., to remove read-only attribute) mode, _______ DOS command is used.
   (a) ATTRIB -A FILE.TXT  
   (b) ATTRIB +A FILE.TXT  
   (c) ATTRIB +R FILE.TXT  
   (d) ATTRIB -R FILE.TXT

58. _______ MS DOS command (removed from latest version of MS DOS) creates a backup of all files having archive attribute.
   (a) CHKDSK  
   (b) BACKUP  
   (c) COMMAND.COM  
   (d) COMP
59.  *MS DOS command verifies file system in given drive and repairs the file system if necessary.*
   (a) **CHKDSK**  (b) **BACKUP**  (c) **COMMAND.COM**  (d) **COMP**

60.  *MS DOS command is the DOS shell.*
   (a) **CHKDSK**  (b) **BACKUP**  (c) **COMMAND.COM**  (d) **COMP**

61.  *MS DOS command compares two files and reports any differences.*
   (a) **CHKDSK**  (b) **BACKUP**  (c) **COMMAND.COM**  (d) **COMP**

62.  *MS DOS command helps to debug a program and inspect values stored in variables.*
   (a) **DEBUG**  (b) **DISKCOMP**  (c) **DISKCOPY**  (d) **DOSKEY**

63.  *MS DOS command keeps history of previous DOS commands and permits navigation on pressing UP or DOWN arrows.*
   (a) **DEBUG**  (b) **DISKCOMP**  (c) **DISKCOPY**  (d) **DOSKEY**

64.  *MS DOS command compares the contents of 2 disks and reports the differences, if any.*
   (a) **DEBUG**  (b) **DISKCOMP**  (c) **DISKCOPY**  (d) **DOSKEY**

65.  *MS DOS command copies the contents of one disk to another.*
   (a) **DEBUG**  (b) **DISKCOMP**  (c) **DISKCOPY**  (d) **DOSKEY**

66.  *MS DOS command displays a visual window for accessing files and folders.*
   (a) **DOSSHEL**  (b) **DISKCOMP**  (c) **DISKCOPY**  (d) **DOSKEY**

67.  *MS DOS command opens a full screen editor.*
   (a) **FC**  (b) **EDIT**  (c) **EDLIN**  (d) **EXPAND**

68.  *MS DOS command edits text data line by line.*
   (a) **FC**  (b) **EDIT**  (c) **EDLIN**  (d) **EXPAND**

69.  *MS DOS command expands a compressed file.*
   (a) **FC**  (b) **EDIT**  (c) **EDLIN**  (d) **EXPAND**

70.  *MS DOS command compares 2 files with text or binary content.*
   (a) **FC**  (b) **EDIT**  (c) **EDLIN**  (d) **EXPAND**

71.  *MS DOS command compares 2 files.*
   (a) **FC**  (b) **EDIT**  (c) **EDLIN**  (d) **EXPAND**

72.  *MS DOS command helps to create and manage partitions in hard disk.*
   (a) **FDISK**  (b) **FORMAT**  (c) **EDLIN**  (d) **EXPAND**

73.  *MS DOS command formats (creates new file system on) given partition.*
   (a) **FDISK**  (b) **FORMAT**  (c) **EDLIN**  (d) **EXPAND**

74.  *MS DOS command displays help information about given command.*
   (a) **FDISK**  (b) **FORMAT**  (c) **HELP**  (d) **LABEL**

75.  *MS DOS command displays disk label.*
   (a) **FDISK**  (b) **FORMAT**  (c) **HELP**  (d) **LABEL**

76.  *MS DOS command displays volume details.*
   (a) **VOL**  (b) **FORMAT**  (c) **HELP**  (d) **LABEL**

77.  *MS DOS command displays memory usage details.*
   (a) **MOVE**  (b) **MEM**  (c) **MIRROR**  (d) **MORE**

78.  *MS DOS command creates a backup file for restoration of data at a later date.*
   (a) **MOVE**  (b) **MEM**  (c) **MIRROR**  (d) **MORE**

79.  *MS DOS command creates a new copy of the file and deletes the source file.*
   (a) **MOVE**  (b) **MEM**  (c) **MIRROR**  (d) **MORE**

80.  *MS DOS command displays screen output in readable chunks/pages.*
   (a) **MOVE**  (b) **MEM**  (c) **MIRROR**  (d) **MORE**

81.  *MS DOS command prints a file to the default printer.*
   (a) **SCANDISK**  (b) **SORT**
1.3.4 Output redirection in MS DOS

88. ____________ redirector writes output of a program to a new file, deleting the old contents, if any.

(a) >          (b) >>
(c) |          (d) none of them

89. ____________ redirector appends output of a program to an existing file, creating the file if it does not exist.

(a) >          (b) >>
(c) |          (d) none of them

90. ____________ redirector sends output of a program to another program as input.

(a) >          (b) >>
(c) |          (d) none of them

1.3.5 Wild cards in MS DOS

91. The *, ? characters in MS DOS are called ____________.

(a) green cards  (b) white cards  (c) SIM cards  (d) wild cards

92. ____________ wild card matches any number of characters in the name.

(a) *          (b) ?
(c) &          (d) $

93. ____________ wild card matches a single character.

(a) *          (b) ?
(c) &          (d) $

1.3.6 Open Source Software (OSS)

94. Any software (paid or free), for which source code is available is called ____________.

(a) open source software
(b) free software
(c) virus software
(d) hacked software

95. ____________ helps capable users to improve and bug fix the software.

(a) open source software
(b) closed source software
(c) virus software
(d) hacked software

96. ____________ model of software helps developers across the world to cooperate in development of software.

(a) open source software
(b) closed source software
(c) virus software
(d) hacked software

97. An example of the most popular open source software is ____________.

(a) Mozilla Firefox browser, GIMP image editor, QCAD drafting tool, Blender 3D modelling software
(b) Linux operating system
(c) Open office, Libre Office, KOffice, gnumeric, AbiWord, Scribus
(d) all of them

98. ____________ are some of the open source licensing models.

(a) GNU GPL/ GNU LGPL
(b) Apache lincense
(c) BSD/ MIT/ Eclipse/ Mozilla license
(d) all of them

99. GNU GPL stands for ____________.

(a) GNU General Public License
(b) GNU Lesser General Public License
(c) GNU Not Unix
(d) GNU Image Manipulation Programme
100. GNU LGPL stands for ____________ and it permits embedding open source libraries in closed source projects.
(a) GNU General Public License  
(b) GNU Lesser General Public License  
(c) GNU Not Unix  
(d) GNU Image Manipulation Programme

101. GNU stands for ____________.
(a) GNU General Public License  
(b) GNU Lesser General Public License  
(c) GNU Not Unix  
(d) GNU Image Manipulation Programme

102. GIMP stands for ____________.
(a) GNU General Public License  
(b) GNU Lesser General Public License  
(c) GNU Not Unix  
(d) GNU Image Manipulation Programme

103. ____________ founded the GNU project to create an alternative to UNIX operating system from scratch.
(a) Richard Stallman  
(b) Linus Torvalds  
(c) Dennis Ritchie  
(d) Brian Kernighan

104. ____________ created and released Linux operating system.
(a) Richard Stallman  
(b) Linus Torvalds  
(c) Dennis Ritchie  
(d) Brian Kernighan

105. Linux operating system was released in the year ____________.
(a) 1969  
(b) 1972  
(c) 1981  
(d) 1991

106. The core of the Linux operating system, which manages files, peripherals and other resources, is called ____________.
(a) kernel  
(b) shell  
(c) neither a nor b  
(d) both a and b

107. The software which helps the user to communicate with the kernel of Linux operating system is called ____________.
(a) kernel  
(b) shell  
(c) neither a nor b  
(d) both a and b

108. Bash in Linux shell stands for ____________.
(a) Bourne Again SHell  
(b) C-Shell

109. The Linux shell having features similar to the C-Programming language is called ____________.
(a) Bourne Again SHell  
(b) C-Shell  
(c) Korn-shell  
(d) none of them

110. ____________ shell was released by AT&T as an improvement to the Bourne shell.
(a) Bourne Again SHell  
(b) C-Shell  
(c) Korn-shell  
(d) none of them

111. The command ____________ in Linux opens ____________ shell.
(a) Bourne Again SHell  
(b) C-Shell  
(c) Korn-shell  
(d) none of them

112. The command ____________ in Linux opens ____________ shell.
(a) Bourne Again SHell  
(b) C-Shell  
(c) Korn-shell  
(d) none of them

113. Any shell script begins with the line ____________ to denote the name of the shell to be used for interpretation.
(a) #!/bin/sh  
(b) #!/bin/csh  
(c) #!/bin/ksh  
(d) any one of them

1.3.7 Linux shell commands

114. To display the list of files and directories, ____________ Linux command is used.
(a) ls  
(b) chmod  
(c) mkdir  
(d) rmdir

115. ____________ Linux command creates a new directory.
(a) ls  
(b) chmod  
(c) mkdir  
(d) rmdir

116. ____________ Linux command removes given directory.
(a) ls  
(b) chmod  
(c) mkdir  
(d) rmdir

117. ____________ Linux command changes the access mode of a file.
(a) pwd  
(b) chmod  
(c) mkdir  
(d) rmdir
118. The numeric value of read permission is
(a) 4 (b) 2
(c) 1 (d) 0

119. The numeric value of write permission is
(a) 4 (b) 2
(c) 1 (d) 0

120. In Linux, the numeric value of execute permission is  
(a) 4 (b) 2
(c) 1 (d) 0

121. In Linux, a file having read and write permissions would have a numeric value of_________ as argument to chmod.
(a) 6 (b) 7
(c) 4 (d) 5

122. In Linux, a file having read only permissions would have a numeric value of_________ as argument to chmod.
(a) 6 (b) 7
(c) 4 (d) 5

123. In Linux, a file having read, write and execute permissions would have a numeric value of_________ as argument to chmod.
(a) 6 (b) 7
(c) 4 (d) 5

124. In Linux, a file having read and execute permissions would have a numeric value of_________ as argument to chmod.
(a) 6 (b) 7
(c) 4 (d) 5

125. In Linux, access permission meant for
(a) user (b) group
(c) world (d) all of them

126. In Linux, first value of permission provided to chmod command is meant for
(a) user (b) group
(c) world (d) all of them

127. In Linux, second value of permission provided to chmod command is meant for
(a) user (b) group
(c) world (d) all of them

128. In Linux, third value of permission provided to chmod command is meant for
(a) user (b) group
(c) world (d) all of them

129. Any person unrelated to the current user or the group of the current user is treated with_________ permissions.

(a) user (b) group
(c) world (d) all of them

130. _________ Linux command creates a copy of given file in new name.
(a) cp (b) ln
(c) mv (d) cd

131. _________ Linux command creates a link to the current file (not a full copy of the file).
(a) cp (b) ln
(c) mv (d) cd

132. _________ Linux command deletes the source file and creates copy of the source file in a new name.
(a) cp (b) ln
(c) mv (d) cd

133. _________ Linux command helps user to change current working directory.
(a) cp (b) ln
(c) mv (d) cd

134. _________ Linux command displays full path of the current directory.
(a) cp (b) pwd
(c) mv (d) cd

135. In Linux, the character . denotes _________ directory.
(a) current (b) parent
(c) home (d) root

136. In Linux, the characters .. denote _________ directory.
(a) current (b) parent
(c) home (d) root

137. In Linux, the character / denotes _________ directory.
(a) current (b) parent
(c) home (d) root

138. In Linux, _________ command is used to mount a new file system.
(a) eject (b) mount
(c) umount (d) shutdown

139. In Linux, _________ command is used to unmount a new file system.
(a) eject (b) mount
(c) umount (d) shutdown
141. In Linux, ________ command ejects removable media drive like CD/DVD drive.
(a) eject  (b) mount  (c) umount  (d) shutdown

142. In Linux, ________ command should be run as root user to shutdown the computer.
(a) eject  (b) mount  (c) umount  (d) shutdown

143. The command `shutdown -r now` ________ the computer immediately.
(a) reboots  (b) halts  (c) sleep  (d) sort

144. The command `shutdown -h now` or `shutdown -P now` or `shutdown -H now` ________ the computer immediately.
(a) reboots  (b) halts  (c) sleep  (d) sort

145. The Linux command `shutdown -c` ________ the computer.
(a) reboots  (b) halts  (c) sleep  (d) cancels reboot or power-off of

146. ________ Linux command sorts the input.
(a) reboots  (b) halts  (c) sleep  (d) sort

147. ________ Linux command makes the shell to stop processing for specified duration.
(a) reboots  (b) halts  (c) sleep  (d) sort

148. ________ Linux command creates a single archive from specified files and directories.
(a) tar  (b) zip  (c) gzip  (d) ls -l

149. ________ Linux command creates zip file using given source file.
(a) tar  (b) zip  (c) gzip  (d) ls -l

150. ________ Linux command creates gzip file using given source file.
(a) tar  (b) zip  (c) gzip  (d) ls -l

151. ________ Linux command displays full information about files and directories.
(a) tar  (b) zip

152. ________ Linux command unzips a zip file.
(a) tar  (b) unzip  (c) gunzip  (d) ls -l

153. ________ Linux command unpacks a gzip file.
(a) tar  (b) unzip  (c) gunzip  (d) ls -l

154. ________ Linux command displays the output of program in readable chunks.
(a) more  (b) less  (c) both a & b  (d) neither a nor b

155. ________ Linux command searches for a given file and optionally executes given command on that file.
(a) banner  (b) find  (c) rm  (d) cat

156. ________ Linux command removes given file.
(a) banner  (b) find  (c) rm  (d) cat

157. ________ Linux command creates a large banner out of given text.
(a) banner  (b) find  (c) rm  (d) cat

158. ________ Linux command displays contents of text file on screen.
(a) banner  (b) find  (c) rm  (d) cat

159. The command `cat - > fl.txt` stores keyboard input to a new file named ________.
(a) -  (b) fl.txt  (c) cat  (d) none of them

160. The command `cat - >> fl.txt` appends keyboard input to a new file named ________.
(a) -  (b) fl.txt  (c) cat  (d) none of them

161. In Linux, ________ symbol denotes the ________.
(a) standard input (keyboard)  (b) mouse  (c) standard output  (d) monitor

162. In Linux, ________ command displays the current date and time.
(a) time  (b) date  (c) cat  (d) man
163. In Linux, _________ command displays help about given command (manual page).
   (a) time  (b) date  
   (c) cat   (d) man

164. In Linux, _________ command displays time taken by a process to complete.
   (a) time  (b) date  
   (c) cat   (d) man

165. In Linux, _________ command invokes text editors.
   (a) vi/vim  (b) emacs  
   (c) gedit/nedit (d) all of them

166. In Linux, _________ command compiles a C-language file to binary output.
   (a) cc  
   (b) useradd  
   (c) userdel  
   (d) passwd

167. In Linux, _________ command adds a new user.
   (a) cc  (b) useradd
   (c) userdel  (d) passwd

168. In Linux, _________ command deletes a new user.
   (a) cc  (b) useradd
   (c) userdel  (d) passwd

169. In Linux, _________ command changes password for given user.
   (a) cc  (b) useradd
   (c) userdel  (d) passwd

170. In Linux, _________ command takes normal user to super user mode.
   (a) su  (b) cal
   (c) bc  (d) cron

171. In Linux, _________ command helps a normal user to execute given command with root privileges.
   (a) sudo  (b) cal
   (c) bc  (d) cron

172. In Linux, _________ command displays calendar.
   (a) sudo  (b) cal
   (c) bc  (d) cron

173. In Linux, _________ command displays binary calculator in the terminal.
   (a) sudo  (b) cal
   (c) bc  (d) cron

174. In Linux, _________ command executes jobs at scheduled timing.
   (a) sudo  (b) cal
   (c) bc  (d) cron

175. In Linux, _________ is a text filter.
   (a) sed  (b) awk  
   (c) perl  (d) all of them

176. In Linux, _________ command searches the path and displays location of a given file.
   (a) which  (b) file  
   (c) tr  (d) chown

177. In Linux, _________ command displays the type of given file.
   (a) which  (b) file  
   (c) tr  (d) chown

178. In Linux, _________ command translates given input characters to specified equivalent characters.
   (a) which  (b) file  
   (c) tr  (d) chown

179. In Linux, _________ command changes ownership of a file to specified owner and group.
   (a) which  (b) file  
   (c) tr  (d) chown

180. In Linux, _________ command changes ownership of a file to specified owner and group.
   (a) which  (b) file  
   (c) tr  (d) chown

181. In Linux, _________ command creates group having specified name.
   (a) groupadd  (b) groupdel
   (c) grep  (d) test

182. In Linux, _________ command deletes specified group.
   (a) groupadd  (b) groupdel
   (c) grep  (d) test

183. In Linux, _________ command catches given string from the input lines or specified files.
   (a) groupadd  (b) groupdel
   (c) grep  (d) test

184. In Linux, _________ command tests whether given condition is true or false.
   (a) groupadd  (b) groupdel
   (c) grep  (d) test

185. In Linux, _________ command helps to make decisions.
   (a) if ; then ... fi  (b) if ; then... elif .. fi  
   (c) both a & b  (d) neither a nor b

186. In Linux, _________ command helps create looping.
   (a) for  
   (b) while  
   (c) both a & b
(d) neither a nor b

187. In Linux, ______ command displays tree structure of all files and directories.
(a) tree        (b) c++
(c) export      (d) clear

188. In Linux, ______ command clears the display.
(a) tree        (b) c++
(c) export      (d) clear

189. In Linux, ______ command compiles C++ source file to binary executable file.
(a) tree        (b) c++
(c) export      (d) clear

190. In Linux, ______ command exports given value to the shell environment.
(a) tree        (b) c++
(c) export      (d) clear

191. In Linux, ______ command displays the list of currently running processes.
(a) tree        (b) ps
(c) kill        (d) clear

192. In Linux, ______ command terminates a process with given process id.
(a) tree        (b) ps
(c) kill        (d) clear

1.3.8 Special characters in Linux

193. Any # character in Linux _______.
(a) starts a comment, ignored by shell script
(b) matches all characters
(c) matches any single character
(d) sends output to a new file

194. The * character in Linux _______.
(a) starts a comment, ignored by shell script
(b) matches all characters
(c) matches any single character
(d) sends output to a new file

195. The ? character in Linux _______.
(a) starts a comment, ignored by shell script
(b) matches all characters
(c) matches any single character
(d) sends output to a new file

196. The > character in Linux _______.
(a) starts a comment, ignored by shell script
(b) matches all characters
(c) matches any single character
(d) sends output to a new file

197. The >> character in Linux _______.
(a) starts a comment, ignored by shell script
(b) matches all characters
(c) matches any single character
(d) appends output to a file

198. The | character in Linux _______.
(a) sends output of left side program to the input of right side program
(b) matches all characters
(c) matches any single character
(d) appends output to a file

199. The $? character in Linux _______.
(a) stores exit status of previous command
(b) matches all characters
(c) matches any single character
(d) appends output to a file

200. The & character placed at the end of command line in Linux _______.
(a) stores exit status of previous command
(b) matches all characters
(c) sends to process to the background
(d) appends output to a file

201. The − character in Linux _______.
(a) stores exit status of previous command
(b) denotes standard input
(c) sends to process to the background
(d) appends output to a file

202. The ^ character in Linux _______.
(a) denotes home directory
(b) denotes standard input
(c) sends to process to the background
(d) appends output to a file

203. The [[...]] sequence in Linux _______.
(a) tests the enclosed condition
(b) denotes standard input
(c) sends to process to the background
(d) appends output to a file

204. The ! sequence in Linux _______.
(a) tests the enclosed condition
(b) denotes standard input
(c) negates given condition
(d) appends output to a file

205. The && sequence in Linux _______.
(a) tests the enclosed condition
(b) denotes standard input
(c) runs the right side process only if the left side process fails
(d) runs the right side process only if the left side process succeeds

206. The || sequence in Linux _______.
(a) tests the enclosed condition
(b) denotes standard input
(c) runs the right side process only if the left side process fails
(d) runs the right side process only if the left side process succeeds

Answers (437 - 642)

1. (a) 2. (c) 3. (d) 4. (b)
5. (d) 6. (a) 7. (b) 8. (c)
9. (a) 10. (b) 11. (d) 12. (a)
13. (c) 14. (a) 15. (b) 16. (d)
17. (a) 18. (a) 19. (c) 20. (a)
21. (b) 22. (d) 23. (a) 24. (d)
25. (a) 26. (c) 27. (a) 28. (c)
29. (b) 30. (d) 31. (a) 32. (a)
33. (b) 34. (c) 35. (d) 36. (b)
37. (c) 38. (a) 39. (b) 40. (d)
41. (a) 42. (d) 43. (b) 44. (c)
45. (b) 46. (d) 47. (a) 48. (c)
49. (b) 50. (d) 51. (a) 52. (d)
53. (c) 54. (b) 55. (a) 56. (c)
57. (d) 58. (b) 59. (a) 60. (c)
61. (d) 62. (a) 63. (d) 64. (b)
65. (c) 66. (a) 67. (b) 68. (c)
69. (d) 70. (a) 71. (a) 72. (a)
73. (b) 74. (c) 75. (d) 76. (a)
77. (b) 78. (c) 79. (a) 80. (d)
81. (c) 82. (a) 83. (b) 84. (d)
85. (a) 86. (b) 87. (c) 88. (a)
89. (b) 90. (c) 91. (d) 92. (a)
93. (b) 94. (a) 95. (a) 96. (a)
97. (d) 98. (d) 99. (a) 100. (b)
101. (c) 102. (d) 103. (a) 104. (b)
105. (d) 106. (a) 107. (b) 108. (a)
109. (b) 110. (c) 111. (b) 112. (c)
113. (d) 114. (a) 115. (c) 116. (d)
117. (b) 118. (a) 119. (b) 120. (c)
121. (a) 122. (c) 123. (b) 124. (d)
125. (d) 126. (a) 127. (b) 128. (c)
129. (c) 130. (a) 131. (b) 132. (c)
133. (d) 134. (b) 135. (a) 136. (b)
137. (c) 138. (d) 139. (b) 140. (c)
141. (a) 142. (d) 143. (a) 144. (b)
145. (d) 146. (d) 147. (c) 148. (a)
149. (b) 150. (c) 151. (d) 152. (b)
153. (c) 154. (c) 155. (b) 156. (c)
157. (a) 158. (d) 159. (b) 160. (b)
161. (a) 162. (b) 163. (d) 164. (a)
165. (d) 166. (a) 167. (b) 168. (c)
169. (d) 170. (a) 171. (a) 172. (b)
173. (c) 174. (d) 175. (d) 176. (a)
177. (b) 178. (c) 179. (d) 180. (d)
181. (a) 182. (b) 183. (c) 184. (d)
185. (c) 186. (c) 187. (a) 188. (d)
189. (b) 190. (c) 191. (b) 192. (c)
193. (a) 194. (b) 195. (c) 196. (d)
197. (d) 198. (a) 199. (a) 200. (c)
201. (b) 202. (a) 203. (a) 204. (c)
1.4 MS Word

1.4.1 Introduction to various application in MS Office

1. The collection of Microsoft tools for preparation of documents, spreadsheets, presentations, database management, time scheduling and mailing is called [MS Office (a), OpenOffice.org (b), StarOffice (c), LibreOffice (d)]

2. In MS Office, [MS Access (a), MS Word (b), MS Excel (c), MS Powerpoint (d)] is the software for preparation of documents.

3. In MS Office, [MS Access (a), MS Word (b), MS Excel (c), MS Powerpoint (d)] is the software for preparation of spreadsheets.

4. In MS Office, [MS Access (a), MS Word (b), MS Excel (c), MS Powerpoint (d)] is the software for preparation of presentations.

5. In MS Office, [MS Access (a), MS Word (b), MS Excel (c), MS Powerpoint (d)] is the software for preparation of databases.

6. In MS Office, [MS Access (a), MS Publisher (b), MS Outlook (c), MS Onenote (d)] is the software for managing emails.

7. In MS Office, [MS Access (a), MS Publisher (b), MS Outlook (c), MS Onenote (d)] is the software for preparation of banners, ID cards, brochures and page based professional publications.

8. In MS Office, [MS Access (a), MS Publisher (b), MS Outlook (c), MS Onenote (d)] is the software for preparation and sharing of notes.

1.4.2 Features of MS Word

9. The default extension for an MS Word document is [\( .docx \) (a), \( .doc \) (b), \( both \ a \ & \ b \) (c), neither a nor b (d)]

10. MS Word can be used for the preparation of [letters (a), books/ reports/theses (b), brochures/ visiting cards (c), all of them (d)]


12. The paradigm of WYSWYG signifies that [the printed document resembles exactly what you see on screen (a), printed document is different from that on screen (b), screen document is better than printed one (c), printed one is better than screen document (d)]

13. in MS Word serves as a standard typeset document for creating professional looking documents. [Macro (a), XML (b), Template (c), HTML (d)]

14. The collection of artworks/images available in MS Office is called [drawing (a), images (b), cliparts (c), tables (d)]

15. To create mail merged results, MS Word can take address input from [MS Excel (a), MS Access (b), text files (c), all of them (d)]

16. In MS Word, spelling mistakes are highlighted by [bold text (a), green underline (b), red underline (c), italic text (d)]

17. In MS Word, grammatic errors are highlighted by [bold text (a), green underline (b)]
18. MS Word can handle _________ to enrich a document.
(a) lists  (b) images  (c) tables  (d) all of them

19. The text or image which appears faintly in the background of a page is called _________
(a) watermark  (b) trade mark  (c) copyright (d) embossing

1.4.3 Office button in MS Word

20. MS Office button is located on the _________ of MS Word window.
(a) top right  (b) top left  (c) bottom left  (d) bottom right

21. _________ is the shortcut to open Office menu of MS Word.
(a) Alt + H  (b) Alt + N  (c) Alt + P  (d) Alt + F

22. The save button is MS Office menu can be accessed through _________
(a) Alt + F + S  (b) Ctrl + S  (c) both Alt + F + S & Ctrl + S  (d) none of them

23. To access Save As item in Office menu of MS Word, use _________ shortcut.
(a) Alt + F + A  (b) Ctrl + O  (c) Ctrl + N  (d) Ctrl + P

24. To select Open item in Office menu of MS Word, use _________ shortcut.
(a) Ctrl + O  (b) Alt + F + O  (c) both Ctrl + O & Alt + F + O  (d) Ctrl + S

25. For Close item in MS Office menu, use _________ shortcut.
(a) Alt + F + A  (b) Ctrl + O  (c) Ctrl + N  (d) Alt + F + C

26. To select Info item in MS Office menu, use _________ shortcut.
(a) Alt + F + A  (b) Ctrl + O  (c) Alt + F + I  (d) Alt + F + C

27. To view recently opened files, use _________ shortcut in Office menu of MS Word.
(a) Alt + F + R  (b) Ctrl + O  (c) Ctrl + F + I  (d) Ctrl + F + C

28. To select New item in Office menu of MS Word, use _________ shortcut.
(a) Ctrl + S

1.4.4 Menus and Toolbars in MS Word

29. To select Print item in MS Office menu, use _________ shortcut.
(a) Ctrl + P  (b) Alt + F + P  (c) both Ctrl + P & Alt + F + P  (d) Ctrl + S

30. To select Save & Send item in MS Office menu, use _________ shortcut.
(a) Ctrl + P  (b) Alt + F + D  (c) Alt + F + H or F1  (d) Ctrl + S

31. To select Help item in MS Office menu, use _________ shortcut.
(a) Ctrl + P  (b) Alt + F + D  (c) Alt + F + H or F1  (d) Ctrl + S

32. To select Options item in MS Office menu, use _________ shortcut.
(a) Alt + F + X  (b) Alt + F + D  (c) Alt + F + H or F1  (d) Alt + F + T

33. To select Exit item in MS Office menu, use _________ shortcut.
(a) Alt + F + X  (b) Alt + F + D  (c) Alt + F + H or F1  (d) Alt + F + T

34. The first menu, containing most common tools required for preparation of document in MS Word, is called _________
(a) Home  (b) Insert  (c) Page Layout  (d) References

35. The tools for Clipboard, Font Style, Paragraph Formatting, Styles & Search are contained in _________ menu.
(a) Home  (b) Insert  (c) Page Layout  (d) References

36. _________ is the shortcut for Home menu in MS Word.
(a) Alt + H  (b) Alt + N  (c) Alt + P  (d) Alt + S
37. _________ menu permits insertion of tables, images, drawing objects and hyperlinks, headers and footers in MS Word.
   (a) Home (b) Insert (c) Page Layout (d) References

38. _________ is the shortcut for Insert menu in MS Word.
   (a) Alt+H (b) Alt+N (c) Alt+P (d) Alt+S

39. _________ menu contains tools to control theme, page setup, page background, paragraph & text wrap.
   (a) Home (b) Insert (c) Page Layout (d) References

40. _________ is the shortcut for Page Layout menu in MS Word.
   (a) Alt+H (b) Alt+N (c) Alt+P (d) Alt+S

41. _________ menu contains tools related to table of contents, foot notes, citation, bibliography, caption, index & table of authorities.
   (a) Home (b) Insert (c) Page Layout (d) References

42. _________ is the shortcut for References menu in MS Word.
   (a) Alt+H (b) Alt+N (c) Alt+P (d) Alt+S

43. _________ menu contains tools related to table of contents, foot notes, citation, bibliography, caption, index & table of authorities.
   (a) Home (b) Mailings (c) Review (d) References

44. _________ is the shortcut for Mailings menu in MS Word.
   (a) Alt+H (b) Alt+M (c) Alt+R (d) Alt+S

45. _________ menu contains tools for creating mailings, merging mails, inserting merge fields, preview of mail merged results, printing mail merged pages or saving the mail merge results in a new file.
   (a) Home (b) Mailings (c) Review (d) References

46. _________ is the shortcut for Review menu in MS Word.
   (a) Alt+H (b) Alt+M (c) Alt+R (d) Alt+S

47. _________ menu contains tools for document views, showing/hiding ruler, zoom, managing windows & macros.
   (a) View (b) Mailings (c) Review (d) References

48. _________ is the shortcut for View menu in MS Word.
   (a) Alt+W (b) Alt+M (c) Alt+R (d) Alt+S

49. Clipboard menu can be accessed using the shortcut _________.
   (a) Alt+H+FO (b) Ctrl+X/ Alt+H+X (c) Ctrl+C/ Alt+H+C (d) Ctrl+V/ Alt+H+V

50. In MS Word, selected content can be cut using the shortcut _________.
   (a) Alt+H+FO (b) Ctrl+X/ Alt+H+X (c) Ctrl+C/ Alt+H+C (d) Ctrl+V/ Alt+H+V

51. In MS Word, selected content can be copied to clipboard using the shortcut _________.
   (a) Alt+H+FO (b) Ctrl+X/ Alt+H+X (c) Ctrl+C/ Alt+H+C (d) Ctrl+V/ Alt+H+V

52. In MS Word, contents of clipboard may be pasted to the document using the shortcut _________.
   (a) Alt+H+FO (b) Ctrl+X/ Alt+H+X (c) Ctrl+C/ Alt+H+C (d) Ctrl+V/ Alt+H+V

53. In MS Word, format painter may be accessed using the shortcut _________.
   (a) Alt+H+FP (b) Ctrl+X/ Alt+H+X (c) Ctrl+C/ Alt+H+C (d) Ctrl+V/ Alt+H+V

54. In MS Word, font style may be accessed using the shortcut _________.
   (a) Alt+H+FN (b) Ctrl+B/ Alt+H+1 (c) Ctrl+I/ Alt+H+2 (d) Ctrl+U/ Alt+H+3

55. In MS Word, bold font style may be accessed using the shortcut _________.
   (a) Alt+H+FN (b) Ctrl+B/ Alt+H+1 (c) Ctrl+I/ Alt+H+2 (d) Ctrl+U/ Alt+H+3

Prepared by: Dr.V.Nagaradjane
56. In MS Word, italic font style may be accessed using the shortcut ________.
   (a) Alt+H+FN
   (b) Ctrl+B/ Alt+H+1
   (c) Ctrl+I/ Alt+H+2
   (d) Ctrl-U/ Alt+H+3

57. In MS Word, underline font style may be accessed using the shortcut ________.
   (a) Alt+H+FN
   (b) Ctrl+B/ Alt+H+1
   (c) Ctrl+I/ Alt+H+2
   (d) Ctrl+U/ Alt+H+3

58. In MS Word, subscript font style may be accessed using the shortcut ________.
   (a) Alt+H+4
   (b) Ctrl+Plus/ Alt+H+5
   (c) Ctrl+Shift+Plus/ Alt+H+6
   (d) Alt+H+FF

59. In MS Word, superscript font style may be accessed using the shortcut ________.
   (a) Alt+H+4
   (b) Ctrl+Plus/ Alt+H+5
   (c) Ctrl+Shift+Plus/ Alt+H+6
   (d) Alt+H+FF

60. In MS Word, font name may be accessed using the shortcut ________.
   (a) Alt+H+4
   (b) Ctrl+Plus/ Alt+H+5
   (c) Ctrl+Shift+Plus/ Alt+H+6
   (d) Alt+H+FF

61. In MS Word, strike through font style may be accessed using the shortcut ________.
   (a) Alt+H+4
   (b) Ctrl+Plus/ Alt+H+5
   (c) Ctrl+Shift+Plus/ Alt+H+6
   (d) Alt+H+FF

62. In MS Word, font size may be accessed using the shortcut ________.
   (a) Alt+H+FC
   (b) Ctrl+Plus/ Alt+H+5
   (c) Ctrl+Shift+Plus/ Alt+H+6
   (d) Alt+H+FS

63. In MS Word, fill color may be accessed using the shortcut ________.
   (a) Alt+H+FC
   (b) Ctrl+Plus/ Alt+H+5
   (c) Ctrl+Shift+Plus/ Alt+H+6
   (d) Alt+H+FS

64. In MS Word, paragraph formatting may be accessed using the shortcut ________.
   (a) Alt+H+U
   (b) Alt+H+N
   (c) Alt+H+M
   (d) Alt+H+PG

65. In MS Word, bullets may be accessed using the shortcut ________.
   (a) Alt+H+U
   (b) Alt+H+N
   (c) Alt+H+M
   (d) Alt+H+PG

66. In MS Word, numbering may be accessed using the shortcut ________.
   (a) Alt+H+U
   (b) Alt+H+N
   (c) Alt+H+M
   (d) Alt+H+PG

67. In MS Word, multi-level list may be accessed using the shortcut ________.
   (a) Alt+H+U
   (b) Alt+H+N
   (c) Alt+H+M
   (d) Alt+H+PG

68. In MS Word, left alignment of paragraph may be accessed using the shortcut ________.
   (a) Ctrl+L/ Alt+H+AL
   (b) Ctrl+J/ Alt+H+AJ
   (c) Ctrl+E/ Alt+H+AC
   (d) Ctrl+R/ Alt+H+AR

69. In MS Word, right alignment of paragraph may be accessed using the shortcut ________.
   (a) Ctrl+L/ Alt+H+AL
   (b) Ctrl+J/ Alt+H+AJ
   (c) Ctrl+E/ Alt+H+AC
   (d) Ctrl+R/ Alt+H+AR

70. In MS Word, centre alignment of paragraph may be accessed using the shortcut ________.
   (a) Ctrl+L/ Alt+H+AL
   (b) Ctrl+J/ Alt+H+AJ
   (c) Ctrl+E/ Alt+H+AC
   (d) Ctrl+R/ Alt+H+AR

71. In MS Word, justified alignment of paragraph may be accessed using the shortcut ________.
   (a) Ctrl+L/ Alt+H+AL
   (b) Ctrl+J/ Alt+H+AJ
   (c) Ctrl+E/ Alt+H+AC
   (d) Ctrl+R/ Alt+H+AR

72. In MS Word, line spacing of paragraph may be accessed using the shortcut ________.
   (a) Alt+H+K
   (b) Alt+H+B
   (c) Alt+H+H
   (d) Alt+H+AO

73. In MS Word, borders may be accessed using the shortcut ________.
   (a) Alt+H+K
   (b) Alt+H+B
   (c) Alt+H+H
   (d) Alt+H+AO

74. In MS Word, fill colour may be accessed using the shortcut ________.
Q. Bank [COPA Semester - 1]

(a) Alt+H+K    (b) Alt+H+B
(c) Alt+H+H    (d) Alt+H+AO

75. In MS Word, indent may be decreased using the shortcut ____________.
(a) Alt+H+AI    (b) Alt+H+B
(c) Alt+H+H    (d) Alt+H+AO

76. In MS Word, indent may be increased using the shortcut ____________.
(a) Alt+H+AI    (b) Alt+H+B
(c) Alt+H+H    (d) Alt+H+AO

77. In MS Word, styles dialog may be changed using the shortcut ____________.
(a) Alt+H+FY
(b) Alt+H+L
(c) Alt+H+G
(d) Ctrl+F/ Alt+H+FD

78. In MS Word, styles may be changed using the shortcut ____________.
(a) Alt+H+FY
(b) Alt+H+L
(c) Alt+H+G
(d) Ctrl+F/ Alt+H+FD

79. In MS Word, normal style may be set using the shortcut ____________.
(a) Alt+H+FY
(b) Alt+H+L
(c) Alt+H+G
(d) Ctrl+F/ Alt+H+FD

80. In MS Word, search and find may be accessed using the shortcut ____________.
(a) Ctrl+H/ Alt+H+R
(b) Alt+H+SL
(c) Ctrl+A/ Alt+H+SL+A
(d) Ctrl+F/ Alt+H+FD

81. In MS Word, search and replace may be accessed using the shortcut ____________.
(a) Ctrl+H/ Alt+H+R
(b) Alt+H+SL
(c) Ctrl+A/ Alt+H+SL+A
(d) Ctrl+F/ Alt+H+FD

82. In MS Word, text selection may be accessed using the shortcut ____________.
(a) Ctrl+H/ Alt+H+R
(b) Alt+H+SL
(c) Ctrl+A/ Alt+H+SL+A
(d) Ctrl+F/ Alt+H+FD

83. In MS Word, select all may be accessed using the shortcut ____________.
(a) Ctrl+H/ Alt+H+R
(b) Alt+H+SL
(c) Ctrl+A/ Alt+H+SL+A
(d) Ctrl+F/ Alt+H+FD

Insert menu in MS Word

84. In MS Word, cover page may be inserted using the shortcut ____________.
(a) Alt+N+NP    (b) Alt+N+V
(c) Alt+N+B    (d) Alt+N+T

85. In MS Word, blank page may be inserted using the shortcut ____________.
(a) Alt+N+NP    (b) Alt+N+V
(c) Alt+N+B    (d) Alt+N+T

86. In MS Word, page break may be inserted using the shortcut ____________.
(a) Alt+N+T+I    (b) Alt+N+D
(c) Alt+N+T+V    (d) Alt+N+T

87. In MS Word, table may be inserted using the shortcut ____________.
(a) Alt+N+NP    (b) Alt+N+V
(c) Alt+N+B    (d) Alt+N+T

88. In MS Word, text with column separation by TAB and row separation by NEWLINE may be converted to table using the shortcut ____________.
(a) Alt+N+T+I    (b) Alt+N+D
(c) Alt+N+T+V    (d) Alt+N+T

89. In MS Word, table may be created by drawing on screen using the shortcut ____________.
(a) Alt+N+T+I    (b) Alt+N+D
(c) Alt+N+T+V    (d) Alt+N+T

90. In MS Word, table may be created by choosing rows and columns using the shortcut ____________.
(a) Alt+N+T+I    (b) Alt+N+D
(c) Alt+N+T+V    (d) Alt+N+T

91. In MS Word, Excel spreadsheet may be inserted as table using the shortcut ____________.
(a) Alt+N+T+I    (b) Alt+N+D
(c) Alt+N+T+X    (d) Alt+N+T

92. In MS Word, quick table from ready made templates may be inserted using the shortcut ____________.
(a) Alt+N+T+I    (b) Alt+N+D
(c) Alt+N+T+X    (d) Alt+N+T

93. In MS Word, pictures may be inserted using the shortcut ____________.
(a) Alt+N+P    (b) Alt+N+F
(c) Alt+N+SH    (d) Alt+N+C

94. In MS Word, clip arts may be inserted using the shortcut ____________.
(a) Alt+N+P    (b) Alt+N+F
(c) Alt+N+SH    (d) Alt+N+C

Prepared by: Dr.V.Nagaradjane
95. In MS Word, shapes like line, rectangle, circle, text box, etc. may be inserted using the shortcut \[ \text{Alt+N+P} \] (a) \[ \text{Alt+N+F} \] (b) \[ \text{Alt+N+SH} \] (c) \[ \text{Alt+N+C} \] (d) \[ \text{Alt+N} \]

96. In MS Word, chart may be inserted using the shortcut \[ \text{Alt+N+P} \] (a) \[ \text{Alt+N+F} \] (b) \[ \text{Alt+N+SH} \] (c) \[ \text{Alt+N+C} \]

97. In MS Word, smart art may be inserted using the shortcut \[ \text{Alt+N+P} \] (a) \[ \text{Alt+N+M} \] (b) \[ \text{Alt+N+SC} \] (c) \[ \text{Alt+N+C} \]

98. In MS Word, screen shot may be inserted using the shortcut \[ \text{Alt+N+P} \] (a) \[ \text{Alt+N+M} \] (b) \[ \text{Alt+N+SC} \] (c) \[ \text{Alt+N+C} \]

99. In MS Word, hyperlink may be inserted using the shortcut \[ \text{Alt+N+I} \] (a) \[ \text{Alt+N+K} \] (b) \[ \text{Alt+N+RF} \] (c) \[ \text{Alt+N+H} \]

100. In MS Word, bookmark may be inserted using the shortcut \[ \text{Alt+N+I} \] (a) \[ \text{Alt+N+K} \] (b) \[ \text{Alt+N+RF} \] (c) \[ \text{Alt+N+H} \]

101. In MS Word, cross references may be inserted using the shortcut \[ \text{Alt+N+I} \] (a) \[ \text{Alt+N+K} \] (b) \[ \text{Alt+N+RF} \] (c) \[ \text{Alt+N+H} \]

102. In MS Word, header may be inserted using the shortcut \[ \text{Alt+N+NU} \] (a) \[ \text{Alt+N+X} \] (b) \[ \text{Alt+N+O} \] (c) \[ \text{Alt+N+H} \]

103. In MS Word, footer may be inserted using the shortcut \[ \text{Alt+N+NU} \] (a) \[ \text{Alt+N+X} \] (b) \[ \text{Alt+N+O} \] (c) \[ \text{Alt+N+H} \]

104. In MS Word, page number may be inserted using the shortcut \[ \text{Alt+N+NU} \] (a) \[ \text{Alt+N+X} \] (b) \[ \text{Alt+N+O} \] (c) \[ \text{Alt+N+H} \]

105. In MS Word, text box may be inserted using the shortcut \[ \text{Alt+N+Q} \] (a) \[ \text{Alt+N+X} \] (b) \[ \text{Alt+N+I} \] (c) \[ \text{Alt+N+RC} \]

106. In MS Word, word art may be inserted using the shortcut \[ \text{Alt+N+Q} \] (a) \[ \text{Alt+N+X} \] (b) \[ \text{Alt+N+I} \] (c) \[ \text{Alt+N+RC} \]

107. In MS Word, quick parts may be inserted using the shortcut \[ \text{Alt+N+Q} \] (a) \[ \text{Alt+N+X} \] (b) \[ \text{Alt+N+I} \] (c) \[ \text{Alt+N+RC} \]

108. In MS Word, drop cap may be inserted using the shortcut \[ \text{Alt+N+Q} \] (a) \[ \text{Alt+N+F} \] (b) \[ \text{Alt+N+I} \] (c) \[ \text{Alt+N+C} \] (d) \[ \text{Alt+N+RC} \]

109. In MS Word, signature may be inserted using the shortcut \[ \text{Alt+N+G} \] (a) \[ \text{Alt+N+D} \] (b) \[ \text{Alt+N+J} \] (c) \[ \text{Alt+N+RC} \]

110. In MS Word, date & time may be inserted using the shortcut \[ \text{Alt+N+G} \] (a) \[ \text{Alt+N+D} \] (b) \[ \text{Alt+N+J} \] (c) \[ \text{Alt+N+RC} \]

111. In MS Word, object may be inserted using the shortcut \[ \text{Alt+N+G} \] (a) \[ \text{Alt+N+D} \] (b) \[ \text{Alt+N+J} \] (c) \[ \text{Alt+N+RC} \]

112. In MS Word, equations may be inserted using the shortcut \[ \text{Alt+N+U/ Alt+N+U+M} \] (a) \[ \text{Alt+N+D} \] (b) \[ \text{Alt+N+J} \] (c) \[ \text{Alt+N+RC} \]

113. In MS Word, symbols and special characters may be inserted using the shortcut \[ \text{Alt+N+U/ Alt+N+U+M} \] (a) \[ \text{Alt+N+D} \] (b) \[ \text{Alt+N+J} \] (c) \[ \text{Alt+N+RC} \]

Page Layout menu in MS Word

114. In MS Word, document theme may be accessed using the shortcut \[ \text{Alt+P+TH} \] (a) \[ \text{Alt+P+TC} \] (b) \[ \text{Alt+P+TE} \]

115. In MS Word, document colors may be accessed using the shortcut \[ \text{Alt+P+TH} \] (a) \[ \text{Alt+P+TC} \] (b) \[ \text{Alt+P+TE} \]

116. In MS Word, document fonts may be accessed using the shortcut \[ \text{Alt+P+TH} \] (a) \[ \text{Alt+P+TC} \] (b) \[ \text{Alt+P+TE} \]

117. In MS Word, document effects may be accessed using the shortcut \[ \text{Alt+P+TH} \] (a) \[ \text{Alt+P+TC} \] (b) \[ \text{Alt+P+TE} \]

118. In MS Word, page setup may be accessed using the shortcut \[ \text{Alt+P+SP} \] (a) \[ \text{Alt+P+M} \] (b) \[ \text{Alt+P+O} \] (c) \[ \text{Alt+P+SZ} \]
119. In MS Word, margins of page may be modified using the shortcut __________.
(a) Alt+P+SP  (b) Alt+P+M  (c) Alt+P+O  (d) Alt+P+SZ

120. In MS Word, orientation of page may be modified using the shortcut __________.
(a) Alt+P+SP  (b) Alt+P+M  (c) Alt+P+O  (d) Alt+P+SZ

121. In MS Word, size of page may be modified using the shortcut __________.
(a) Alt+P+SP  (b) Alt+P+M  (c) Alt+P+O  (d) Alt+P+SZ

122. In MS Word, columns in page may be modified using the shortcut __________.
(a) Alt+P+J/ Alt+P+J+C  (b) Alt+P+B  (c) Alt+P+LN  (d) Alt+P+H

123. In MS Word, page breaks may be modified using the shortcut __________.
(a) Alt+P+J/ Alt+P+J+C  (b) Alt+P+B  (c) Alt+P+LN  (d) Alt+P+H

124. In MS Word, line number may be inserted or removed using the shortcut __________.
(a) Alt+P+J/ Alt+P+J+C  (b) Alt+P+B  (c) Alt+P+LN  (d) Alt+P+H

125. In MS Word, hyphenation may be inserted or removed using the shortcut __________.
(a) Alt+P+J/ Alt+P+J+C  (b) Alt+P+B  (c) Alt+P+LN  (d) Alt+P+H

126. In MS Word, paragraph layout may be accessed using the shortcut __________.
(a) Alt+P+PG  (b) Alt+P+IL  (c) Alt+P+IR  (d) Alt+P+SB

127. In MS Word, left indent may be accessed using the shortcut __________.
(a) Alt+P+SA  (b) Alt+P+IL  (c) Alt+P+IR  (d) Alt+P+SB

128. In MS Word, right indent may be accessed using the shortcut __________.
(a) Alt+P+SA  (b) Alt+P+IL  (c) Alt+P+IR  (d) Alt+P+SB

129. In MS Word, spacing before paragraph may be accessed using the shortcut __________.
(a) Alt+P+SA  (b) Alt+P+IL  (c) Alt+P+IR  (d) Alt+P+SB

130. In MS Word, spacing after paragraph may be accessed using the shortcut __________.
(a) Alt+P+SA  (b) Alt+P+IL  (c) Alt+P+IR  (d) Alt+P+SB

131. In MS Word, objects may be arranged in position using the shortcut __________.
(a) Alt+P+PO  (b) Alt+P+TW  (c) Alt+P+AF  (d) Alt+P+AE

132. In MS Word, text wrapping may be accessed using the shortcut __________.
(a) Alt+P+PO  (b) Alt+P+TW  (c) Alt+P+AF  (d) Alt+P+AE

133. In MS Word, bring forward may be accessed using the shortcut __________.
(a) Alt+P+PO  (b) Alt+P+TW  (c) Alt+P+AF  (d) Alt+P+AE

134. In MS Word, selection pane may be accessed using the shortcut __________.
(a) Alt+P+PO  (b) Alt+P+TW  (c) Alt+P+AF  (d) Alt+P+AE

135. In MS Word, paragraph selection may be accessed using the shortcut __________.
(a) Alt+P+AP  (b) Alt+P+AA  (c) Alt+P+G  (d) Alt+P+AY

136. In MS Word, alignment of page may be accessed using the shortcut __________.
(a) Alt+P+AP  (b) Alt+P+AA  (c) Alt+P+G  (d) Alt+P+AY

137. In MS Word, grouping of objects may be accessed using the shortcut __________.
(a) Alt+P+AP  (b) Alt+P+AA  (c) Alt+P+G  (d) Alt+P+AY

138. In MS Word, object rotation may be accessed using the shortcut __________.
(a) Alt+P+AP  (b) Alt+P+AA  (c) Alt+P+G  (d) Alt+P+AY

References menu in MS Word

139. In MS Word, table of contents may be inserted using the shortcut __________.
(a) Alt+S+A  (b) Alt+S+T  (c) Alt+S+U  (d) Alt+S+Q

140. In MS Word, add text may be accessed using the shortcut __________.
(a) Alt+S+A  (b) Alt+S+T  (c) Alt+S+U  (d) Alt+S+Q

141. In MS Word, table of contents may be updated using the shortcut __________.
(a) Alt+S+A  (b) Alt+S+T  (c) Alt+S+U  (d) Alt+S+Q
142. In MS Word, foot notes dialog may be accessed using the shortcut \text{(c) Alt+S+U} \quad \text{(d) Alt+S+Q}.

143. In MS Word, foot notes may be inserted using the shortcut \text{(a) Alt+S+F} \quad \text{(b) Alt+S+E} \quad \text{(c) Alt+S+O} \quad \text{(d) Alt+S+H}.

144. In MS Word, end notes may be inserted using the shortcut \text{(c) Alt+S+O} \quad \text{(d) Alt+S+H}.

145. In MS Word, next foot notes may be inserted using the shortcut \text{(c) Alt+S+O} \quad \text{(d) Alt+S+H}.

146. In MS Word, show notes (to view all foot/end notes) may be accessed using the shortcut \text{(a) Alt+S+F} \quad \text{(b) Alt+S+E} \quad \text{(c) Alt+S+O} \quad \text{(d) Alt+S+H}.

147. In MS Word, citation may be inserted using the shortcut \text{(a) Alt+S+C} \quad \text{(b) Alt+S+M} \quad \text{(c) Alt+S+L} \quad \text{(d) Alt+S+B}.

148. In MS Word, manage citation sources dialog may be accessed using the shortcut \text{(a) Alt+S+C} \quad \text{(b) Alt+S+M} \quad \text{(c) Alt+S+L} \quad \text{(d) Alt+S+B}.

149. In MS Word, bibliography may be accessed using the shortcut \text{(a) Alt+S+C} \quad \text{(b) Alt+S+M} \quad \text{(c) Alt+S+L} \quad \text{(d) Alt+S+B}.

150. In MS Word, citation style be accessed using the shortcut \text{(a) Alt+S+C} \quad \text{(b) Alt+S+M} \quad \text{(c) Alt+S+L} \quad \text{(d) Alt+S+B}.

151. In MS Word, insert caption may be accessed using the shortcut \text{(c) Alt+S+P} \quad \text{(b) Alt+S+G} \quad \text{(c) Alt+S+V} \quad \text{(d) Alt+S+G}.

152. In MS Word, table of figures may be inserted using the shortcut \text{(a) Alt+S+P} \quad \text{(b) Alt+S+G} \quad \text{(c) Alt+S+V} \quad \text{(d) Alt+S+RF}.

153. In MS Word, table of figures may be updated using the shortcut \text{(a) Alt+S+P} \quad \text{(b) Alt+S+G} \quad \text{(c) Alt+S+V} \quad \text{(d) Alt+S+RF}.

154. In MS Word, cross references may be inserted using the shortcut \text{(a) Alt+S+P} \quad \text{(b) Alt+S+G} \quad \text{(c) Alt+S+V} \quad \text{(d) Alt+S+RF}.

Mailings menu in MS Word

155. In MS Word, mark entry under references menu may be accessed using the shortcut \text{(a) Alt+S+N} \quad \text{(b) Alt+S+X} \quad \text{(c) Alt+S+D} \quad \text{(d) Alt+S+I}.

156. In MS Word, insert index under references menu may be accessed using the shortcut \text{(a) Alt+S+N} \quad \text{(b) Alt+S+X} \quad \text{(c) Alt+S+D} \quad \text{(d) Alt+S+I}.

157. In MS Word, update index under references menu may be accessed using the shortcut \text{(a) Alt+S+N} \quad \text{(b) Alt+S+X} \quad \text{(c) Alt+S+D} \quad \text{(d) Alt+S+I}.

158. In MS Word, mark citation under references menu may be accessed using the shortcut \text{(a) Alt+S+N} \quad \text{(b) Alt+S+X} \quad \text{(c) Alt+S+D} \quad \text{(d) Alt+S+I}.

159. In MS Word, insert table of authorities under references menu may be accessed using the shortcut \text{(a) Alt+S+RT} \quad \text{(b) Alt+S+RU} \quad \text{(c) Alt+S+D} \quad \text{(d) Alt+S+I}.

160. In MS Word, update table of authorities under references menu may be accessed using the shortcut \text{(a) Alt+S+RT} \quad \text{(b) Alt+S+RU} \quad \text{(c) Alt+S+D} \quad \text{(d) Alt+S+I}.

---

Mailings menu in MS Word

161. \text{Mailings} menu contains items required for mail merge functionality in MS Word.

(a) Home \quad \text{(b) Insert} \quad \text{(c) Mailings} \quad \text{(d) Reference}.

162. \text{Mailings} is the shortcut to create envelopes using Mailings menu in MS Word.

(a) Alt+M+E \quad \text{(b) Alt+M+L} \quad \text{(c) Alt+M+S} \quad \text{(d) Alt+M+R}.

163. \text{Mailings} is the shortcut to create labels using Mailings menu in MS Word.

(a) Alt+M+E \quad \text{(b) Alt+M+L} \quad \text{(c) Alt+M+S} \quad \text{(d) Alt+M+R}.

164. \text{Mailings} is the shortcut to start mail merge in MS Word.

(a) Alt+M+E \quad \text{(b) Alt+M+L} \quad \text{(c) Alt+M+S} \quad \text{(d) Alt+M+R}.
165. (a) Alt+M+E (b) Alt+M+L (c) Alt+M+S (d) Alt+M+R

166. (a) Alt+M+R+E (b) Alt+M+R+N (c) Alt+M+R+O (d) Alt+M+D

167. (a) Alt+M+R+E (b) Alt+M+R+N (c) Alt+M+R+O (d) Alt+M+D

168. (a) Alt+M+R+E (b) Alt+M+R+N (c) Alt+M+R+O (d) Alt+M+D

169. (a) Alt+M+R+E (b) Alt+M+R+N (c) Alt+M+R+O (d) Alt+M+D

170. (a) Alt+M+H (b) Alt+M+A (c) Alt+M+G (d) Alt+M+I

171. (a) Alt+M+H (b) Alt+M+A (c) Alt+M+G (d) Alt+M+I

172. (a) Alt+M+H (b) Alt+M+A (c) Alt+M+G (d) Alt+M+I

173. (a) Alt+M+H (b) Alt+M+A (c) Alt+M+G (d) Alt+M+I

174. (a) Alt+M+U (b) Alt+M+A (c) Alt+M+B (d) Alt+M+T

175. (a) Alt+M+U (b) Alt+M+A (c) Alt+M+B (d) Alt+M+T

176. (a) Alt+M+U (b) Alt+M+A (c) Alt+M+B (d) Alt+M+T

177. (a) Alt+M+W (b) Alt+M+P (c) Alt+M+Q (d) Alt+M+M

178. (a) Alt+M+W (b) Alt+M+P (c) Alt+M+Q (d) Alt+M+M

179. (a) Alt+M+W (b) Alt+M+P (c) Alt+M+Q (d) Alt+M+M

180. (a) Alt+M+W (b) Alt+M+P (c) Alt+M+Q (d) Alt+M+M

181. (a) Alt+M+W (b) Alt+M+P (c) Alt+M+Q (d) Alt+M+M

Review menu in MS Word

184. (a) Alt+R+R (b) Alt+R+E (c) Alt+R+S (d) Alt+R+W

185. (a) Alt+R+R (b) Alt+R+E (c) Alt+R+S (d) Alt+R+W

186. (a) Alt+R+R (b) Alt+R+E (c) Alt+R+S (d) Alt+R+W

187. (a) Alt+R+R (b) Alt+R+E (c) Alt+R+S (d) Alt+R+W
188. _______ is the shortcut for languages under review menu in MS Word.
   (a) Alt+R+R  (b) Alt+R+T
   (c) Alt+R+S  (d) Alt+R+U

189. _______ is the shortcut for translate under review menu in MS Word.
   (a) Alt+R+R  (b) Alt+R+T
   (c) Alt+R+S  (d) Alt+R+U

190. _______ is the shortcut for new comment under review menu in MS Word.
     (a) Alt+R+C  (b) Alt+R+D
     (c) Alt+R+V  (d) Alt+R+N

191. _______ is the shortcut for delete comment under review menu in MS Word.
     (a) Alt+R+C  (b) Alt+R+D
     (c) Alt+R+V  (d) Alt+R+N

192. _______ is the shortcut for next record of comment under review menu in MS Word.
     (a) Alt+R+C  (b) Alt+R+D
     (c) Alt+R+V  (d) Alt+R+N

193. _______ is the shortcut for previous record of comment under review menu in MS Word.
     (a) Alt+R+C  (b) Alt+R+D
     (c) Alt+R+V  (d) Alt+R+N

194. _______ is the shortcut to track changes under review menu in MS Word.
     (a) Alt+R+G  (b) Alt+R+TD
     (c) Alt+R+TM  (d) Alt+R+TP

195. _______ is the shortcut to show markup under review menu in MS Word.
     (a) Alt+R+G  (b) Alt+R+TD
     (c) Alt+R+TM  (d) Alt+R+TP

196. _______ is the shortcut to show final markup under review menu in MS Word.
     (a) Alt+R+G  (b) Alt+R+TD
     (c) Alt+R+TM  (d) Alt+R+TP

197. _______ is the shortcut to show reviewing pane under review menu in MS Word.
     (a) Alt+R+G  (b) Alt+R+TD
     (c) Alt+R+TM  (d) Alt+R+TP

198. _______ is the shortcut to accept changes under review menu in MS Word.
     (a) Alt+R+A  (b) Alt+R+J
     (c) Alt+R+F  (d) Alt+R+H

199. _______ is the shortcut to reject changes under review menu in MS Word.
     (a) Alt+R+A  (b) Alt+R+J
     (c) Alt+R+F  (d) Alt+R+H

200. _______ is the shortcut to navigate to previous change under review menu in MS Word.
     (a) Alt+R+A  (b) Alt+R+J
     (c) Alt+R+F  (d) Alt+R+H

201. _______ is the shortcut to navigate to next change under review menu in MS Word.
     (a) Alt+R+A  (b) Alt+R+J
     (c) Alt+R+F  (d) Alt+R+H

202. _______ is the shortcut to compare documents under review menu in MS Word.
     (a) Alt+R+M  (b) Alt+R+PB
     (c) Alt+R+PE  (d) Alt+R+H

203. _______ is the shortcut to block authors under review menu in MS Word.
     (a) Alt+R+M  (b) Alt+R+PB
     (c) Alt+R+PE  (d) Alt+R+H

204. _______ is the shortcut to restrict editing under review menu in MS Word.
     (a) Alt+R+M  (b) Alt+R+PB
     (c) Alt+R+PE  (d) Alt+R+H

Review menu in MS Word

205. Document view may be changed to Page Layout using _______ shortcut in View menu of MS Word.
     (a) Alt+W+P  (b) Alt+W+F
     (c) Alt+W+L  (d) Alt+W+U

206. Document view may be changed to full screen reading using _______ shortcut in View menu of MS Word.
     (a) Alt+W+P  (b) Alt+W+F
     (c) Alt+W+L  (d) Alt+W+U

207. Document view may be changed to web layout using _______ shortcut in View menu of MS Word.
     (a) Alt+W+P  (b) Alt+W+F
     (c) Alt+W+L  (d) Alt+W+U

208. Document view may be changed to outline layout using _______ shortcut in View menu of MS Word.
     (a) Alt+W+P  (b) Alt+W+F
     (c) Alt+W+L  (d) Alt+W+U

209. Document view may be changed to draft layout using _______ shortcut in View menu of MS Word.
     (a) Alt+W+P  (b) Alt+W+F
     (c) Alt+W+E  (d) Alt+W+U

210. Ruler may be set visible or invisible using _______ shortcut in MS Word.
     (a) Alt+W+R  (b) Alt+W+G
211. Grid lines may be set visible or invisible using __________ shortcut in MS Word.
(a) Alt+W+R    (b) Alt+W+G
(c) Alt+W+K    (d) Alt+W+Q

212. Navigation pane may be set visible or invisible using __________ shortcut in MS Word.
(a) Alt+W+R    (b) Alt+W+G
(c) Alt+W+K    (d) Alt+W+Q

213. Zoom options dialog may be opened using __________ shortcut in MS Word.
(a) Alt+W+R    (b) Alt+W+G
(c) Alt+W+K    (d) Alt+W+Q

214. Zoom level may be set to 100% using __________ shortcut in MS Word.
(a) Alt+W+J    (b) Alt+W+I
(c) Alt+W+2    (d) Alt+W+1

215. Zoom level may be adjusted to width of single page using __________ shortcut in MS Word.
(a) Alt+W+J    (b) Alt+W+I
(c) Alt+W+2    (d) Alt+W+1

216. Zoom level may be adjusted to width of two pages using __________ shortcut in MS Word.
(a) Alt+W+J    (b) Alt+W+1
(c) Alt+W+2    (d) Alt+W+1

217. Zoom level may be adjusted to full page width using __________ shortcut in MS Word.
(a) Alt+W+J    (b) Alt+W+1
(c) Alt+W+2    (d) Alt+W+1

218. New MS Word window may be opened using __________ shortcut in MS Word.
(a) Alt+W+N    (b) Alt+W+A
(c) Alt+W+S    (d) Alt+W+B

219. All open windows may be arranged side-by-side using __________ shortcut in MS Word.
(a) Alt+W+N    (b) Alt+W+A
(c) Alt+W+S    (d) Alt+W+B

220. Current window may be split to 2 parts to enable viewing of different sections of the document at the same time using __________ shortcut in MS Word.
(a) Alt+W+N    (b) Alt+W+A
(c) Alt+W+S    (d) Alt+W+B

221. 2 documents may be opened side by side using __________ shortcut in MS Word.
(a) Alt+W+N    (b) Alt+W+A
(c) Alt+W+S    (d) Alt+W+B

222. Scrolling on 2 documents opened side by side may be synchronized using __________ shortcut in MS Word.
(a) Alt+W+YS   (b) Alt+W+T
(c) Alt+W+S    (d) Alt+W+W

223. Window positions of 2 side by side documents may be reset to equal proportion using __________ shortcut in MS Word.
(a) Alt+W+YS   (b) Alt+W+T
(c) Alt+W+S    (d) Alt+W+W

224. Cursor focus may be switched from one window to another window using __________ shortcut in MS Word.
(a) Alt+W+YS   (b) Alt+W+T
(c) Alt+W+S    (d) Alt+W+W

225. Macros may be recorded using __________ shortcut in MS Word.
(a) Alt+W+YS   (b) Alt+W+T
(c) Alt+W+S    (d) Alt+W+W

226. A set of VBA instructions to assist in carrying out recurring activities in is called __________.
(a) mail merge   (b) macro
(c) thesaurus    (d) spell check

227. Macro may be assigned a __________ for convenient invocation.
(a) keyboard shortcut
(b) a button on office menu
(c) either keyboard shortcut or a button in office menu
(d) neither keyboard shortcut nor a button in office menu

228. Macro may be assigned a __________ for convenient invocation.
(a) keyboard shortcut
(b) a button on office menu
(c) either keyboard shortcut or a button in office menu
(d) neither keyboard shortcut nor a button in office menu

1.4.5 Creating & saving a document in MS Word

229. On opening MS Word (without clicking on a target document), it displays __________ document.
(a) previous    (b) formatted
(c) completed   (d) blank/new

230. MS Word provides __________ to function as the starting point special new documents like report, visiting card, brochure, etc.
231. After opening a new document in MS Word, one should __________ to create a comfortable experience.

(a) set paper size 
(b) set font size 
(c) set paragraph spacing, line spacing 
(d) all of them

232. Page setup in MS Word may be accessed using __________ menu.

(a) Page Layout -> Page Setup (Alt + P + SP) 
(b) Home -> Paragraph (Alt + H + PG) or Page Layout -> Paragraph (Alt + P + PG) 
(c) Home -> Font Face (Alt + H + FF) 
(d) Home -> Font Size (Alt + H + FS)

233. Paragraph settings in MS Word may be accessed using __________ menu.

(a) Page Layout -> Page Setup (Alt + P + SP) 
(b) Home -> Paragraph (Alt + H + PG) or Page Layout -> Paragraph (Alt + P + PG) 
(c) Home -> Font Face (Alt + H + FF) 
(d) Home -> Font Size (Alt + H + FS)

234. Font face may be changed in MS Word using __________ menu.

(a) Page Layout -> Page Setup (Alt + P + SP) 
(b) Home -> Paragraph (Alt + H + PG) or Page Layout -> Paragraph (Alt + P + PG) 
(c) Home -> Font Face (Alt + H + FF) 
(d) Home -> Font Size (Alt + H + FS)

235. Font size may be changed in MS Word using __________ menu.

(a) Page Layout -> Page Setup (Alt + P + SP) 
(b) Home -> Paragraph (Alt + H + PG) or Page Layout -> Paragraph (Alt + P + PG) 
(c) Home -> Font Face (Alt + H + FF) 
(d) Home -> Font Size (Alt + H + FS)

236. In MS Word, font colour may be changed using __________ menu.

(a) Page Layout -> Page Setup (Alt + P + SP) 
(b) Home -> Font Color (Alt + H + FC) 
(c) Home -> Background (Alt + H + I) 
(d) Home -> Font Size (Alt + H + FS)

238. In MS Word, tables, figures and equations may be assigned numbers using __________ menu.

(a) Page Layout -> Page Setup (Alt + P + SP) 
(b) Home -> Font Color (Alt + H + FC) 
(c) Home -> Background (Alt + H + I) 
(d) References -> Insert Caption (Alt + S + P)

239. In MS Word, book title, chapter title, heading1, heading2, normal text, etc. may be inserted using __________ menu.

(a) Home -> Styles (Alt + H + L) 
(b) Home -> Font Color (Alt + H + FC) 
(c) Home -> Background (Alt + H + I) 
(d) References -> Insert Caption (Alt + S + P)

240. In MS Word, citation to references may be inserted using __________ menu.

(a) References -> Insert Citation (Alt + S + C) 
(b) References -> Mark Entry (Alt + S + N) 
(c) Home -> Background (Alt + H + I) 
(d) References -> Insert Caption (Alt + S + P)

241. In MS Word, words to be indexed at the end of book may be marked using __________ menu.

(a) References -> Insert Citation (Alt + S + C) 
(b) References -> Mark Entry (Alt + S + N) 
(c) Home -> Background (Alt + H + I) 
(d) References -> Insert Caption (Alt + S + P)

242. In MS Word, table, picture, shapes, flow charts, headers, footers, page numbers, word art, drop cap, equations or symbols may be inserted using __________ menu.

(a) References -> Insert Citation (Alt + S + C) 
(b) References -> Mark Entry (Alt + S + N) 
(c) Home -> Background (Alt + H + I) 
(d) References -> Insert Caption (Alt + S + P)

243. In MS Word, __________ menu helps to save the document in a new name.

(a) Home -> Save As (Alt + F + A) 
(b) References -> Mark Entry (Alt + S + N) 
(c) Home -> Background (Alt + H + I) 
(d) References -> Insert
1.4.6 Inserting objects in MS Word

244. ____________ are the most important objects used in MS Word documents.
(a) tables & pictures
(b) shapes, flow charts & clip art
(c) equations, lists, bullets & numbering
(d) ____________

245. In MS Word, table can be inserted using ____________ menu.
(a) Insert -> Table (Alt + N + T)
(b) Insert -> Picture (Alt + N + P)
(c) References -> Insert Caption (Alt + S + N)
(d) Insert -> Equation (Alt + N + E)

246. In MS Word, picture can be inserted using ____________ menu.
(a) Insert -> Table (Alt + N + T)
(b) Insert -> Picture (Alt + N + P)
(c) References -> Insert Caption (Alt + S + N)
(d) ____________

247. In MS Word, caption for table, image or equation number can be inserted using ____________ menu.
(a) Insert -> Table (Alt + N + T)
(b) Insert -> Picture (Alt + N + P)
(c) References -> Insert Caption (Alt + S + N)
(d) ____________

248. In MS Word, equation can be inserted using ____________ menu.
(a) Insert -> Table (Alt + N + T)
(b) Insert -> Picture (Alt + N + P)
(c) References -> Insert Caption (Alt + S + N)
(d) ____________

249. In MS Word, clip art can be inserted using ____________ menu.
(a) Insert -> Clip Art (Alt + N + F)
(b) Insert -> Picture (Alt + N + P)
(c) References -> Insert Caption (Alt + S + N)
(d) ____________

250. In MS Word, special artistic design text may be inserted using ____________ menu.
(a) Insert -> Clip Art (Alt + N + F)
(b) Insert -> Word Art (Alt + N + RC)
(c) References -> Insert Caption (Alt + S + N)
(d) ____________

251. In MS Word, drop cap may be inserted using ____________ menu.
(a) Insert -> Clip Art (Alt + N + F)
(b) Insert -> Word Art (Alt + N + W)
(c) Insert -> Drop Cap (Alt + N + RC)
(d) ____________

252. In MS Word, special symbols may be inserted using ____________ menu.
(a) Insert -> Clip Art (Alt + N + F)
(b) Insert -> Symbols (Alt + N + U)
(c) Insert -> Drop Cap (Alt + N + RC)
(d) ____________

253. In MS Word, objects from other applications may be inserted using ____________ menu.
(a) Insert -> Text from File (Alt + N + J + F)
(b) Insert -> Symbols (Alt + N + U)
(c) Insert -> Objects -> Objects (Alt + N + J + J)
(d) ____________

254. In MS Word, text from other applications may be inserted using ____________ menu.
(a) Insert -> Text from File (Alt + N + J + F)
(b) Insert -> Symbols (Alt + N + U)
(c) Insert -> Objects -> Objects (Alt + N + J + J)
(d) ____________

1.4.7 Inserting Macros in MS Word

255. MS Word has the ability to automate repeated tasks using ____________
(a) tables
(b) ____________
(c) equations
(d) ____________

256. In MS Word, a Macro may be assigned ____________ to invoke its functionality.
(a) keyboard shortcut
(b) button
(c) ____________
(d) ____________

257. To make the Macros tab visible, one needs to open the options dialog using ____________
(a) ____________
(b) ____________
(c) ____________
(d) ____________

258. In MS Word, one may display the Developer tab in the menu bar through the options dialog by choosing ____________
(a) ____________
(b) ____________
(c) ____________
(d) ____________
259. In MS Word, Macro security settings may be accessed through __________.  
(a) Macros $\rightarrow$ Macro Security (Alt + L + AS)  
(b) Macros $\rightarrow$ Record Macro (Alt + L + R)  
(c) Macros $\rightarrow$ Pause Recording (Alt + L + S)  
(d) Macros $\rightarrow$ Macros (Alt + L + PM)

260. In MS Word, New macro may be recorded through __________.  
(a) Macros $\rightarrow$ Macro Security (Alt + L + AS)  
(b) Macros $\rightarrow$ Record Macro (Alt + L + R)  
(c) Macros $\rightarrow$ Pause Recording (Alt + L + S)  
(d) Macros $\rightarrow$ Macros (Alt + L + PM)

261. In MS Word, the default macro security setting is __________.  
(a) Enable all macros  
(b) Disable all macros  
(c) Trust VBA Code  
(d) Do not trust VBA code

262. In MS Word, it is better change macro security setting to __________ before starting record or use macros.  
(a) Enable all macros  
(b) Disable all macros  
(c) Trust VBA Code  
(d) Do not trust VBA code

263. In MS Word, recording of macros may be paused and certain actions which need not be recorded in the macro may be performed through __________.  
(a) Macros $\rightarrow$ Macro Security (Alt + L + AS)  
(b) Macros $\rightarrow$ Record Macro (Alt + L + R)  
(c) Macros $\rightarrow$ Pause Recording (Alt + L + S)  
(d) Macros $\rightarrow$ Macros Resume Recorder (Alt + L + S)

264. In MS Word, paused macro recording may be resumed through __________.  
(a) Macros $\rightarrow$ Macro Security (Alt + L + AS)  
(b) Macros $\rightarrow$ Record Macro (Alt + L + R)  
(c) Macros $\rightarrow$ Pause Recording (Alt + L + S)  
(d) Macros $\rightarrow$ Macros Resume Recorder (Alt + L + S)

265. In MS Word, recorded macros may be edited or deleted through __________.  
(a) Macros $\rightarrow$ Macros (Alt + L + PM)  
(b) Macros $\rightarrow$ Record Macro (Alt + L + R)  
(c) Macros $\rightarrow$ Pause Recording (Alt + L + S)  
(d) Macros $\rightarrow$ Macros Resume Recorder (Alt + L + S)

266. In MS Word, coding in Visual Basic for Applications (VBA) may be carried out to customize the available features or add new features using __________.  
(a) Macros $\rightarrow$ Macros (Alt + L + PM)  
(b) Macros $\rightarrow$ Record Macro (Alt + L + R)  
(c) Macros $\rightarrow$ Visual Basic (Alt + L + V)  
(d) Macros $\rightarrow$ Macros Resume Recorder (Alt + L + S)

267. While creating a macro, its availability may be __________.  
(a) granted to all documents  
(b) restricted to the current document  
(c) both a & b  
(d) neither a nor b

1.4.8 Creating mail merge in MS Word

268. The feature in MS Word which helps to create customized correspondence targeting different recipients is called __________.  
(a) mail merge  
(b) charting  
(c) clip art  
(d) equations

269. A mail merge document requires a __________ to fill the blank spaces.  
(a) picture  
(b) record source  
(c) chart  
(d) equation

270. To create mail merge using existing list of recipients, choose __________.  
(a) Mailings $\rightarrow$ Select Recepients $\rightarrow$ Use Existing List  
(b) Mailings $\rightarrow$ Select Recepients $\rightarrow$ Type New List  
(c) Mailings $\rightarrow$ Select Recepients $\rightarrow$ Select from Outlook Contacts  
(d) Mailings $\rightarrow$ Insert Merge Field

271. To create mail merge using new list, choose __________.  
(a) Mailings $\rightarrow$ Select Recepients $\rightarrow$ Use Existing List  
(b) Mailings $\rightarrow$ Select Recepients $\rightarrow$ Type New List  
(c) Mailings $\rightarrow$ Select Recepients $\rightarrow$ Select from Outlook Contacts  
(d) Mailings $\rightarrow$ Insert Merge Field

272. To create mail merge using Outlook contacts list, choose __________.  
(a) Mailings $\rightarrow$ Select Recepients $\rightarrow$ Use Existing List
Q. Bank [COPA Semester - 1]

273. In MS Word, to insert a mail merge field in document, choose ___________
   (a) Mailings— >Select Recepients— >Use Existing List
   (b) Mailings— >Select Recepients— >Type New List
   (c) Mailings— >Select Recepients— >Select from Outlook Contacts
   (d) Mailings— >Insert Merge Field

274. In MS Word, data sources for mail merge may be prepared using
   (a) MS Excel
   (b) MS Access
   (c) Plain text file with tab for field separation & newline for record separation
   (d) all of them

275. Mail merge results may be previewed using __________ menu.
   (a) Mailings— >Edit Individual Documents
   (b) Mailings— >Preview Results (Alt+M+P)
   (c) Mailings— >Print Documents
   (d) Mailings— >Send E-Mail Messages

276. In MS Word, individual documents resulting from mail merge may be edited using __________ menu.
   (a) Mailings— >Edit Individual Documents
   (b) Mailings— >Preview Results (Alt+M+P)
   (c) Mailings— >Print Documents
   (d) Mailings— >Send E-Mail Messages

277. In MS Word, mail merge results may be printed using __________ menu.
   (a) Mailings— >Edit Individual Documents
   (b) Mailings— >Preview Results (Alt+M+P)
   (c) Mailings— >Print Documents
   (d) Mailings— >Send E-Mail Messages

278. In MS Word, mail merge results may be sent through email using __________ menu.
   (a) Mailings— >Edit Individual Documents
   (b) Mailings— >Preview Results (Alt+M+P)
   (c) Mailings— >Print Documents
   (d) Mailings— >Send E-Mail Messages

1.4.9 Creating templates in MS Word

279. A standard standard document with proper formatting and layout may be saved as a __________, which may be used as the base for new documents.
   (a) template
   (b) pdf file
   (c) plain text file
   (d) HTML file

280. A document may be saved as a template using File— >Save As from the menu and choosing __________ as the document type.
   (a) Excel Template
   (b) HTML file
   (c) Word Template
   (d) Open Document Format (ODF)

281. Default extension for word template is ____________.
   (a) .docx (b) .dotx (c) .xlsx (d) .pptx

282. Content created using template document ____________.
   (a) should be saved as Excel file
   (b) should be saved as new word document
   (c) should be saved as new power point document
   (d) none of them

283. Magazines, journals and proceedings may publish __________ for the help of authors in following the right styles for publication.
   (a) picture
   (b) screenshot
   (c) template document
   (d) Excel spreadsheets

1.4.10 Page setup & printing in MS Word

284. In MS Word, Selecting page size, margins and paper orientation is possible through ____________.
   (a) Page Layout— >Columns
   (b) Page Layout— >Page Setup (Alt+P+SP)
   (c) Page Layout— >Water Mark
   (d) Page Layout— >Page Color

285. In MS Word, choosing number of columns per page is possible through ____________.
   (a) Page Layout— >Columns
   (b) Page Layout— >Page Setup (Alt+P+SP)
   (c) Page Layout— >Water Mark
   (d) Page Layout— >Page Color

286. In MS Word, water mark can be inserted or removed through ____________.
   (a) Page Layout— >Columns

Prepared by: Dr.V.Nagaradjane
287. In MS Word, page background colour may be selected through ____________ option available in ____________
(a) Page Layout—>Columns
(b) Page Layout—>Page Setup (Alt+P+SP)
(c) Page Layout—>Water Mark
(d) Page Layout—>Page Color

288. In MS Word, page border may be selected through ____________
(a) Page Layout—>Page Border
(b) Page Layout—>Page Setup (Alt+P+SP)
(c) Page Layout—>Water Mark
(d) Page Layout—>Page Color

289. When the width of paper is smaller and height of paper is larger, the orientation is called ____________
(a) landscape
(b) portrait
(c) both a & b
(d) neither a nor b

290. When the width of paper is larger and height of paper is smaller, the orientation is called ____________
(a) landscape
(b) portrait
(c) both a & b
(d) neither a nor b

291. Commonly used paper sizes for MS Word documents are ____________
(a) A4
(b) letter
(c) legal
(d) all of them

292. In MS Word, a document may be printed using ____________
(a) File—>Print (Ctrl+P)
(b) Home—>Copy (Ctrl+C)
(c) Home—>Cut (Ctrl+X)
(d) Home—>Paste (Ctrl+V)

293. MS Word document type set on specific paper size may be printed on a different paper size using ____________ option available in print dialog.
(a) collate
(b) scale
(c) printer properties—>Finishing—>Print on both sides
(d) Properties—>Paper/Quality

294. Multiple copies of a document may be printed in complete sets (divide by set) using ____________ option available in print dialog.
(a) collate
(b) scale
(c) printer properties—>Finishing—>Print on both sides
(d) Properties—>Paper/Quality

295. A document may be printed on both sides of paper using ____________ option available in print dialog.
(a) collate
(b) scale
(c) printer properties—>Finishing—>Print on both sides
(d) Properties—>Paper/Quality

296. The print resolution (quality) and colour preferences may be set using ____________ option available in print dialog.
(a) collate
(b) scale
(c) printer properties—>Finishing—>Print on both sides
(d) Properties—>Paper/Quality

Answers (643 - 938)

1. (a) 2. (b) 3. (c) 4. (d)
5. (a) 6. (c) 7. (b) 8. (d)
9. (c) 10. (d) 11. (b) 12. (a)
13. (c) 14. (c) 15. (d) 16. (c)
17. (b) 18. (d) 19. (a) 20. (b)
21. (d) 22. (c) 23. (a) 24. (c)
25. (d) 26. (c) 27. (a) 28. (d)
29. (c) 30. (b) 31. (c) 32. (d)
33. (a) 34. (a) 35. (a) 36. (a)
37. (b) 38. (b) 39. (c) 40. (c)
41. (d) 42. (d) 43. (b) 44. (b)
45. (c) 46. (c) 47. (a) 48. (a)
49. (a) 50. (b) 51. (c) 52. (d)
53. (a) 54. (a) 55. (b) 56. (c)
57. (d) 58. (b) 59. (c) 60. (d)
61. (a) 62. (d) 63. (a) 64. (d)
65. (a) 66. (b) 67. (c) 68. (a)
69. (d) 70. (c) 71. (b) 72. (a)
73. (b) 74. (c) 75. (d) 76. (a)
77. (a) 78. (c) 79. (b) 80. (d)
81. (a) 82. (b) 83. (c) 84. (b)
85. (a) 86. (c) 87. (d) 88. (c)
89. (a) 90. (a) 91. (c) 92. (d)
93. (a) 94. (b) 95. (c) 96. (d)
97. (b) 98. (c) 99. (a) 100. (b)
101. (c) 102. (d) 103. (c) 104. (a)
105. (b) 106. (c) 107. (a) 108. (d)
109. (a) 110. (b) 111. (c) 112. (d)
113. (a) 114. (a) 115. (b) 116. (c)
<table>
<thead>
<tr>
<th>Q. Bank [COPA Semester - 1]</th>
</tr>
</thead>
<tbody>
<tr>
<td>117. (d) 118. (a) 119. (b) 120. (c) 209. (c) 210. (a) 211. (b) 212. (c)</td>
</tr>
<tr>
<td>121. (d) 122. (a) 123. (b) 124. (c) 213. (d) 214. (a) 215. (b) 216. (c)</td>
</tr>
<tr>
<td>125. (d) 126. (a) 127. (b) 128. (c) 217. (d) 218. (a) 219. (b) 220. (c)</td>
</tr>
<tr>
<td>129. (d) 130. (a) 131. (a) 132. (b) 221. (d) 222. (a) 223. (b) 224. (d)</td>
</tr>
<tr>
<td>133. (c) 134. (d) 135. (a) 136. (b) 225. (c) 226. (b) 227. (c) 228. (c)</td>
</tr>
<tr>
<td>137. (c) 138. (d) 139. (b) 140. (a) 229. (d) 230. (a) 231. (d) 232. (a)</td>
</tr>
<tr>
<td>141. (c) 142. (d) 143. (a) 144. (b) 233. (b) 234. (c) 235. (d) 236. (b)</td>
</tr>
<tr>
<td>145. (c) 146. (d) 147. (a) 148. (b) 237. (c) 238. (d) 239. (d) 240. (a)</td>
</tr>
<tr>
<td>149. (d) 150. (c) 151. (a) 152. (b) 241. (b) 242. (d) 243. (a) 244. (d)</td>
</tr>
<tr>
<td>153. (c) 154. (d) 155. (a) 156. (b) 245. (a) 246. (b) 247. (c) 248. (d)</td>
</tr>
<tr>
<td>157. (c) 158. (d) 159. (a) 160. (b) 249. (a) 250. (b) 251. (c) 252. (b)</td>
</tr>
<tr>
<td>161. (c) 162. (a) 163. (b) 164. (c) 253. (c) 254. (a) 255. (d) 256. (c)</td>
</tr>
<tr>
<td>165. (d) 166. (b) 167. (a) 168. (c) 257. (a) 258. (b) 259. (a) 260. (b)</td>
</tr>
<tr>
<td>169. (d) 170. (a) 171. (b) 172. (c) 261. (b) 262. (a) 263. (c) 264. (d)</td>
</tr>
<tr>
<td>173. (d) 174. (a) 175. (d) 176. (c) 265. (a) 266. (b) 267. (c) 268. (a)</td>
</tr>
<tr>
<td>177. (b) 178. (c) 179. (c) 180. (d) 269. (b) 270. (a) 271. (b) 272. (c)</td>
</tr>
<tr>
<td>181. (a) 182. (b) 183. (a) 184. (c) 273. (d) 274. (d) 275. (b) 276. (a)</td>
</tr>
<tr>
<td>185. (a) 186. (d) 187. (b) 188. (d) 277. (c) 278. (d) 279. (a) 280. (c)</td>
</tr>
<tr>
<td>189. (b) 190. (a) 191. (b) 192. (d) 281. (b) 282. (b) 283. (c) 284. (b)</td>
</tr>
<tr>
<td>193. (c) 194. (a) 195. (c) 196. (b) 285. (a) 286. (c) 287. (d) 288. (a)</td>
</tr>
<tr>
<td>197. (d) 198. (a) 199. (b) 200. (d) 289. (b) 290. (a) 291. (d) 292. (a)</td>
</tr>
<tr>
<td>201. (c) 202. (a) 203. (b) 204. (c) 293. (b) 294. (a) 295. (c) 296. (d)</td>
</tr>
<tr>
<td>205. (a) 206. (b) 207. (c) 208. (d)</td>
</tr>
</tbody>
</table>
1.5 MS Excel

1. Columns in MS Excel are named in the form of ________.
   (a) alphabets (A, B, C, D, ...)
   (b) numbers (1, 2, 3, 4, ...)
   (c) roman numerals (I, II, III, IV, ...)
   (d) none of them

2. Rows in MS Excel are named in the form of ________.
   (a) alphabets (A, B, C, D, ...)
   (b) numbers (1, 2, 3, 4, ...)
   (c) roman numerals (I, II, III, IV, ...)
   (d) none of them

3. The intersection of a row and column in MS Excel is called ________.
   (a) spreadsheet
   (b) workbook
   (c) document
   (d) cell

4. The cell having column number 3 and row number 6 is denoted by the name ________.
   (a) F3
   (b) C6
   (c) C3
   (d) F6

5. In MS Excel, a function is entered by typing ________ symbol first.
   (a) @
   (b) $
   (c) #
   (d) =

6. MS Excel can ____________ given data.
   (a) sort
   (b) statistically analyze
   (c) draw graphs for
   (d) all of them

7. The latest version of MS Excel can have ________ rows.
   (a) 10,48,576
   (b) 16,384
   (c) 1024
   (d) 512

8. The latest version of MS Excel can have ________ columns.
   (a) 10,48,576
   (b) 16,384
   (c) 1024
   (d) 512

9. Excel supports recording of repeated actions with the help of ________.
   (a) graph
   (b) chart
   (c) macro
   (d) other applications

10. MS Excel macros can be invoked using ________.
    (a) button
    (b) keystroke
    (c) both a & b
    (d) neither a nor b

11. MS Excel supports a version of Visual Basic called ________ for programming.
    (a) Javascript
    (b) Visual Basic for Applications (VBA)
    (c) ASP.NET
    (d) C#.NET

12. Each file in MS Excel is called a ________.
    (a) workbook
    (b) worksheet
    (c) notesheet
    (d) notebook

13. Each sheet in MS Excel file is called a ________.
    (a) workbook
    (b) worksheet
    (c) notesheet
    (d) notebook

14. By default, Excel worksheets are named ________.
    (a) book1, book2, book3, ...
    (b) sheet1, sheet2, sheet3, ...
    (c) page1, page2, page3, ...
    (d) note1, note2, note3, ...

15. Excel file without any macros has the default extension of ________.
    (a) .xlsx
    (b) .xls
    (c) .xlsm
    (d) .xmlt

16. Excel file containing macros has the default extension of ________.
    (a) .xlsx
    (b) .xls
    (c) .xlsm
    (d) .xmlt

17. MS Excel can reference data in ________.
    (a) the same sheet
    (b) different sheet in the same workbook
    (c) different sheet in a different workbook
    (d) all of them

1.5.1 Data types in MS Excel

18. In MS Excel, the common type of data applicable to any cell is called ________ data type.
    (a) General
    (b) Number
    (c) Currency
    (d) Text

19. In MS Excel, the data type suitable for handling numbers is called ________ data type.
    (a) General
    (b) Number
    (c) Currency
    (d) Text

20. In MS Excel, number data type can control the ________.
    (a) digit grouping
    (b) number of decimal places
    (c) both a & b
    (d) neither a nor b
21. In MS Excel, numbers can be grouped and prefixed with a currency symbol using ________ data type.
   (a) Accounting  
   (b) Currency    
   (c) both a & b   
   (d) neither a nor b

22. In MS Excel, ________ data type is suitable for handling dates.
   (a) Date        
   (b) Time       
   (c) Percentage  
   (d) Fraction

23. In MS Excel, ________ data type is suitable for handling time values.
   (a) Date        
   (b) Time       
   (c) Percentage  
   (d) Fraction

24. In MS Excel, ________ data type takes values between 0 and 1 and displays them in percentage format.
   (a) Date        
   (b) Time       
   (c) Percentage  
   (d) Fraction

25. In MS Excel, ________ data type displays decimal fractions as vulgar or mixed fractions.
   (a) Date        
   (b) Time       
   (c) Percentage  
   (d) Fraction

26. In MS Excel, ________ data type displays numbers in scientific notation.
   (a) Scientific  
   (b) Text       
   (c) Custom     
   (d) Date

27. In MS Excel, ________ data type is suitable for names and other character sequences.
   (a) Scientific  
   (b) Text       
   (c) Custom     
   (d) Date

28. In MS Excel, ________ data type supports formatting of numbers with suitable customization.
   (a) Scientific  
   (b) Text       
   (c) Custom     
   (d) Date

29. In MS Excel, for the number 45453453 to be displayed as 4,54,53,453.0, the custom format could be ________.
   (a) ##,##,##,##0.0  
   (b) ###,###,##0.0   
   (c) #######0.0     
   (d) ##,##,##,##.#

30. In custom formatting of numbers, an optional digit is denoted by ________ symbol.
   (a) 0          
   (b) #        
   (c) $        
   (d) ^

1.5.2 Cell referencing

32. When copying and pasting an excel formula, the method which permits formula to progressively update cell references is called ________ referencing system.
   (a) static  
   (b) semi-relative  
   (c) relative  
   (d) none of them

33. When copying and pasting an excel formula, the method which permits formula to progressively update either column reference or row reference (but not both column and row references) is called ________ referencing system.
   (a) static  
   (b) semi-relative  
   (c) relative  
   (d) none of them

34. When copying and pasting an excel formula, the method which keeps references to a particular cell address is called ________ referencing system.
   (a) static  
   (b) semi-relative  
   (c) relative  
   (d) none of them

35. The formula = A5 * 5 is written in ________ system.
   (a) static  
   (b) semi-relative  
   (c) relative  
   (d) none of them

36. The formula = A5 * 5, when copied to the next row of the same column, will become ________ system.
   (a) = A4 * 5  
   (b) = B5 * 5  
   (c) = A7 * 5  
   (d) = A6 * 5

1.5.3 Categories of functions in MS Excel

37. In MS Excel, ________ functions help to access databases stored in spreadsheets.
   (a) Cube/ Database  
   (b) Date/ Time
38. ________ functions help to access date and time functions in MS Excel.
(a) Cube/ Database
(b) Date/ Time
(c) Engineering
(d) Financial

39. ________ functions help to access base conversion, logarithmic and other Engineering features in MS Excel.
(a) Cube/ Database
(b) Date/ Time
(c) Engineering
(d) Financial

40. In MS Excel, ________ functions help to access interest calculation, accounting and currency related calculations.
(a) Cube/ Database
(b) Date/ Time
(c) Engineering
(d) Financial

41. In MS Excel, ________ functions help to check the status of cells, as to whether the cell is blank, contains a number, text, type of data, etc.
(a) Information
(b) Logical
(c) Lookup & reference
(d) Math & Trigonometric

42. In MS Excel, ________ functions help to make logical functions like AND, OR, NOT, etc.
(a) Information
(b) Logical
(c) Lookup & reference
(d) Math & Trigonometric

43. In MS Excel, ________ functions help to make lookup in other sheets and references.
(a) Information
(b) Logical
(c) Lookup & reference
(d) Math & Trigonometric

44. In MS Excel, mathematical functions like round, absolute, ceiling, floor, etc. and trigonometric functions like sin, cos, tan, asin, acos, atan, etc are containing the category of ________
(a) Information
(b) Logical
(c) Lookup & reference

45. In MS Excel, statistical functions like average, standard deviation, median, mode, etc. can be accessed under the category ________
(a) Logical
(b) Lookup & reference
(c) Math & Trigonometric
(d) Statistical

46. In MS Excel, functions for length of text, text search, text concatenation, upper, lower and proper, etc. can be accessed under the category ________
(a) Text
(b) Logical
(c) Lookup & reference
(d) Math & Trigonometric

Date functions

47. ________ function in MS Excel takes year, month and date values and displays given date.
(a) DATE
(b) DATEDIF
(c) DATEVALUE
(d) DAY

48. ________ function in MS Excel takes a date value and returns the day of month.
(a) DATE
(b) DATEDIF
(c) DATEVALUE
(d) DAY

49. ________ function in MS Excel takes 2 date values and calculates the difference between the dates in years ("Y"), months ("M") or days ("D").
(a) DATE
(b) DATEDIF
(c) DATEVALUE
(d) DAY

50. ________ function in MS Excel takes a date string and returns parsed date value.
(a) DATE
(b) DATEDIF
(c) DATEVALUE
(d) DAY

51. ________ function in MS Excel returns number of days between given dates.
(a) DAYS/ DAYS360
(b) EDATE
(c) EOMONTH
(d) HOUR

52. ________ function in MS Excel takes a date, number of months to offset from that date and returns new date.
(a) DAYS/ DAYS360
(b) EDATE
(c) EOMONTH
(d) HOUR
53. _______ function in MS Excel returns last date of the month represented by given date.
   (a) DAYS/ DAYS360
   (b) EDATE
   (c) EOMONTH
   (d) HOUR

54. _______ function in MS Excel returns the hour represented by the given time.
   (a) DAYS/ DAYS360
   (b) EDATE
   (c) EOMONTH
   (d) HOUR

55. _______ function in MS Excel returns minutes from a time value.
   (a) MINUTES
   (b) SECOND
   (c) EOMONTH
   (d) HOUR

56. _______ function in MS Excel returns seconds from a time value.
   (a) MINUTES
   (b) SECOND
   (c) EOMONTH
   (d) HOUR

57. _______ function in MS Excel returns current time.
   (a) MINUTES
   (b) SECOND
   (c) NOW
   (d) HOUR

58. _______ function in MS Excel returns current date.
   (a) MINUTES
   (b) SECOND
   (c) NOW
   (d) TODAY

59. _______ function in MS Excel returns day of week for given date.
   (a) WEEKDAY
   (b) WORKDAY
   (c) YEAR
   (d) YEARFRAC

60. _______ function in MS Excel returns the date after given number of working days.
   (a) WEEKDAY
   (b) WORKDAY
   (c) YEAR
   (d) YEARFRAC

61. _______ function in MS Excel returns the year part of given date.
   (a) WEEKDAY
   (b) WORKDAY
   (c) YEAR
   (d) YEARFRAC

62. _______ function in MS Excel returns fractional year between given dates.
   (a) WEEKDAY
   (b) WORKDAY
   (c) YEAR
   (d) YEARFRAC

Engineering functions

63. In MS Excel, _______ function converts a binary number to decimal number.
   (a) BIN2DEC
   (b) BIN2HEX
   (c) BIN2OCT
   (d) BITAND

64. In MS Excel, _______ function converts a binary number to hexadecimal number.
   (a) BIN2DEC
   (b) BIN2HEX
   (c) BIN2OCT
   (d) BITAND

65. In MS Excel, _______ function converts a binary number to octal number.
   (a) BIN2DEC
   (b) BIN2HEX
   (c) BIN2OCT
   (d) BITAND

66. In MS Excel, _______ function performs bitwise AND operation.
   (a) BIN2DEC
   (b) BIN2HEX
   (c) BIN2OCT
   (d) BITAND

67. In MS Excel, _______ function performs bitwise OR operation.
   (a) BITOR
   (b) BITSHIFT
   (c) BITXOR
   (d) BITAND

68. In MS Excel, _______ function performs bitwise right shift operation.
   (a) BITOR
   (b) BITSHIFT
   (c) BITXOR
   (d) BITAND

69. In MS Excel, _______ function performs bitwise XOR operation.
   (a) BITOR
   (b) BITSHIFT
   (c) BITXOR
   (d) BITAND

70. In MS Excel, _______ function converts given value from one unit to another (for example, "m" to "ft").
   (a) COVNET
   (b) DEC2BIN
   (c) DEC2HEX
   (d) DEC2OCT

71. In MS Excel, _______ function converts decimal number to binary number.
   (a) COVNET
   (b) DEC2BIN
   (c) DEC2HEX
   (d) DEC2OCT

72. In MS Excel, _______ function converts decimal number to hexadecimal number.
   (a) COVNET
   (b) DEC2BIN
   (c) DEC2HEX
   (d) DEC2OCT

73. In MS Excel, _______ function converts decimal number to octal number.
   (a) COVNET
   (b) DEC2BIN
   (c) DEC2HEX
   (d) DEC2OCT

74. In MS Excel, _______ function returns 1 if given values are equal.
   (a) DELTA
   (b) DEC2BIN
   (c) DEC2HEX
   (d) DEC2OCT

75. In MS Excel, _______ function converts hexadecimal number to binary number.
   (a) DELTA
   (b) HEX2BIN
   (c) HEX2DEC
   (d) HEX2OCT

Prepared by: Dr. V. Nagaradjane
76. In MS Excel, __________ function converts hexadecimal number to decimal number.
(a) DELTA  (b) HEX2BIN  
(c) HEX2DEC  (d) HEX2OCT

77. In MS Excel, __________ function converts hexadecimal number to octal number.
(a) DELTA  (b) HEX2BIN  
(c) HEX2DEC  (d) HEX2OCT

Cell information functions

78. In MS Excel, __________ function returns true if a cell is blank.
(a) ISBLANK  (b) ISERR  
(c) ISEVEN  (d) ISODD

79. In MS Excel, __________ function returns true if there is an error in the formula contained in given cell.
(a) ISBLANK  (b) ISERR  
(c) ISEVEN  (d) ISODD

80. In MS Excel, __________ function returns true if the given cell contains an even number.
(a) ISBLANK  (b) ISERR  
(c) ISEVEN  (d) ISODD

81. In MS Excel, __________ function returns true if the given cell contains an odd number.
(a) ISBLANK  (b) ISERR  
(c) ISEVEN  (d) ISODD

82. In MS Excel, __________ function returns true if the given cell contains a formula.
(a) ISFORMULA  (b) ISERR  
(c) ISEVEN  (d) ISODD

83. In MS Excel, __________ function returns true if the given cell a logical value (TRUE or FALSE).
(a) ISNUMBER  (b) ISNONTEXT  
(c) ISNA  (d) ISLOGICAL

Logical functions

84. In MS Excel, __________ function returns true only if all the given conditions are true.
(a) OR  (b) FALSE  
(c) TRUE  (d) AND

85. In MS Excel, __________ function returns true even if just one of the given conditions is true.
(a) OR  (b) FALSE  
(c) TRUE  (d) AND

86. In MS Excel, __________ function tests the condition given in the first part, executes second part if the condition is true or executes third part if the condition is false.
(a) OR  (b) IF  
(c) TRUE  (d) AND

Math functions

87. In MS Excel, __________ function returns #NA error number.
(a) N  (b) NA  
(c) TYPE  (d) AND

88. In MS Excel, __________ function returns number equivalent of text value.
(a) N  (b) NA  
(c) TYPE  (d) AND

89. In MS Excel, __________ function returns a number corresponding to the data type of the cell.
(a) N  (b) NA  
(c) TYPE  (d) AND

90. In MS Excel, __________ function returns the condition given in the first part, executes second part if the condition is true or executes third part if the condition is false.
(a) OR  (b) IF  
(c) TRUE  (d) AND

91. In MS Excel, __________ function returns positive value irrespective of whether the input is positive or negative.
(a) ABS  (b) ASIN  
(c) ACOS  (d) ATAN
96. In MS Excel, ______ function returns $\cos^{-1}$ value.
   (a) ABS  (b) ASIN  (c) ACOS  (d) ATAN

97. In MS Excel, ______ function returns $\tan^{-1}$ value.
   (a) ABS  (b) ASIN  (c) ACOS  (d) ATAN

98. In MS Excel, ______ function returns $\cot^{-1}$ value.
   (a) ACOT  (b) ASIN  (c) ACOS  (d) ATAN

99. In MS Excel, ______ function returns aggregate value like count, sum, average, etc.
   (a) ARABIC  (b) ASINH  (c) ATANH  (d) AGGREGATE

100. In MS Excel, ______ function returns hyperbolic sin value.
    (a) ACOSH  (b) ASINH  (c) ATANH  (d) AGGREGATE

101. In MS Excel, ______ function returns hyperbolic cosine value.
     (a) ACOSH  (b) ASINH  (c) ATANH  (d) AGGREGATE

102. In MS Excel, ______ function returns hyperbolic tan value.
     (a) ACOSH  (b) ASINH  (c) ATANH  (d) AGGREGATE

103. In MS Excel, ______ function returns the integer just above a fractional number.
     (a) CEILING  (b) FLOOR  (c) ROUND  (d) ROUNDDOWN

104. In MS Excel, ______ function returns the integer just below a fractional number.
     (a) CEILING  (b) FLOOR  (c) ROUND  (d) ROUNDDOWN

105. In MS Excel, ______ function returns the number rounded to the given digits.
     (a) CEILING  (b) FLOOR  (c) ROUND  (d) ROUNDDOWN

106. In MS Excel, ______ function returns the number rounded DOWN to the given digits, simply discarding the trailing value even if it is greater than or equal to 5.
     (a) CEILING  (b) FLOOR  (c) ROUND  (d) ROUNDDOWN

107. In MS Excel, ______ function returns the number rounded UP to the given digits, simply discarding the trailing value even if it is greater than or equal to 5.
     (a) CEILING  (b) FLOOR  (c) ROUND  (d) ROUNDDOWN

108. In MS Excel, ______ function returns the number of statistical combinations ($\binom{n}{r}$) possible.
    (a) ROUNDUP  (b) FLOOR  (c) COMBIN  (d) PERMUT

109. In MS Excel, ______ function returns the number of statistical permutations ($\binom{n}{r}$) possible.
    (a) ROUNDUP  (b) FLOOR  (c) COMBIN  (d) PERMUT

110. In MS Excel, ______ function converts given angle from radian to degrees.
     (a) DEGREES  (b) RADIANS  (c) EVEN  (d) ODD

111. In MS Excel, ______ function converts given angle from degrees to radians.
     (a) DEGREES  (b) RADIANS  (c) EVEN  (d) ODD

112. In MS Excel, ______ function returns the nearest even number.
     (a) DEGREES  (b) RADIANS  (c) EVEN  (d) ODD

113. In MS Excel, ______ function returns the nearest odd number.
     (a) DEGREES  (b) RADIANS  (c) EVEN  (d) ODD

114. In MS Excel, ______ function returns the exponential value for given number.
     (a) EXP  (b) LN  (c) LOG/LOG10  (d) FACT

115. In MS Excel, ______ function returns the natural logarithm for given number.
     (a) EXP  (b) LN  (c) LOG/LOG10  (d) FACT

116. In MS Excel, ______ function returns the common logarithm (to the base 10) for given number.
     (a) EXP  (b) LN  (c) LOG/LOG10  (d) FACT

117. In MS Excel, ______ function returns the factorial of given number in integer format.
     (a) FACTDOUBLE  (b) LN  (c) LOG/LOG10  (d) FACT

118. In MS Excel, ______ function returns the factorial of given number in double number format.
     (a) FACTDOUBLE  (b) LN

Prepared by: Dr.V.Nagaradjane
119. In MS Excel, ________ function returns the greatest common divisor for given numbers.
   (a) FACTDOUBLE  (b) GCD  (c) LCM  (d) INT

120. In MS Excel, ________ function returns the least common multiple for given numbers.
   (a) FACTDOUBLE  (b) GCD  (c) LCM  (d) INT

121. In MS Excel, ________ function returns the integer equivalent of given number, after discarding fractional parts.
   (a) FACTDOUBLE  (b) GCD  (c) LCM  (d) INT

122. In MS Excel, ________ function returns the determinant of given matrix.
   (a) MDTERM  (b) MINVERSE  (c) MMUL  (d) MOD

123. In MS Excel, ________ function returns the inverse of given matrix.
   (a) MDTERM  (b) MINVERSE  (c) MMUL  (d) MOD

124. In MS Excel, ________ function returns the multiplication result of given matrix.
   (a) MDTERM  (b) MINVERSE  (c) MMUL  (d) MOD

125. In MS Excel, ________ function returns the modulo remainder for given number and divisor.
   (a) QUOTIENT  (b) MINVERSE  (c) MMUL  (d) MOD

126. In MS Excel, ________ function returns the quotient for given number and divisor.
   (a) QUOTIENT  (b) MINVERSE  (c) MMUL  (d) MOD

127. In MS Excel, ________ function returns the number rounded to the nearest multiple of the second argument.
   (a) PI  (b) POWER  (c) MROUND  (d) RAND

128. In MS Excel, ________ function returns the value of \( \pi \).
   (a) PI  (b) POWER  (c) MROUND  (d) RAND

129. In MS Excel, ________ function returns the power of given number raised by second argument.
   (a) PI  (b) POWER  (c) MROUND  (d) RAND

130. In MS Excel, ________ function returns a random number.
   (a) PI  (b) POWER  (c) MROUND  (d) RAND

131. In MS Excel, ________ function returns a random number between given lower limit and upper limit.
   (a) PI  (b) POWER  (c) MROUND  (d) RANDBETWEEN

132. In MS Excel, ________ function converts a number from Roman numeral to Arabic numeral.
   (a) ROMAN  (b) ARABIC  (c) SIGN  (d) SQRT

133. In MS Excel, ________ function converts a number from Arabic numeral to Roman numeral.
   (a) ROMAN  (b) ARABIC  (c) SIGN  (d) SQRT

134. In MS Excel, ________ function returns \(-1\) if given number is negative and 1 if is positive.
   (a) ROMAN  (b) ARABIC  (c) SIGN  (d) SQRT

135. In MS Excel, ________ function returns the square root of the given number.
   (a) ROMAN  (b) ARABIC  (c) SIGN  (d) SQRT

136. In MS Excel, ________ function returns the subtotal of given numbers.
   (a) SUBTOTAL  (b) SUM  (c) SUMIF  (d) SUMSQ

137. In MS Excel, ________ function returns the sum of given numbers.
   (a) SUBTOTAL  (b) SUM  (c) SUMIF  (d) SUMSQ

138. In MS Excel, ________ function returns the sum of squares of given numbers.
   (a) SUBTOTAL  (b) SUM  (c) SUMIF  (d) SUMSQ

139. In MS Excel, ________ function returns the sum of those numbers that fulfill given condition.
   (a) SUBTOTAL  (b) SUM  (c) SUMIF  (d) SUMSQ

140. In MS Excel, ________ function truncates decimal digits of given real number to produce an integer value.
   (a) TRUNC  (b) SUM  (c) SUMIF  (d) SUMSQ
Statistical functions in MS Excel

141. In MS Excel, ________ function calculates the average absolute (unsigned) deviation.
   (a) AVERAGE  (b) AVEDEV
   (c) AVERAGEIFS  (d) CORREL

142. In MS Excel, ________ function calculates the average of given numbers.
   (a) AVERAGE  (b) AVEDEV
   (c) AVERAGEIFS  (d) CORREL

143. In MS Excel, ________ function calculates the average of given numbers which fulfill the given conditions.
   (a) AVERAGE  (b) AVEDEV
   (c) AVERAGEIFS  (d) CORREL

144. In MS Excel, ________ function calculates the coefficient of correlation.
   (a) AVERAGE  (b) AVEDEV
   (c) AVERAGEIFS  (d) CORREL

145. In MS Excel, ________ function counts the number of objects.
   (a) COUNT  (b) DEVSQ
   (c) FORECAST  (d) COUNTBLANK

146. In MS Excel, ________ function counts the number of blank cells.
   (a) COUNT  (b) DEVSQ
   (c) FORECAST  (d) COUNTBLANK

147. In MS Excel, ________ function returns the sum of squares of deviations.
   (a) COUNT  (b) DEVSQ
   (c) FORECAST  (d) COUNTBLANK

148. In MS Excel, ________ function counts the items based on given condition.
   (a) COUNT  (b) DEVSQ
   (c) FORECAST  (d) COUTNIF

149. In MS Excel, ________ function counts the items based on given conditions.
   (a) COUNT  (b) DEVSQ
   (c) FORECAST  (d) COUTNIFS

150. In MS Excel, ________ function provides a linear estimate of the result expected for given input.
    (a) COUNT  (b) DEVSQ
    (c) FORECAST  (d) COUTNIFS

151. In MS Excel, ________ function provides an exponential estimate of the result expected for given input.
    (a) GROWTH  (b) GEOMEAN
    (c) LARGE  (d) MEDIAN

152. In MS Excel, ________ function returns the median value of a list.
    (a) GROWTH  (b) GEOMEAN

Text functions

161. In MS Excel, ________ function returns the character equivalent of numeric ASCII value.
    (a) CHAR  (b) CODE
    (c) DOLLAR  (d) CONCATENATE

162. In MS Excel, ________ function returns the ASCII code for given character value.
    (a) CHAR  (b) CODE
    (c) DOLLAR  (d) CONCATENATE

163. ASCII stands for ________.
    (a) American Standard Code for Information Interface
    (b) African Standard Code for Information Interface

Prepared by: Dr. V. Nagaradjane
In MS Excel, __________ function formats a number as currency and prefixes the currency symbol of the locale.
(a) CHAR (b) CODE (c) DOLLAR (d) CONCATENATE

In MS Excel, __________ function appends several strings one after the other.
(a) CHAR (b) CODE (c) DOLLAR (d) CONCATENATE

In MS Excel, __________ function formats given number based on rules provided using # and 0 characters.
(a) FORMAT (b) LEFT (c) EXACT (d) FIND

In MS Excel, __________ function returns the location of the first string occurring within the second, larger string.
(a) FORMAT (b) LEFT (c) EXACT (d) FIND

In MS Excel, __________ function returns the length of given string.
(a) LOWER (b) UPPER (c) PROPER (d) LEN

In MS Excel, __________ function returns formatted version of given number.
(a) T (b) TEXT (c) SUBSTITUTE (d) TRIM

In MS Excel, __________ function returns a string after replacing given characters of first string using the last string.
(a) SEARCH (b) REPLACE (c) REPT (d) LOWER

In MS Excel, __________ function repeats a string for given number of times.
(a) SEARCH (b) REPLACE (c) REPT (d) LOWER

In MS Excel, __________ function returns the location of the first string occurring inside the second string.
(a) SEARCH (b) REPLACE (c) REPT (d) LOWER

In MS Excel, __________ function returns a string only when the given input is a string, returning blank value otherwise.
(a) TEXT (b) SUBSTITUTE (c) TRIM (d) T

1.5.4 Sorting in MS Excel

Data can be sorted using _______ menu in MS Excel.
(a) Data—>Filter (b) Data—>Sort (c) Data—>What if analysis—>Data table (d) Data—>What if analysis—>Pivot table

To sort data in MS Excel, __________ containing data for sorting should be selected.
(a) all the cells
185. The sort dialog in MS Excel contains a tick box named __________ to select whether the data contains a header row or not.
(a) My data contains footers
(b) My data contains errors
(c) My data contains pictures
(d) My data contains headers

186. The sorting dialog in MS Excel contains __________ boxes to choose sorting criteria.
(a) column name to be used for sorting
(b) whether to sort by value, color or icon
(c) whether to sort ascending or descending
(d) all of them

187. In MS Excel, if the sorting requires several levels of criteria, the same can be added using __________ button in sorting dialog.
(a) Add level
(b) add row
(c) add column
(d) add filter

1.5.5 Filtering in MS Excel

188. Data can be filtered using __________ menu in MS Excel.
(a) Data— >Filter
(b) Data— >Sort
(c) Data— >What if analysis— >Data table
(d) Data— >What if analysis— >Pivot table

189. For applying filtering, the data should contain __________.
(a) no header row
(b) header row
(c) footer row
(d) pivot table

190. After selecting data and invoking Data— >Filter from the menu, a __________ appears in each column of the first row to enable filtering.
(a) circle
(b) square
(c) triangular button
(d) red dot

191. The triangular filter button at header row of data helps sorting of data using __________.
(a) ascending/descending order
(b) color
(c) search specific values or applying filter conditions for numbers
(d) all of them

1.5.6 Validation in MS Excel

192. After selecting the cells to be subjected to data validation, choose __________ from the menu to validate data in MS Excel.
(a) Data— >Filter
(b) Data— >Sort
(c) Data— >Validation
(d) Data— >What if analysis— >Pivot table

193. In MS Excel, permitting data values in specific range for entry in a cell is called __________.
(a) validation
(b) sorting
(c) filtering
(d) chart

194. The data validation dialog shows, allow criterion with __________ conditions.
(a) between/ not between
(b) equal to/ not equal to
(c) >, <, ≥, ≤
(d) all of them

195. In MS Excel, data violating the validation rule may be __________ using Data— >Validation— >Circle invalid data.
(a) encircled
(b) deleted
(c) sorted
(d) coloured

196. In MS Excel, to display a specific error message for invalid data entry, __________ tab in validation dialog can be opened to set a custom message.
(a) Error display
(b) Input message
(c) Output message
(d) Result message

1.5.7 Charting in MS Excel

197. MS Excel supports __________ type chart.
(a) column/ bar
(b) pie/ area/ stock/ surface/ doughnut/ bubble/ radar
(c) scatter/ line
(d) all of them

198. The data used for charting should have __________ to decide the graph parameters like axis name.
(a) header row
(b) footer row
(c) blank row
(d) blank column

199. In MS Excel, pie chart may be inserted using __________ menu.
200. In MS Excel, bar chart may be inserted using \textit{_____________} menu.
(a) Insert \(\rightarrow\) Pie
(b) Insert \(\rightarrow\) Column
(c) Insert \(\rightarrow\) Bar
(d) Insert \(\rightarrow\) line

201. In MS Excel, column chart may be inserted using \textit{_____________} menu.
(a) Insert \(\rightarrow\) Pie
(b) Insert \(\rightarrow\) Column
(c) Insert \(\rightarrow\) Bar
(d) Insert \(\rightarrow\) line

202. In MS Excel, line chart may be inserted using \textit{_____________} menu.
(a) Insert \(\rightarrow\) Pie
(b) Insert \(\rightarrow\) Column
(c) Insert \(\rightarrow\) Bar
(d) Insert \(\rightarrow\) line

203. In MS Excel, scatter chart may be inserted using \textit{_____________} menu.
(a) Insert \(\rightarrow\) Pie
(b) Insert \(\rightarrow\) Column
(c) Insert \(\rightarrow\) Bar
(d) Insert \(\rightarrow\) X-Y scatter

204. In MS Excel, charts may be customized by \textit{_____________} on appropriate element of the graph.
(a) selecting
(b) right clicking
(c) both a \& b
(d) none of them

1.5.8 Data tables in MS Excel

205. Results for several input values can be calculated based on one sample result using \textit{_____________} menu in MS Excel.
(a) Data \(\rightarrow\) Filter
(b) Data \(\rightarrow\) Sort
(c) Data \(\rightarrow\) What if analysis \(\rightarrow\) Pivot table
(d) Data \(\rightarrow\) What if analysis \(\rightarrow\) Data table

206. In MS Excel, for a row wise data table, fill input values in top row, calculate result for first column in the second row and choose \textit{_____________} in the Data table dialog.

(a) \textit{Row Input and Result}
(b) Column Input and Result
(c) both row input and column input along with result
(d) none of them

207. In MS Excel, for a column wise data table, fill input values in left column, calculate result for first row in the right side column and choose \textit{_____________} in the Data table dialog.
(a) Row Input and Result
(b) Column Input and Result
(c) both row input and column input along with result
(d) none of them

208. In MS Excel, to calculate results based on two input values (like a matrix), choose \textit{_____________} from the Data table dialog.
(a) Row Input and Result
(b) Column Input and Result
(c) both row input and column input along with result
(d) none of them

1.5.9 Pivot table

209. In MS Excel, summary of data in a table may be created using \textit{_____________}.
(a) data table
(b) pivot table
(c) chart
(d) validation

210. In MS Excel, data meant for pivot table may be converted to a table using \textit{_____________} first.
(a) Insert \(\rightarrow\) Table
(b) Insert \(\rightarrow\) Pie
(c) Insert \(\rightarrow\) Column
(d) Insert \(\rightarrow\) Scatter

211. In MS Excel, pivot table may be inserted using \textit{_____________} first.
(a) Insert \(\rightarrow\) Table
(b) Insert \(\rightarrow\) Pivot \(\rightarrow\) Pivot table
(c) Insert \(\rightarrow\) Pivot \(\rightarrow\) Pivot chart
(d) Insert \(\rightarrow\) Scatter

212. In MS Excel, pivot chart may be inserted using \textit{_____________} first.
(a) Insert \(\rightarrow\) Table
(b) Insert \(\rightarrow\) Pivot \(\rightarrow\) Pivot table
(c) Insert \(\rightarrow\) Pivot \(\rightarrow\) Pivot chart
(d) Insert \(\rightarrow\) Scatter
1.5.10 Goal seek in MS Excel

213. After selecting the cells to be subjected to data validation, choose ________ from the menu to apply goal seek in MS Excel.
   (a) Data— >Filter
   (b) Data— >What if analysis— >Data table
   (c) Data— >What if analysis— >Goal seek
   (d) Data— >What if analysis— >Pivot table

214. In MS Excel, adjusting an input value to get specific result is called _____________.
   (a) goal seek (b) charting (c) sorting (d) validation

215. In MS Excel, after choosing Data— >What if analysis— >Goal seek from the menu, a dialog appears to take ____________ values.
   (a) desired result
   (b) input cell in which values are to be changed
   (c) both a & b
   (d) none of them

1.5.11 Scenarios in MS Excel

216. After selecting the cells to be subjected to data validation, choose ________ from the menu to apply scenario in MS Excel.
   (a) Data— >Filter
   (b) Data— >What if analysis— >Data table
   (c) Data— >What if analysis— >Goal seek
   (d) Data— >What if analysis— >Scenario

217. In MS Excel, creating resulting conditions based on several uncertain future conditions is called _____________.
   (a) validation (b) scenario (c) goal seek (d) charting

218. Each scenario created using MS Excel may contain _____________.
   (a) a title
   (b) a selection of cells which are affected by that scenario
   (c) both a & b
   (d) none of them

219. After creating several scenario representing future conditions, resulting conditions may be displayed by choosing _____________.
   (a) appropriate scenario from the scenarios box
   (b) charting
   (c) validation
   (d) sorting

Answers (939 - 1157)

1. (a) 2. (b) 3. (d) 4. (b)
5. (d) 6. (d) 7. (a) 8. (b)
9. (c) 10. (c) 11. (b) 12. (a)
13. (b) 14. (b) 15. (a) 16. (c)
17. (d) 18. (a) 19. (b) 20. (c)
21. (c) 22. (a) 23. (b) 24. (c)
25. (d) 26. (a) 27. (b) 28. (c)
29. (a) 30. (b) 31. (a) 32. (c)
33. (b) 34. (a) 35. (c) 36. (d)
37. (a) 38. (b) 39. (c) 40. (d)
41. (a) 42. (b) 43. (c) 44. (d)
45. (d) 46. (a) 47. (a) 48. (d)
49. (b) 50. (c) 51. (a) 52. (b)
53. (c) 54. (d) 55. (a) 56. (b)
57. (c) 58. (d) 59. (a) 60. (b)
61. (c) 62. (d) 63. (a) 64. (b)
65. (c) 66. (d) 67. (a) 68. (b)
69. (c) 70. (a) 71. (b) 72. (c)
73. (d) 74. (a) 75. (b) 76. (c)
77. (d) 78. (a) 79. (b) 80. (c)
81. (d) 82. (a) 83. (d) 84. (a)
85. (d) 86. (b) 87. (c) 88. (a)
89. (b) 90. (c) 91. (d) 92. (a)
93. (b) 94. (a) 95. (b) 96. (c)
97. (d) 98. (a) 99. (d) 100. (b)
101. (a) 102. (c) 103. (a) 104. (b)
105. (c) 106. (d) 107. (a) 108. (c)
109. (d) 110. (a) 111. (b) 112. (c)
113. (d) 114. (a) 115. (b) 116. (c)
117. (d) 118. (a) 119. (b) 120. (c)
121. (d) 122. (a) 123. (b) 124. (c)
125. (d) 126. (a) 127. (c) 128. (a)
129. (b) 130. (d) 131. (d) 132. (b)
133. (a) 134. (c) 135. (d) 136. (a)
137. (b) 138. (d) 139. (c) 140. (a)
141. (b) 142. (a) 143. (c) 144. (d)
145. (a) 146. (d) 147. (b) 148. (d)
149. (d) 150. (c) 151. (a) 152. (d)
153. (c) 154. (b) 155. (a) 156. (b)
157. (c) 158. (d) 159. (b) 160. (d)
161. (a) 162. (b) 163. (c) 164. (c)
165. (d) 166. (c) 167. (d) 168. (a)
169. (b) 170. (d) 171. (d) 172. (a)
173. (b) 174. (c) 175. (b) 176. (c)
177. (a) 178. (d) 179. (b) 180. (c)
181. (d) 182. (b) 183. (b) 184. (a)
185. (d) 186. (d) 187. (a) 188. (a)
189. (b) 190. (c) 191. (d) 192. (c)
193. (a) 194. (d) 195. (a) 196. (a)
197. (d) 198. (a) 199. (a) 200. (c)
201. (b) 202. (d) 203. (d) 204. (c)

Prepared by: Dr.V.Nagaradgane
1.6 Powerpoint

1.6.1 Introduction to PowerPoint

1. The MS office tool used for preparation of presentations is called __________.
(a) MS Word  
(b) MS Excel  
(c) MS Access  
(d) MS Powerpoint

2. The command to invoke power point from command line is __________.
(a) powerpnt  
(b) power  
(c) point  
(d) msppt

3. The default extension for a presentation prepared in powerpoint contained in MS Office version 2007 or later is __________.
(a) .accdb  
(b) .pptx  
(c) .xlsx  
(d) .docx

4. The default extension for a presentation prepared in powerpoint contained in MS Office version 2003 or earlier is __________.
(a) .doc  
(b) .xls  
(c) .ppt  
(d) .mdb

5. Powerpoint is suitable for creating __________ presentations.
(a) business  
(b) educational  
(c) strategic (military)  
(d) all of them

6. Powerpoint may be started using __________.
(a) Start— >All Apps— >Microsoft Office— >Microsoft Powerpoint  
(b) Pressing Windows+R, typing "powerpnt" and pressing enter  
(c) both a & b  
(d) none of them

1.6.2 Advantages of Powerpoint

7. Delivering an information through Powerpoint helps __________.
(a) to keep the attention of audience  
(b) to create a collaborative environment  
(c) permits the speaker to maintain the flow of information  
(d) all of them

8. Creating a presentation in Powerpoint helps to share the information with those who __________.
(a) who could attend  
(b) who could not attend  
(c) who become interested to know the information after completion of  
(d) all of them

9. Powerpoint helps to create a mix of __________ to make the presentation lively and interesting.
(a) audio/video  
(b) text/ table/ lists  
(c) images/ graphs  
(d) all of them

10. Powerpoint presentation may be exported to __________.
(a) Portable Document Format (PDF)  
(b) Video file (through File— >Save & send)  
(c) both a & b  
(d) none of them

11. Powerpoint can help to deliver content over __________.
(a) web  
(b) email  
(c) social media  
(d) all of them

1.6.3 Creating Slide Shows

12. New presentation in power point can be created using __________.
(a) File— >New  
(b) Ctrl + N  
(c) both a & b  
(d) none of them

13. On choosing File— >New, __________ can be chosen to start the presentation.
(a) Blank Presentation  
(b) Themes  
(c) either a or b  
(d) none of them

14. In Powerpoint, slide styles may be chosen from __________ menu.
(a) Design— >Themes  
(b) Home— >Font  
(c) Home— >Slides  
(d) Home— >Paragraph

15. In Powerpoint, font for presentation may be chosen from __________ menu.
(a) Design— >Themes  
(b) Home— >Font  
(c) Home— >Slides  
(d) Home— >Paragraph

16. In Powerpoint, new slide, slide layout, slide reset and slide sectioning may be chosen from __________ menu.
(a) Design— >Themes  
(b) Home— >Font  
(c) Home— >Slides  
(d) Home— >Paragraph

Prepared by: Dr.V.Nagaradjane
17. In Powerpoint, paragraph style for presentation may be chosen from __________ menu.
   (a) Home—>Drawing
   (b) Home—>Font
   (c) Home—>Slides
   (d) Home—>Paragraph

18. In Powerpoint, drawing for use in the presentation may be created using __________ menu.
   (a) Home—>Drawing
   (b) Home—>Font
   (c) Home—>Slides
   (d) Home—>Paragraph

19. In Powerpoint, drawing for use in the presentation may be created using __________ menu.
   (a) Home—>Drawing
   (b) Home—>Font
   (c) Home—>Slides
   (d) Home—>Paragraph

20. In Powerpoint, table can be inserted using __________ menu.
    (a) Insert—>Tables
    (b) Insert—>Images
    (c) Insert—>Illustrations
    (d) Insert—>Links

21. In Powerpoint, images like picture from file, clipart and photo albums can be inserted using __________ menu.
    (a) Insert—>Tables
    (b) Insert—>Images
    (c) Insert—>Illustrations
    (d) Insert—>Links

22. In Powerpoint, geometric shapes, hyperlink and action link can be inserted using __________ menu.
    (a) Insert—>Tables
    (b) Insert—>Images
    (c) Insert—>Illustrations
    (d) Insert—>Links

23. In Powerpoint, geometric shapes, smart art and chart can be inserted using __________ menu.
    (a) Insert—>Tables
    (b) Insert—>Images
    (c) Insert—>Illustrations
    (d) Insert—>Links

24. In Powerpoint, textbox, header & footer, word art, date & time, slide number and text objects from other applications can be inserted using __________ menu.
    (a) Insert—>Tables

25. In Powerpoint, equations and mathematical symbols can be inserted using __________ menu.
    (a) Insert—>Tables
    (b) Insert—>Text
    (c) Insert—>Symbol
    (d) Insert—>Media

26. In Powerpoint, media objects like video and audio can be inserted using __________ menu.
    (a) Insert—>Tables
    (b) Insert—>Text
    (c) Insert—>Symbol
    (d) Insert—>Media

1.6.4 Fine tuning the presentation

27. In Powerpoint, page setup and slide orientation may be controlled using __________ menu.
    (a) Design—>Page Setup
    (b) Design—>Themes
    (c) Insert—>Colors
    (d) Insert—>Fonts

28. In Powerpoint, slide transition effects may be controlled using __________ menu.
    (a) Design—>Effects
    (b) Design—>Themes
    (c) Insert—>Colors
    (d) Insert—>Fonts

29. In Powerpoint, slide theme can be controlled using __________ menu.
    (a) Design—>Background
    (b) Design—>Themes
    (c) Insert—>Colors
    (d) Insert—>Fonts

30. In Powerpoint, color themes (background, foreground, title color, etc.) can be controlled using __________ menu.
    (a) Design—>Background
    (b) Design—>Themes
    (c) Insert—>Colors
    (d) Insert—>Fonts

31. In Powerpoint, fonts can be chosen using __________ menu.
    (a) Design—>Background
    (b) Design—>Themes
    (c) Insert—>Colors
32. In Powerpoint, background fill colour, hide background graphics using ________ menu.
   (a) Design → Background
   (b) Design → Themes
   (c) Insert → Colors
   (d) Insert → Fonts

33. In Powerpoint, presentation preview can be started using ________ menu.
   (a) Transition → Preview
   (b) Transition → Transition to this slide
   (c) Timing
   (d) none of them

34. In Powerpoint, slide transition effects can be applied using ________ menu.
   (a) Transition → Preview
   (b) Transition → Transition to this slide
   (c) Timing
   (d) none of them

35. In Powerpoint, sound effects for slide transition, automatic-transition time, etc. can be applied using ________ menu.
   (a) Transition → Preview
   (b) Transition → Transition to this slide
   (c) Timing
   (d) none of them

36. In Powerpoint, animated flow of text and images in presentation can be applied using ________ menu.
   (a) Animations → Advanced Animation
   (b) Animations → Preview
   (c) Animation → Timing
   (d) none of them

37. In Powerpoint, slide animation preview can be opened using ________ menu.
   (a) Animations → Advanced Animation
   (b) Animations → Preview
   (c) Animation → Timing
   (d) none of them

38. In Powerpoint, animation timings can be controlled using ________ menu.
   (a) Animations → Advanced Animation
   (b) Animations → Preview
   (c) Animation → Timing
   (d) none of them

39. In Powerpoint, slide shows from beginning, slide show from current slide and custom slide show can be started using ________ menu.
   (a) Slide show → Start slide show
   (b) Slide show → Set up
   (c) Slide show → Monitors
   (d) none of them

40. In Powerpoint, slide shows can be setup, slide can be hidden, timing can be rehearsed and slide transition times can be recorded using ________ menu.
   (a) Slide show → Start slide show
   (b) Slide show → Set up
   (c) Slide show → Monitors
   (d) none of them

41. In Powerpoint, proofing, language, comments and comparison of 2 slide shows can be accomplished using ________ menu.
   (a) Review
   (b) View
   (c) Slide show
   (d) Animations

42. In Powerpoint, presentation views, master views, ruler, grlines, guides, zoom, fit to window, color, grayscale, black and white, new window, arrange all, cascade, move split, switch windows and macros can be accessed using ________ menu.
   (a) Review
   (b) View
   (c) Slide show
   (d) Animations

1.6.5 Good presentation techniques

43. To make effective presentation, minimize text and maximize ________.
   (a) images
   (b) graphs
   (c) videos
   (d) all of them

44. To make an effective impact, a presentation should be ________.
   (a) very long, running to 2 or 3 hours
   (b) short and sweet
   (c) unorganized, mixing head and tail at one place
   (d) blank from first to last slide

45. To make an effective impact, a presentation should be ________.
   (a) very long, running to 2 or 3 hours
   (b) short and sweet
   (c) unorganized, mixing head and tail at one place
   (d) blank from first to last slide

46. Optimum duration for making a presentation is ________.
   (a) 7 hours
   (b) 3 to 4 hours
   (c) 1 minute
   (d) 22 to 35 minutes

47. In presentation, the rule of 3 means, ________.
   (a) people forget the first 3 items

Prepared by: Dr.V.Nagaradjane
(b) people forget the last 3 items
(c) people remember the best 3 items
(d) people remember the worst 3 items

48. After preparing a presentation, it should  _________ to make it effective.
    (a) be kept in a pen drive or CD till delivery
    (b) never be opened till delivery
    (c) be opened just for delivery
    (d) be rehearsed many times

49. To make an effective presentation, one should  _________ the text typed in the
    slides.
    (a) simply keep reading
    (b) add spice to the text through stories and fables
    (c) keep reading (whether the audience listens or not)
    (d) none of them

50. One should record the presentation in _________ and watch it again to find the
    mistakes done during delivery.
    (a) paper
    (b) video
    (c) text
    (d) transcript

51. To make an effective presentation, one should _________.
    (a) forget what is on the current slide
    (b) forget what is on the next slide
    (c) remember offer a lead to the next slide
    (d) never care for the order of slides

52. One should have _________ to cater to the unexpected situations of projector
    failure, power failure, computer failure, disk error, etc.
    (a) a backup plan for alternate delivery (like through paper handouts)
    (b) a style to say sorry
    (c) a practice to weep in front of the audience over the failure
    (d) guts to say good bye without making the presentation

53. Before making a presentation, the presenter should _________.
    (a) arrive at the room early
    (b) verify the presentation loaded on the projector
    (c) choose the best place to stand during the presentation
    (d) all of them

Answers (1158 - 1210)
1.7 OpenOffice

1.7.1 Introduction to Open Office

1. The suit of free software offered by Apache foundation for document preparation, spreadsheet, presentation, drawing and database management is called
   (a) OpenOffice.org
   (b) Microsoft Office
   (c) Star Office
   (d) KOffice

2. OpenOffice.org text document file has extension of _________.
   (a) .odt   (b) .ods
   (c) .odg   (d) .odp

3. OpenOffice.org text spreadsheet file has extension of _________.
   (a) .odt   (b) .ods
   (c) .odg   (d) .odp

4. OpenOffice.org drawing file has extension of _________.
   (a) .odt   (b) .ods
   (c) .odg   (d) .odp

5. OpenOffice.org presentation file has extension of _________.
   (a) .odt   (b) .ods
   (c) .odg   (d) .odp

6. In OpenOffice.org, text document can be prepared using _________.
   (a) writer   (b) calc
   (c) draw     (d) impress

7. In OpenOffice.org, spreadsheet can be prepared using _________.
   (a) writer   (b) calc
   (c) draw     (d) impress

8. In OpenOffice.org, presentation can be prepared using _________.
   (a) writer   (b) calc
   (c) draw     (d) impress

9. In OpenOffice.org, drawing can be prepared using _________.
   (a) writer   (b) calc
   (c) draw     (d) impress

11. In OpenOffice.org, presentation can be prepared using _________. application.
   (a) writer   (b) calc
   (c) draw     (d) impress

1.7.2 Image properties

12. ________ are the important properties of images.
    (a) Colour   (b) Width
    (c) Height   (d) all of them

13. An image is made of small dots called _________.
    (a) pixel     (b) dot
    (c) point     (d) line

14. Each pixel possess the properties of _________.
    (a) Colour
    (b) Transparency (alpha)
    (c) both a & b
    (d) none of them

15. Normally, color coding in images is represented in _________. system.
    (a) Red Green Blue Alpha (RGBA)
    (b) Cyan Magenta Yellow black (CMYK)
    (c) both a & b
    (d) neither a nor b

16. Any visible colour can be created using appropriate combination of _________.
    (a) Red
    (b) Green
    (c) Blue
    (d) all of them

17. Alpha value of 0 represents _________. colour.
    (a) opaque
    (b) transparent
    (c) semitransparent
    (d) none of them

18. Maximum alpha value represents _________. colour.
    (a) opaque
    (b) transparent
    (c) semitransparent
    (d) none of them

19. Alpha value between 0 and maxim represents _________. colour.
    (a) opaque
    (b) transparent
    (c) semitransparent
    (d) none of them
1.7.3 Image types

20. BMP in image format stands for
   (a) Binary Magnified Photo
   (b) Binary Machine Picture
   (c) Binary Machine Photo
   (d) BitMap

21. JPG or JPEG in image format stands for
   (a) Joint Photographic Experts Group
   (b) Joint Picture Experts Group
   (c) Joint Photographic Experts Graph
   (d) Joint Photographic Experts General

22. JPEG is a ______ compression format.
   (a) lossy
   (b) lossless
   (c) both a & b
   (d) neither a nor b

23. JPEG format is widely adopted for
   (a) digital photography
   (b) printing
   (c) image editing
   (d) all of them

24. JPEG 2000 is a new version of JPEG adopted in
   (a) video frame compression
   (b) audio compression
   (c) grayscale image compression
   (d) none of them

25. JPEG 2000 is a ______ compression format.
   (a) lossy
   (b) lossless
   (c) both a & b
   (d) neither a nor b

26. In digital imaging, GIF stands for
   (a) Graphics Interchange Frame
   (b) Graphics Interchange Format
   (c) Graphics Interlaced Format
   (d) Graphics Intersection Format

27. ______ file format supports simple animations in an image.
   (a) GIF
   (b) JPG
   (c) BMP
   (d) TIF

28. In digital imaging, TIFF stands for
   (a) Tagged Initial File Format
   (b) Tagged Image File Frame
   (c) Triggered Image File Format
   (d) Tagged Image File Format

29. In digital imaging, TIFF stands for
   (a) Tagged Initial File Format
   (b) Tagged Image File Frame
   (c) Triggered Image File Format
   (d) Tagged Image File Format

30. TIFF is more suitable for ______ than for digital photography.
   (a) digital printing
   (b) digital drawing
   (c) digital video
   (d) digital audio

31. PNG in digital imaging stands for ______.
   (a) Palate Network Graphics
   (b) Portable Network Graphics
   (c) Portable Number Graphics
   (d) Portable Network Grayscale

32. PNG supports ______ compression.
   (a) lossy
   (b) lossless
   (c) both a & b
   (d) neither a nor b

33. Google WebP is an image format which supports ______ compression.
   (a) lossy
   (b) lossless
   (c) both a & b
   (d) neither a nor b

34. Google WebP aims to supersede ______ as a file format for digital cameras.
   (a) JPG
   (b) PNG
   (c) GIF
   (d) TIFF

35. ICO is an image format containing one or more icons of ______ type.
   (a) BMP
   (b) PNG
   (c) both a & b
   (d) neither a nor b

36. CPT file extension stands for
   (a) Corel Picture Paint
   (b) Corel Photo Paint
   (c) Creative Photo Paint
   (d) Corel Photo Print

37. PSD file extension stands for
   (a) Photo Shop Drawing
   (b) Picture Shop Document
   (c) Photo Scan Document
   (d) Photo Shop Document
38. PSP file extension stands for
   (a) Paint Shop Pro
   (b) Paint Shop Photo
   (c) Paint Shop Picture
   (d) Paint Shop Print

39. XCF file extension stands for
   (a) eXtreme Computing Facility
   (b) eXtended Computing Facility
   (c) eXperimental Computing Facility
   (d) eXperimental Counting Facility

40. SVG in image format stands for
   (a) Scanned Vector Graphics
   (b) Scalable Vector Graphics
   (c) Scalable Vector Grayscale
   (d) Scalable Vintage Graphics

1.7.4 Editing of images

41. The process of enhancing image quality by rotation, extraction, colour transformation, partial relocation, morphing and conversion from/to colour image to grayscale, etc. are categorized as
   (a) image capture
   (b) image viewing
   (c) *image editing*
   (d) none of them

42. Adobe Photoshop, Corel Paint Shop Pro, GIMP, etc. belong to the category of *image editing* software.
   (a) image capture
   (b) image viewing
   (c) *image editing*
   (d) none of them

43. *GIMP* is a free and open source software for image editing.
   (a) Adobe Photoshop
   (b) Corel Paint Shop Pro
   (c) *GIMP*
   (d) none of them

44. GIMP toolbox can be opened using
   (a) Windows->Toolbox menu
   (b) Ctrl+B shortcut
   (c) both a & b
   (d) none of them

45. GIMP toolbox contains rectangle, ellipse, freehand, fuzzy tool, colour select, scissor selection tool, foreground select and path tools for
   (a) selecting portions of images
   (b) deleting images
   (c) creating images
   (d) drawing on images

46. In GIMP, color in one part of image may be picked for painting another part using
   (a) color picker
   (b) zoom
   (c) measure
   (d) move

47. In GIMP, image size may be enlarged or reduced using
   (a) color picker
   (b) zoom
   (c) measure
   (d) move

48. In GIMP, distances and angles can be measured using
   (a) color picker
   (b) zoom
   (c) measure
   (d) move

49. In GIMP, selected portions can be moved using
   (a) color picker
   (b) zoom
   (c) measure
   (d) move

50. In GIMP, selected portions can be moved using
   (a) color picker
   (b) zoom
   (c) measure
   (d) move

51. Edges of images can be removed using
   (a) crop tool
   (b) alignment tool
   (c) rotate tool
   (d) scale tool

52. Layers may be aligned using
   (a) crop tool
   (b) alignment tool
   (c) rotate tool
   (d) scale tool

53. Selected portions or layers may be rotated using
   (a) crop tool
   (b) alignment tool
   (c) rotate tool
   (d) scale tool

54. Selected portions or layers may be scaled using
   (a) crop tool
   (b) alignment tool
   (c) rotate tool
   (d) scale tool

55. Selected region or layer may be distorted using
   (a) shear
   (b) perspective
56. Selected region or layer converted to 3D appearance using _______ tool in GIMP.
   (a) shear
   (b) perspective
   (c) flip
   (d) ___________

57. Selected portions may be distorted inside a cage using _______ tool in GIMP.
   (a) shear
   (b) perspective
   (c) flip
   (d) ___________

58. Image may be flipped (horizontally or vertically) using _______ tool in GIMP.
   (a) shear
   (b) perspective
   (c) ___________
   (d) ___________

59. Text can be inserted into an image using _______ tool in GIMP.
   (a) text
   (b) bucket fill
   (c) blend
   (d) ___________

60. Filling can be done using _______ tool in GIMP.
    (a) text
    (b) ___________
    (c) blend
    (d) ___________

61. Colour difference between adjacent portions can be healed through proper gradient using _______ tool in GIMP.
    (a) text
    (b) bucket fill
    (c) blend
    (d) ___________

62. Pencil drawing can be done using _______ tool in GIMP.
    (a) text
    (b) bucket fill
    (c) blend
    (d) pencil

63. Simple painting can be done using _______ tools in GIMP.
    (a) brush/airbrush
    (b) eraser
    (c) ink
    (d) ___________

64. GIMP permits manipulation at _______ levels.
    (a) image
    (b) layer
    (c) color space
    (d) ___________

Answers (1211 - 1274)

1. (a) 2. (a) 3. (b) 4. (c) 5. (d) 6. (d) 7. (a) 8. (b) 9. (b) 10. (c) 11. (d) 12. (d) 13. (a) 14. (c) 15. (a) 16. (d) 17. (a) 18. (b) 19. (c) 20. (d) 21. (a) 22. (a) 23. (d) 24. (a) 25. (c) 26. (b) 27. (a) 28. (d) 29. (d) 30. (a) 31. (b) 32. (b) 33. (c) 34. (a) 35. (c) 36. (b) 37. (d) 38. (a) 39. (c) 40. (b) 41. (c) 42. (c) 43. (c) 44. (c) 45. (a) 46. (a) 47. (b) 48. (c) 49. (d) 50. (d) 51. (a) 52. (b) 53. (c) 54. (d) 55. (a) 56. (b) 57. (d) 58. (c) 59. (a) 60. (b) 61. (c) 62. (d) 63. (d) 64. (d)
1.8 Database Management Systems

1.8.1 Data, Information and Database

1. ___________ refers to collection, storage, manipulation, reporting and mining of available information.
   (a) Database management
   (b) Presentation
   (c) Charting
   (d) Document preparation

   (a) schemes
   (b) tables
   (c) queries/views
   (d) all of them

3. SQL stands for ___________.
   (a) Synchronized Query Language
   (b) Structured Query Language
   (c) Simplified Query Language
   (d) Structured Question Language

4. Creation and modification of databases and tables is called ___________.
   (a) update
   (b) retrieval
   (c) data definition
   (d) administration

5. Inserting data and modifying values in previously inserted data in tables of a database is called ___________.
   (a) data update
   (b) data retrieval
   (c) data definition
   (d) database administration

6. Querying and selecting data from a table is called ___________.
   (a) data update
   (b) data retrieval
   (c) data definition
   (d) database administration

7. Defining the users, passwords and roles for users to control a database is called ___________.
   (a) data update
   (b) data retrieval
   (c) data definition
   (d) database administration

8. Maintaining data in error free manner is called data ___________.

(a) integrity  (b) duplicity
(c) multiplicity  (d) atomicity

1.8.2 Overview of popular databases systems

9. DBMS stands for ___________.
   (a) Database Maintenance System
   (b) Database Management Syntax
   (c) Database Management System
   (d) Digital Management System

10. Oracle, IBM DB2, SAP HANA, MySQL, PostgreSQL, Microsoft SQL server, Sybase, MongoDB, MariaDB & SQLite are the most popular ___________ tools.
    (a) graphics & animation
    (b) image editing
    (c) document typesetting
    (d) database management

11. Oracle, IBM DB2, SAP HANA & Microsoft SQL server are ___________ database management tools.
    (a) professional (paid)
    (b) free/open source
    (c) outdated
    (d) unsuitable

12. MySQL, PostgreSQL, MariaDB & SQLite are ___________ database management tools.
    (a) professional (paid)
    (b) free/open source
    (c) outdated
    (d) unsuitable

13. Among the open source and free database management systems, ___________ is the most popular.
    (a) MySQL
    (b) PostgreSQL
    (c) MariaDB
    (d) SQLite

14. Among the professional (paid) database management systems, ___________ is the most popular.
    (a) IBM DB2
    (b) SAP HANA
    (c) Oracle
    (d) Microsoft SQL Server

15. ___________ is the most popular database management system in the embedded (mobile phones/tablets) category.
    (a) MySQL
    (b) SQLite
    (c) Oracle
    (d) PostgreSQL
16. RDBMS stands for ____________.
   (a) Relational Digital Base Management System
   (b) Restricted Data Base Management System
   (c) Relational Data Base Management System
   (d) Relational Data Binary Management System

17. Relational database model was proposed by ____________.
   (a) Bill Gates
   (b) Steve Jobs
   (c) Dennis Ritchie
   (d) Edgar F Codd

18. A database management system requires to fulfill ____________ to be called a relational database system.
   (a) Codd’s 12 Rules
   (b) 10 commandments of Moses
   (c) 3 laws of Isac Newton
   (d) 2 laws of Kirchoff

19. Codd’s Rule 0 defines a relational database system as the one which manages data through ____________ capabilities.
   (a) hierarchical database
   (b) network database
   (c) relational database
   (d) none of them

20. Codd’s Rule 1 is otherwise called ____________ rule and specifies that all information should be held in tables.
    (a) information
    (b) access
    (c) null value
    (d) database description

21. Codd’s Rule 2 is otherwise called ____________ rule and it guarantees that each and every information stored in a database is accessible.
    (a) information
    (b) access
    (c) null value
    (d) database description

22. Codd’s Rule 3 is otherwise called ____________ rule and it specifies that there should be unique NULL value to denote missing information.
    (a) information
    (b) access
    (c) null value
    (d) database description

23. Codd’s Rule 4 is otherwise called ____________ rule and it states that meta data should also be stored as normal data.
    (a) information
    (b) access
    (c) null value
    (d) database description

24. Codd’s Rule 5 is otherwise called ____________ rule and it permits commands for creating, managing, rolling back and authorizing data access.
    (a) data sublanguage
    (b) view updating
    (c) insert, update, delete
    (d) independence from physical storage

25. Codd’s Rule 6 is otherwise called ____________ rule and it specifies that every view which is theoretically updateable should be updateable through the system.
    (a) data sublanguage
    (b) view updating
    (c) insert, update, delete
    (d) independence from physical storage

26. Codd’s Rule 7 is otherwise called ____________ rule and it specifies that insertion, delete and update of data should also be based on relational principles.
    (a) data sublanguage
    (b) view updating
    (c) insert, update, delete
    (d) independence from physical storage

27. Codd’s Rule 8 is otherwise called ____________ rule and it specifies that the type of physical storage media should not affect the access methods of data through the database management system.
    (a) data sublanguage
    (b) view updating
    (c) insert, update, delete
    (d) independence from physical storage

28. Codd’s Rule 9 is otherwise called ____________ rule and application programs are unaffected by changes to the data unless it impairs the results of the application program.
    (a) logical data independence
    (b) integrity independence
    (c) distribution independence
    (d) non-subversion
29. Codd’s Rule 10 is otherwise called __________ rule and it specifies that data integrity conditions should be defined in the database management system and not in the application program.
(a) logical data independence
(b) integrity independence
(c) distribution independence
(d) non-subversion

30. Codd’s Rule 11 is otherwise called __________ rule and it specifies that the end user should feel that the data is stored at one place, although the storage may be distributed on several computers.
(a) logical data independence
(b) integrity independence
(c) distribution independence
(d) non-subversion

31. Codd’s Rule 12 is otherwise called __________ rule and it specifies that data access should be provided only through the relational model, without exposing the low level storage APIs to the end user.
(a) logical data independence
(b) integrity independence
(c) distribution independence
(d) non-subversion

32. API stands for ____________.
(a) Applied Programming Interface
(b) Application Programming Interface
(c) Application Programming Integration
(d) Application Provider Interface

OODB

33. Object oriented databases are based on the concept of ____________, similar to object oriented programming.
(a) SQL  (b) table  (c) objects  (d) column

34. Relational databases are _____________ oriented.
(a) method  (b) table  (c) objects  (d) program

35. OODB stands for ____________.
(a) Object Oriented Digital Base
(b) Offset Oriented Data Base
(c) Object Oriented Data Binary
(d) Object Oriented Data Base

36. OODB is more accessible from ____________.
(a) SQL  (b) Object Oriented Programming Languages like C++, Java, Smalltalk, Delphi, etc.
(c) pen drive  (d) wired connection

37. OODB with support for SQL (like relational database) is called ____________.
(a) hybrid object relational database
(b) programming
(c) pure relational database
(d) NOSQL database

38. Objects of OODB may be accessed using ____________.
(a) NOSQL
(b) SQL
(c) Object Query Language (OQL)
(d) none of them

39. Object schema in OODB use data types ____________ to object oriented programming languages.
(a) unrelated
(b) unconnected
(c) similar
(d) not connected

40. ODMG stands for ____________, which is the consortium in charge of the standardizing the development of Object Oriented Data Base.
(a) Object Data Management General
(b) Object Data Management Group
(c) Object Digital Management Group
(d) Object Data Maintenance Group

41. OMG in object oriented database stands for ____________.
(a) Object Maintenance Group
(b) Oh My God
(c) Object Management Group
(d) Object Management Gimmick

42. XQuery is ____________ language.
(a) XML based Query
(b) Structured Query
(c) programming
(d) object oriented programming

43. Object Oriented Data Base is suitable for cases in which relational tables are ____________ to design and manipulate.
(a) too complex  (b) too easy
(c) too simple  (d) too plain

44. ORM in database management stands for ____________.
(a) Object Reverse Mapping
(b) Offset Relational Mapping
(c) Object Relational Mapping
(d) Object Restricted Mapping

Prepared by: Dr.V.Nagaradjane
NOSQL

45. The system of managing databases using models other than tables and retrieving data using methods other than or related to SQL is called __________ data management system.
   (a) relational database
   (b) table oriented
   (c) Query oriented
   (d) NOSQL

46. NOSQL is suitable for social media sites because it __________.
   (a) permits fast queries
   (b) permits ad-hoc joins
   (c) compromises data integrity rules in favour of speed
   (d) all of them

47. NOSQL databases permit updates which __________ and are prone to data loss.
   (a) may be incomplete
   (b) are complete
   (c) which are immediately effected
   (d) which are subject to strict rules of integrity

1.8.3 Rules for designing good tables

48. A good database table has __________ naming.
   (a) inconsistent
   (b) consistent
   (c) unrelated
   (d) haphazard

49. The name of table and column should be in __________.
   (a) plural
   (b) vernacular
   (c) incoherent words
   (d) singular

50. In a well defined database, names of database, table and column __________ contain space.
   (a) do
   (b) may
   (c) should not
   (d) should

51. If the name of database, table or column should have separation, use __________ instead of the space character.
   (a) &
   (b) _
   (c) @
   (d) $

52. As a good practice in the design of database tables, passwords should be stored in __________ format.
   (a) numeric
   (b) random
   (c) plain text
   (d) encrypted

53. As a good practice in design of database tables, it is advisable to have __________ for indexing.

(a) Integer ID column
(b) no column
(c) all columns
(d) none of them

54. As a good practice, each user should have __________ user id and password.
   (a) same
   (b) different
   (c) root
   (d) admin

55. As a good practice, select queries should have contain __________ column names.
   (a) * for
   (b) blank for
   (c) required field names
   (d) none of them

56. In defining a database table, it is a good practice to define frequently searched columns with __________.
   (a) primary key
   (b) foreign key
   (c) either a or b
   (d) neither a nor b

57. When a column value cannot be null, it is a good practice to include __________ declaration for that column when creating the table.
   (a) DEFAULT 0
   (b) DEFAULT < SOME VALUE >
   (c) NULL
   (d) NOT NULL

58. When a column value should be filled with a default of 0 or any other value, it is a good practice to include __________ declaration for that column when creating the table.
   (a) DEFAULT 0
   (b) DEFAULT < SOME VALUE >
   (c) either a or b
   (d) NOT NULL

59. For mission critical databases, __________ should be created to avoid data loss.
   (a) backup
   (b) program
   (c) SQL
   (d) table

60. The process of dividing the data in suitable tables to avoid repetition of data is called __________.
   (a) normalization
   (b) data insertion
   (c) data deletion
   (d) data updation
1.8.4 Integrity rules and constraints in a table

61. The database rule which permits inserting a row without any specific value for a column is called ________________.
(a) null rule
(b) unique column rule
(c) primary key rule
(d) referential integrity rule

62. ________________ in database management permits inserting a new value only if there is no previous entry having the same value.
(a) null rule
(b) unique column rule
(c) primary key rule
(d) referential integrity rule

63. ________________ in database management permits unique values to be used for searching and indexing of data.
(a) null rule
(b) unique column rule
(c) primary key rule
(d) referential integrity rule

64. ________________ in database management ensures that key values in one table are referenced in a related table.
(a) null rule
(b) unique column rule
(c) primary key rule
(d) referential integrity rule

65. ________________ in database management ensures that user defined constraints are enforced to restrict deletion or updating of rows.
(a) Complex integrity checking rule
(b) unique column rule
(c) primary key rule
(d) referential integrity rule

66. ________________ rule in data reference integrity ensures that referred data is not deleted or updated.
(a) restrict
(b) set to null
(c) set to default
(d) cascade

68. ________________ rule in data reference integrity ensures that whenever data is deleted, all dependencies are set to their default value.
(a) restrict
(b) set to null
(c) set to default
(d) cascade

69. ________________ rule in data reference integrity ensures that whenever data is updated or deleted, all dependency rows are correspondingly updated or deleted.
(a) restrict
(b) set to null
(c) set to default
(d) cascade

70. ________________ rule in data reference integrity ensures that whenever data is updated or deleted, all dependency rows are correspondingly updated or deleted.
(a) restrict
(b) set to null
(c) set to default
(d) cascade

71. ________________ rule in data reference integrity ensures that no action is taken when attempt is made to delete or update referenced data.
(a) No action
(b) Set to null
(c) Set to default
(d) Cascade

72. The practice of specifying only specified values are entered in particular column (like NOT NULL, DEFAULT 0) is called ________________.
(a) integrity rule
(b) integrity constraint
(c) updation rule
(d) relational rule

1.8.5 Relationships in tables

73. Creating relationship for data in one table with that in another table in database is called ________________.
(a) integrity
(b) constraint
(c) relationship
(d) none of them

74. ________________ is used to relate data in one table to that in another table.
(a) key
(b) column
(c) row
(d) table
75. A key which is unique to a table is called ______________.
   (a) primary key  (b) foreign key
   (c) unique        (d) none of them

76. A key which helps to connect data in one secondary table to that in a primary table is called ______________.
   (a) primary key  (b) foreign key
   (c) unique        (d) none of them

77. A key which helps to connect data in one secondary table to that in a primary table is called ______________.
   (a) primary key  (b) foreign key
   (c) alternate key or candidate key (d) none of them

78. A key which can be used as a prospective primary key (in the future) is called ______________.
   (a) primary key  (b) foreign key
   (c) alternate key or candidate key (d) none of them

79. A key which can be used as a prospective primary key (in the future) is called ______________.
   (a) primary key  (b) foreign key
   (c) alternate key or candidate key (d) none of them

80. SQL stands for ______________.
   (a) Structured Query Language (b) Standard Query Language
   (c) Synchronized Query Language (d) Structured Question Language

81. A query which creates database, table, inserts rows, deletes rows & updates existing values is called ______________.
   (a) update query (b) select query
   (c) both a & b (d) neither a nor b

82. A query which selects values based from a table is called ______________.
   (a) update query (b) select query
   (c) both a & b (d) neither a nor b

83. A query which selects values from a table is called ______________.

1.8.6 Introduction to various types of Queries and their uses

80. SQL stands for ______________.
   (a) Structured Query Language (b) Standard Query Language
   (c) Synchronized Query Language (d) Structured Question Language

81. A query which creates database, table, inserts rows, deletes rows & updates existing values is called ______________.
   (a) update query (b) select query
   (c) both a & b (d) neither a nor b

82. A query which selects values based from a table is called ______________.
   (a) update query (b) select query
   (c) both a & b (d) neither a nor b

83. A query which selects values from a table is called ______________.

(a) update query (b) select query
   (c) both a & b (d) neither a nor b

84. The clause which specifies constraints for selecting or updating data is called ______________ clause.
   (a) GROUP BY     (b) HAVING
   (c) ORDER BY     (d) WHERE

85. The clause which specifies rule for data aggregation is called ______________ clause.
   (a) GROUP BY     (b) HAVING
   (c) ORDER BY     (d) WHERE

86. The clause which specifies rule for selecting data needed for aggregation is called ______________ clause.
   (a) GROUP BY     (b) HAVING
   (c) ORDER BY     (d) WHERE

87. The clause which specifies the rule for sorting of data is called ______________ clause.
   (a) GROUP BY     (b) HAVING
   (c) ORDER BY     (d) WHERE

88. The clause which specifies that data should be sorted in descending order is called ______________ clause.
   (a) DESC         (b) HAVING
   (c) ORDER BY     (d) WHERE

89. Which of the following queries creates a table named contact with name and mobile columns?
   (a) create table contact (name varchar(30), mobile varchar(20), primary key(name));
   (b) insert into contact values(‘Desiga’,’329842893’);
   (c) update contact set mobile=’322312112’ where name=’Desiga’;
   (d) select * from contact;

90. Which of the following queries selects all records from a table named contact?
   (a) create table contact (name varchar(30), mobile varchar(20), primary key(name));
   (b) insert into contact values(‘Desiga’,’329842893’);
   (c) update contact set mobile=’322312112’ where name=’Desiga’;
   (d) select * from contact;

91. Which of the following queries sets a new mobile number (322312112) for a person named Desiga in the contact table?
   (a) create table contact (name varchar(30), mobile varchar(20), primary key(name));
   (b) insert into contact values(‘Desiga’,’329842893’);
   (c) update contact set mobile=’322312112’ where name=’Desiga’;
   (d) select * from contact;
(c) update contact set mobile='322312112' where name='Desiga';
(d) select * from contact;

92. Which of the following queries inserts a new record in a table named contact?
(a) create table contact (name varchar(30), mobile varchar(20), primary key(name));
(b) insert into contact values('Desiga','329842893');
(c) update contact set mobile='322312112' where name='Desiga';
(d) select * from contact;

93. The following query creates column named name, with a data type ________.
create table contact (name varchar(30), mobile varchar(20), primary key(name));
(a) varchar (b) int (c) double (d) blob

94. The following query creates column named name, having varchar type with maximum length of ________ characters.
create table contact (name varchar(30), mobile varchar(20), primary key(name));
(a) 10 (b) 20 (c) 30 (d) 40

95. The following query creates column named mobile, having varchar type with maximum length of ________ characters.
create table contact (name varchar(30), mobile varchar(20), primary key(name));
(a) 10 (b) 20 (c) 30 (d) 40

96. The following query designates ________ as primary key.
create table contact (name varchar(30), mobile varchar(20), primary key(name));
(a) name (b) mobile (c) contact (d) primary key

97. Adding ________ keyword to an integer field permits automatic increment to the record number.
(a) primary key (b) key (c) auto_increment (d) automatic

98. The following query inserts ________ in the mobile column.
insert into contact (name, mobile) values ('Nathiya', '2332323423');
(a) 2332323423 (b) 3423424223 (c) 33423423242 (d) 2342342323

99. The following query inserts ________ in the name column.
insert into contact (name, mobile) values ('Nathiya', '2332323423');
(a) values (b) contact (c) name (d) Nathiya

100. The following query updates the mobile column to new value if the name is ________.
update contact set mobile='453453445343' where name='Girija';
(a) name (b) Girija (c) mobile (d) contact

101. The following query updates the mobile to ________ where the name is Girija.
update contact set mobile='453453445343' where name='Girija';
(a) 453453445343 (b) 433543534535 (c) 56454646544 (d) 2342432423

102. The following query deletes a row if the name is ________.
delete from contact where name='Gayathri';
(a) contact (b) name (c) Gayathri (d) delete

103. The following query ________ a table named contact.
drop table contact;
(a) deletes (b) creates (c) updates (d) adds new column to

104. The following query selects data in ________ order.
select * from contact order by name DESC;
(a) ascending (b) descending (c) unordered (d) none of them

1.8.7 Designing Access Reports and Forms

105. Microsoft Access provides visual environment for design of ________.
(a) tables       (b) reports  
(c) forms        (d) all of them

106. MS Access creates files are stored with ___________ extension.
    (a) .docx     (b) .xlsx
    (c) .accdb     (d) .pptx

107. New database created in MS Access has got a default table named _____________.
    (a) Table1    (b) Database1
    (c) Column1    (d) Row1

108. By default, new table is displayed in _____________ view.
    (a) Datasheet View       (b) Design View
    (c) Report View          (d) Form View

109. __________ is an alternate to datasheet view for design of table in MS Access.
    (a) Datasheet View       (b) Design View
    (c) Report View          (d) Form View

110. __________ can be created to help easy data entry in MS Access tables.
    (a) Form       (b) Report
    (c) database    (d) spreadsheet

111. __________ view permits selection of datatypes, default values and constraints for each column.
    (a) Datasheet    (b) Design
    (c) Report       (d) Form

112. By default, first column of an MS Access table is named __________ and it has auto increment property.
    (a) NAME       (b) DATE
    (c) NULL       (d) ID

113. An ordinary form for data entry in MS Access tables may be created using ___________ menu.
    (a) Create—>Form
    (b) Create—>Split Form
    (c) Create—>Multiple Items
    (d) Create—>Blank Form

114. In MS Access, a form with data records at one half and entry format at the other half may be created using ___________ menu.
    (a) Create—>Form
    (b) Create—>Split Form
    (c) Create—>Multiple Items
    (d) Create—>Blank Form

115. In MS Access, multiple rows of data may be created using ___________ menu.
    (a) Create—>Form
    (b) Create—>Split Form
    (c) Create—>Multiple Items
    (d) Create—>Blank Form

116. In MS Access, blank form may be created using ___________ menu.
    (a) Create—>Form
    (b) Create—>Split Form
    (c) Create—>Multiple Items
    (d) Create—>Blank Form

117. In MS Access, form may be created through a wizard using ___________ menu.
    (a) Create—>More Forms—>Form Wizard
    (b) Create—>More Forms—>Data Sheet
    (c) Create—>More Forms—>Modal Dialog
    (d) Create—>Blank Form

118. In MS Access, data sheet may be created using ___________ menu.
    (a) Create—>More Forms—>Form Wizard
    (b) Create—>More Forms—>Data Sheet
    (c) Create—>More Forms—>Modal Dialog
    (d) Create—>Blank Form

119. In MS Access, form dialog may be created using ___________ menu.
    (a) Create—>More Forms—>Form Wizard
    (b) Create—>More Forms—>Data Sheet
    (c) Create—>More Forms—>Modal Dialog
    (d) Create—>Blank Form

120. In MS Access, form may be manually designed through available components (like textfield, datapicker, combo-box, etc.) using ___________ menu.
    (a) Create—>More Forms—>Form Wizard
    (b) Create—>More Forms—>Data Sheet
    (c) Create—>More Forms—>Modal Dialog
    (d) Create—>Blank Form

121. In MS Access, default report may be created using ___________ menu.
    (a) Create—>Report
    (b) Create—>Blank Report
    (c) Create—>Report Wizard
    (d) Create—>Report Design

122. In MS Access, blank report may be created using ___________ menu.
    (a) Create—>Report
    (b) Create—>Blank Report
    (c) Create—>Report Wizard
    (d) Create—>Report Design

123. In MS Access, report may be created through wizard using ___________ menu.
    (a) Create—>Report
    (b) Create—>Blank Report
124. In MS Access, report may be designed using components like combobox, text field, text area, list, etc. using ________ menu.
(a) Create—>Report
(b) Create—>Blank Report
(c) Create—>Report Wizard
(d) Create—>Report Design

1.8.8 Macros in MS Access

125. In MS Access, macro may be recorded to carry out different actions using ________ menu.
(a) Create—>Report
(b) Create—>Blank Report
(c) Create—>Report Wizard
(d) Create—>Macro

126. In MS Access, a macro can be activated by pressing, ________ button.
(a) Form  (b) Report
(c) Run    (d) Table

127. In MS Access, macros can automate ________
(a) program flow/ data entry
(b) data import/ data export
(c) filter/ query/ search
(d) all of them

Answers (1275 - 1401)

1. (a)  2. (d)  3. (b)  4. (c)
5. (a)  6. (b)  7. (d)  8. (a)
9. (c)  10. (d) 11. (a) 12. (b)
13. (a) 14. (c) 15. (b) 16. (c)
17. (d) 18. (a) 19. (c) 20. (a)
21. (b) 22. (c) 23. (d) 24. (a)
25. (b) 26. (c) 27. (d) 28. (a)
29. (b) 30. (c) 31. (d) 32. (b)
33. (c) 34. (b) 35. (d) 36. (b)
37. (a) 38. (c) 39. (c) 40. (b)
41. (c) 42. (a) 43. (a) 44. (c)
45. (d) 46. (d) 47. (a) 48. (b)
49. (d) 50. (c) 51. (b) 52. (d)
53. (a) 54. (b) 55. (c) 56. (c)
57. (d) 58. (c) 59. (a) 60. (a)
61. (a) 62. (b) 63. (c) 64. (d)
65. (a) 66. (a) 67. (b) 68. (c)
69. (d) 70. (d) 71. (a) 72. (b)
73. (c) 74. (a) 75. (a) 76. (b)
77. (b) 78. (c) 79. (c) 80. (a)
81. (a) 82. (b) 83. (b) 84. (d)
85. (a) 86. (b) 87. (c) 88. (a)
89. (a) 90. (d) 91. (c) 92. (b)
93. (c) 94. (c) 95. (b) 96. (a)
97. (c) 98. (a) 99. (d) 100. (b)
101. (a) 102. (c) 103. (a) 104. (b)
105. (d) 106. (c) 107. (a) 108. (a)
109. (b) 110. (a) 111. (b) 112. (d)
113. (a) 114. (b) 115. (c) 116. (d)
117. (a) 118. (b) 119. (c) 120. (d)
121. (a) 122. (b) 123. (c) 124. (d)
125. (d) 126. (c) 127. (d)

Prepared by: Dr. V. Nagaradhane
1.9 Networking

1.9.1 Computer Networks, Necessity and Advantages

1. Connecting several computers and devices using wired or wireless technology is called ________.
   (a) hard disk  (b) RAM  
   (c) pen drive  (d) networking

2. Internet is constituted of __________.
   (a) network of networks  (b) hard disk 
   (c) DVD  (d) pen drive

3. Computers and devices can be connected using ________ technology to create a network.
   (a) wired  (b) wireless  
   (c) both a & b  (d) neither a nor b

4. The systematic design (like radial, ring, etc.) of connecting computers in a network is called network ________.
   (a) topology  (b) protocol 
   (c) firewall  (d) antivirus

5. The procedure used by computers connected in a network for data exchange is called network ________.
   (a) topology  (b) protocol  
   (c) firewall  (d) antivirus

6. The computer which separates a local network from external Internet is called network ________.
   (a) topology  (b) protocol 
   (c) firewall  (d) antivirus

7. The piece of software which prevents malicious software from entering a computer is called network ________.
   (a) topology  (b) protocol 
   (c) firewall  (d) antivirus

8. Most of the wired network connections use ________.
   (a) Optical Fibre Cable (OFC)  (b) USB cable 
   (c) pen drive  (d) hard drive

9. The port for connecting broadband cable to a computer is called ________.
   (a) ethernet port  (b) Registered Jack 45 (RJ-45) 
   (c) both a & b

10. Wireless network connections use __________ technologies.
    (a) Wireless Fidelity (WiFi)  (b) Bluetooth 
    (c) both a & b  (d) neither a nor b

11. __________ are the hardware devices that help the computer to connect to a network.
    (a) Routers  (b) MODEMs 
    (c) Wireless MODEMs  (d) all of them

12. MODEM stands for __________.
    (a) MODulation DEMocracy  (b) MODulation DEModulation 
    (c) MODern DEModulation  (d) MODerate DEModulation

13. Routers help in __________.
    (a) transmission of data between networks  (b) connecting different devices using appropriate protocol 
    (c) both a & b  (d) neither a nor b

1.9.2 Client Server and peer to Peer networking concepts

14. A network connection requires __________ important components to connect to each other.
    (a) IP address  (b) Port number  
    (c) both a & b  (d) none of them

15. IP address helps to __________ a computer connected to a network.
    (a) uniquely identify  (b) format 
    (c) reset  (d) reject

16. Port number on a computer host connected to a network denotes a ________.
    (a) background server program  (b) client program 
    (c) both a & b  (d) none of them

17. A program which runs in the background and sends results requested by a client is called a ________.
    (a) server  (b) client 
    (c) port  (d) IP address
18. A program which runs in the foreground, communicates with server and displays results sent by the server is called a ___________
   (a) server  (b) client  (c) port  (d) IP address

19. Computers connected to a network without any client or server system (all hosts are equally important) are in __________ network.
   (a) client server  (b) peer to peer  (c) firewall  (d) proxy server

1.9.3 Concept of Proxy Server and proxy firewall server

20. The intermediary host which communicates with the clients on behalf of another server is called __________.
   (a) proxy server  (b) firewall  (c) ethernet  (d) WiFi

21. The intermediary host which protects a network from any communication with prohibited hosts outside the protected network is called __________.
   (a) proxy server  (b) firewall  (c) ethernet  (d) WiFi

22. Firewall can __________.
   (a) deny access to specific sites  (b) allow access to only white listed sites  (c) both a & b  (d) none of them

23. A proxy server which simply forwards messages from one network to another network is called __________ proxy.
   (a) gateway/ tunneling  (b) forward proxy  (c) reverse proxy  (d) all of them

24. A proxy server which communicates with the Internet and retrieves data from the Internet is called __________ proxy.
   (a) gateway/ tunneling  (b) forward proxy  (c) reverse proxy  (d) all of them

25. A proxy server which communicates with the servers in a local network (for services like decryption, authentication, etc.) is called __________ proxy.
   (a) gateway/ tunneling

26. Firewall can be implemented through __________.
   (a) hardware  (b) software  (c) both a & b  (d) none of them

1.9.4 Network topologies

27. Each computer or device connected to a network is generally called __________.
   (a) node  (b) host  (c) both a & b  (d) neither a nor b

28. The design adopted for connecting several hosts on a network is called __________.
   (a) telephony  (b) wiring  (c) connection  (d) topology

29. When 2 devices are connected through a dedicated line, it is __________ topology.
   (a) point to point  (b) bus  (c) star  (d) ring

30. When all nodes are connected a common transmission line (backbone line with 2 or more end points), it is __________ topology.
   (a) point to point  (b) bus  (c) star  (d) ring

31. When all nodes are connected to a central hub, it is __________ topology.
   (a) point to point  (b) bus  (c) star  (d) ring

32. When all nodes are connected in a circular form (the first node becomes the last node), it is __________ topology.
   (a) point to point  (b) bus  (c) star  (d) ring

33. When each host has a dedicated line connected to any other host on the network, it is __________ topology.
   (a) fully connected  (b) Daisy chain

Prepared by: Dr. V. Nagaradjane
34. For fully connected topology, the number of connections \( c \) required for \( n \) hosts is 
(a) \( c = \frac{n(n-2)}{2} \)  
(b) \( c = \frac{n(n-1)}{4} \)  
(c) \( c = \frac{n(n-1)}{2} \)  
(d) \( c = \frac{n(n-1)(n-2)}{2} \)

35. When each host has a dedicated line connected to any other host on the network, it is ______ topology.
(a) fully connected  
(b) daisy chain  
(c) tree  
(d) partly connected

36. When computers are connected in chain (from one host to another) and data hops between hosts till it reaches the intended host, it is ______ topology.
(a) fully connected  
(b) daisy chain  
(c) tree  
(d) partly connected

37. When data travels in branching connections to reach intended host, the network topology is called ______.
(a) fully connected  
(b) daisy chain  
(c) tree  
(d) partly connected

38. When hosts are connected in a part fully connected manner (with many missing connections), it is ______ topology.
(a) fully connected  
(b) daisy chain  
(c) tree  
(d) partly connected

39. LAN stands for ____________.
(a) Local Area Number  
(b) Local Area Network  
(c) Local Assignment Network  
(d) Lead Area Network

40. MAN stands for ____________.
(a) Metropolitan Area Number  
(b) Metropolitan Assignment Network  
(c) Metropolitan Area Network

41. WAN stands for ____________.
(a) Wide Area Number  
(b) Wide Assignment Network  
(c) Wise Area Network  
(d) Wide Area Network

42. Usually, the network connecting hosts inside a single building is called ______.
(a) LA N  
(b) WAN  
(c) MAN  
(d) none of them

43. Usually, the network connecting hosts inside a city/metropolitan limit is called ______.
(a) LA N  
(b) WAN  
(c) MAN  
(d) none of them

44. Usually, the network connecting hosts located in several cities or nations is called ______.
(a) LA N  
(b) WAN  
(c) MAN  
(d) none of them

45. WLAN stands for ____________.
(a) Wireless Local Area Network  
(b) Wired Local Area Network  
(c) Wireless Local Area Number  
(d) Wireless Local Arithmetic Network

46. When network hosts are connected without wires, ______ protocol is used.
(a) LAN  
(b) WAN  
(c) MAN  
(d) WLAN

1.9.5 Network components

Modem

47. MODEM is a device used for converting ______.
(a) digital signal to analog  
(b) analog signal to digital  
(c) both a & b  
(d) neither a nor b

48. MODEM stands for ____________.
(a) MODulation DEmodulation  
(b) MODulation DEclaraction  
(c) MODern DEmodulation  
(d) MODulation DEcision

49. MODEM is used to convey data over ______.
(a) air  
(b) telephone line  
(c) train track  
(d) bus route
Q. Bank [COPA Semester - 1]

Hub

50. The device which repeats a signal on all lines except incoming one is called
(a) hub  (b) switch  (c) MODEM  (d) router

51. Hub is ____________ to switch/ bridge since it repeats data even to the unwanted connections.
(a) inferior  (b) superior  (c) equivalent  (d) none of them

Switch

52. The networking device which receives a packet and repeats it to just the intended recipient lines is called a ____________.
(a) hub  (b) switch  (c) MODEM  (d) none of them

53. Switch is ____________ to a hub since unwanted repetitions are curtailed.
(a) inferior  (b) superior  (c) equivalent  (d) none of them

Router

54. The device used to transfer data from one network to another network on the Internet is called ____________.
(a) hub  (b) switch  (c) MODEM  (d) router

55. The device which connects one Local Area Network to another Local Area Network is called ____________.
(a) hub  (b) switch  (c) MODEM  (d) bridge

Gateway

56. The node which connects one large network (a WAN, MAN, etc.) to another large network is called ____________.
(a) hub  (b) switch  (c) gateway  (d) MODEM

1.9.6 Network Cables

57. The cable containing 4 pairs of twisted wires without any shielding foil for data transmission is called ____________.
(a) unshielded twisted cable  (b) shielded twisted cable  (c) coaxial cable  (d) fibre optic cable

58. The cable containing 4 pairs of twisted wires with shielding foil to control interference with other electrical signals and used for data transmission is called ____________.
(a) unshielded twisted cable  (b) shielded twisted cable  (c) coaxial cable  (d) fibre optic cable

59. A cable with single copper core and braided metal shield is called ____________.
(a) unshielded twisted cable  (b) shielded twisted cable  (c) coaxial cable  (d) fibre optic cable

60. A cable with single fibre optic core line surrounded by several layers of protective materials is called ____________.
(a) unshielded twisted cable  (b) shielded twisted cable  (c) coaxial cable  (d) fibre optic cable

61. Fibre optic cables are ____________ interferences from electric cables and electromagnetic waves.
(a) prone to  (b) unaffected by  (c) susceptible to  (d) affected by

62. Out of the several cable options, ____________ cable provides high speed over long distances without being affected by local interferences.
(a) fibre optic  (b) unshielded twisted pair  (c) shielded twisted pair  (d) none of them

1.9.7 Wireless networks

63. Wireless networks communicate using ____________ signal instead of cables.
(a) infrared  (b) low frequency radio wave  (c) Wireless Fidelity (WiFi - IEEE 802.11 standard)  (d) all of them

64. In the modern days, ____________ is the best choice for wireless networking.
65. The WiFi standard which permits transmission distance of 50m with data rate of 54MBPS is ________.
   (a) IEEE 802.11a  (b) IEEE 802.11b  
   (c) IEEE 802.11g  (d) IEEE 802.11n
66. The WiFi standard which permits transmission distance of 100m with data rate of 11MBPS is ________.
   (a) IEEE 802.11a  (b) IEEE 802.11b  
   (c) IEEE 802.11g  (d) IEEE 802.11n
67. The WiFi standard which permits transmission distance of 100m with data rate of 54MBPS is ________.
   (a) IEEE 802.11a  (b) IEEE 802.11b  
   (c) IEEE 802.11g  (d) IEEE 802.11n
68. The WiFi standard which permits transmission distance of more than 100m with data rate of 100MBPS is ________.
   (a) IEEE 802.11a  (b) IEEE 802.11b  
   (c) IEEE 802.11g  (d) IEEE 802.11n
69. Wireless networks are ________ wired networks.
   (a) slower than (b) faster than  
   (c) as fast as (d) none of them
70. In terms of data safety, wireless networks are ________ wired networks.
   (a) more secure than (b) less secure than  
   (c) as safe as (d) none of them
71. Normally, WiFi signal reach ________m distance.
   (a) 50 to 100m  (b) 1 to 2m  
   (c) 0.5 to 1.0m  (d) 2 to 3m
72. WiFi networks have ________ for connecting.
   (a) name  (b) password  
   (c) both a & b  (d) none of them
73. Name of a WiFi network may be ________
   (a) visible (b) invisible  
   (c) both a & b (d) none of them
74. Open WiFi networks have ________
   (a) a visible name  (b) no password  
   (c) visible name without any password (d) none of them

1.9.8 Bluetooth technology
75. The technology which permits data transmission between devices like computers, mobile phones, tablets, headsets, etc. is called ________.
   (a) Bluetooth  (b) coaxial cable  
   (c) fibre optic cable (d) twisted pair cable
76. The network established using Bluetooth technology is called a ________.
   (a) Local Area Network (LAN)  (b) Wide Area Network (WAN)  
   (c) Metropolitan Area Network (MAN) (d) Personal Area Network (PAN)
77. Bluetooth signals have a range of ________
   (a) 1m  (b) 5m  
   (c) 10m (d) 100m
78. Bluetooth permits ________
   (a) pairing by acceptance  (b) pairing by password authentication  
   (c) pairing by verification (d) all of them

1.9.9 OSI 7 Layer Model
79. The 7 layer model of OSI stands for ________.
   (a) Open System Interconnection  (b) Open System Interface  
   (c) Open Synchronous Interconnection (d) Ordered System Interconnection
80. The first layer of the OSI model is ________ layer and it controls transmission of bits of data.
   (a) physical  (b) data link layer  
   (c) network (d) transport
81. The second layer of the OSI model is ________ layer and it controls reliable transmission of data frames.
   (a) physical (b) data link  
   (c) network (d) transport
82. The third layer of the OSI model is ________ layer and it controls addressing, routing and traffic control for data frame transmission.
   (a) physical (b) data link  
   (c) network (d) transport
83. The fourth layer of the OSI model is ________ layer and it controls transmission of data using particular protocols like TCP or UDP.
   (a) physical (b) data link
84. The fifth layer of the OSI model is ______ layer and it controls connection between 2 hosts (like client and server) during data communication.
(a) session (b) presentation (c) application (d) transport

85. The sixth layer of the OSI model is ______ layer and it takes care of encryption, decryption, compression, decompression and data encoding.
(a) session (b) presentation (c) application (d) transport

86. The seventh layer of the OSI model is ______ layer and it deals with file sharing, video sharing, audio sharing, browsing, etc. using specific programs.
(a) session (b) presentation (c) application (d) transport

1.9.10 Various Network protocols

87. TCP stands for ________
(a) Transmission Control Protocol
(b) Transmission Control Procedure
(c) Transit Control Protocol
(d) Transmission Convergence Protocol

88. UDP stands for ________
(a) Unified Datagram Protocol
(b) User Datagram Protocol
(c) User Datagram Procedure
(d) User Digital Protocol

89. IP stands for ________
(a) Information Protocol
(b) Internet Procedure
(c) Identity Protocol
(d) Internet Protocol

90. DNS stands for ________
(a) Domain Name Synchronized
(b) Data Name System
(c) Domain Name System
(d) Domain Network System

91. ________ allows for mapping IP address to an ethernet or hardware address.
(a) Address Resolution Protocol (ARP)
(b) Reverse Address Resolution Protocol (RARP)
(c) Open System Interconnection (OSI)
(d) none of them

92. ________ allows for mapping an ethernet or hardware address to an IP address.
(a) Address Resolution Protocol (ARP)
(b) Reverse Address Resolution Protocol (RARP)
(c) Open System Interconnection (OSI)
(d) none of them

93. ________ is the version of Internet Protocol now being phased out.
(a) IP version 1 (IPV1)
(b) IP version 2 (IPV2)
(c) IP version 4 (IPV4)
(d) IP version 6 (IPV6)

94. ________ is the version of Internet Protocol now being introduced to handle increased size of the Internet.
(a) IP version 1 (IPV1)
(b) IP version 2 (IPV2)
(c) IP version 4 (IPV4)
(d) IP version 6 (IPV6)

95. IPV4 addresses have a ________ by numeric address.
(a) 4 (b) 6 (c) 8 (d) 16

96. The addresses 216.58.213.36 (www.google.com), 209.191.88.254 (www.yahoo.com) belong to IP version ________.
(a) 1 (b) 2 (c) 3 (d) 4

TCP/IP

97. In a client server network, the ports in the range of 0 to 1023 are called ________ ports.
(a) relational ports
(b) general ports
(c) well known ports
(d) user ports

98. Network protocols are standardized through ________.
(a) Request For Comment (RFC)
(b) email
(c) web server
(d) telnet

99. RFC in networking stands for ________.
(a) Rejection For Comment
(b) Request For Comment
(c) Request For Contest
(d) Request Freight Comment

100. W3C in networking stands for ________.
(a) World Wide Winter Consortium
(b) World Wide Web Contest
(c) World White Web Consortium

Prepared by: Dr.V.Nagaradjane
101. TCP/IP port number 7 is assigned for ________ protocol.
(a) daytime
(b) echo
(c) quote of the day
(d) message send

102. TCP/IP port number 13 is assigned for ________ protocol.
(a) daytime
(b) echo
(c) quote of the day
(d) message send

103. TCP/IP port number 17 is assigned for ________ protocol.
(a) daytime
(b) echo
(c) quote of the day
(d) message send

104. TCP/IP port number 18 is assigned for ________ protocol.
(a) daytime
(b) echo
(c) quote of the day
(d) message send

105. TCP/IP port number 20 is assigned for ________.
(a) Telnet
(b) Simple Mail Transfer Protocol (SMTP)
(c) File Transfer Protocol Protocol (FTP)
(d) Trivial File Transfer Protocol (TFTP)

106. TCP/IP port number 23 is assigned for ________.
(a) Telnet
(b) Simple Mail Transfer Protocol (SMTP)
(c) File Transfer Protocol Protocol (FTP)
(d) Trivial File Transfer Protocol (TFTP)

107. TCP/IP port number 25 is assigned for ________.
(a) Telnet
(b) Simple Mail Transfer Protocol (SMTP)
(c) File Transfer Protocol Protocol (FTP)
(d) Trivial File Transfer Protocol (TFTP)

108. TCP/IP port number 69 is assigned for ________.
(a) Telnet
(b) Simple Mail Transfer Protocol (SMTP)
(c) File Transfer Protocol Protocol (FTP)
(d) Trivial File Transfer Protocol (TFTP)

109. TCP/IP port number 80 is assigned for ________.
(a) Hyper Text Transfer Protocol (HTTP)
(b) Post Office Protocol (POP)
(c) Structured Query Language (SQL)
(d) Network News Transfer Protocol (NNTP)

110. TCP/IP port number 109 is assigned for ________.
(a) Hyper Text Transfer Protocol (HTTP)
(b) Post Office Protocol (POP)
(c) Structured Query Language (SQL)
(d) Network News Transfer Protocol (NNTP)

111. TCP/IP port number 118/156 is assigned for ________.
(a) Hyper Text Transfer Protocol (HTTP)
(b) Post Office Protocol (POP)
(c) Structured Query Language (SQL)
(d) Network News Transfer Protocol (NNTP)

112. TCP/IP port number 119/443 is assigned for ________.
(a) Hyper Text Transfer Protocol (HTTP)
(b) Post Office Protocol (POP)
(c) Structured Query Language (SQL)
(d) Network News Transfer Protocol (NNTP)

113. TCP/IP port number 143/220 is assigned for ________.
(a) Internet Message Access Protocol (IMAP)
(b) Simple Network Management Protocol (SNMP)
(c) Internet Relay Chat (IRC)
(d) Precision Time Protocol (PTP)

114. TCP/IP port number 161 is assigned for ________.
(a) Internet Message Access Protocol (IMAP)
(b) Simple Network Management Protocol (SNMP)
(c) Internet Relay Chat (IRC)
(d) Precision Time Protocol (PTP)

115. TCP/IP port number 194 is assigned for ________.
(a) Internet Message Access Protocol (IMAP)
(b) Simple Network Management Protocol (SNMP)
(c) Internet Relay Chat (IRC)
(d) Precision Time Protocol (PTP)

116. TCP/IP port number 319 is assigned for ________.
(a) Internet Message Access Protocol (IMAP)
(b) Simple Network Management Protocol (SNMP)
(c) Internet Relay Chat (IRC)
(d) Precision Time Protocol (PTP)

117. TCP/IP port number 319 is assigned for ________.
(a) Internet Message Access Protocol (IMAP)
(b) Simple Network Management Protocol (SNMP)
(c) Internet Relay Chat (IRC)
118. TCP/IP port number 443 is assigned for
(a) **HTTP over Secure Socket Layer HTTPS**
(b) Remote Procedure Call (RPC)
(c) Dynamic Host Configuration Protocol (DHCP)
(d) Internet Message Access Protocol over Secure Socket Layer (IMAPS)

119. TCP/IP port number 530 is assigned for
(a) **HTTP over Secure Socket Layer HTTPS**
(b) Remote Procedure Call (RPC)
(c) Dynamic Host Configuration Protocol (DHCP)
(d) Internet Message Access Protocol over Secure Socket Layer (IMAPS)

120. TCP/IP port number 546/547 is assigned for
(a) **HTTP over Secure Socket Layer HTTPS**
(b) Remote Procedure Call (RPC)
(c) Dynamic Host Configuration Protocol (DHCP)
(d) Internet Message Access Protocol over Secure Socket Layer (IMAPS)

121. TCP/IP port number 993 is assigned for
(a) **HTTP over Secure Socket Layer HTTPS**
(b) Remote Procedure Call (RPC)
(c) Dynamic Host Configuration Protocol (DHCP)
(d) Internet Message Access Protocol over Secure Socket Layer (IMAPS)

122. The TCP/IP protocol which permits sharing of large files over the Internet is called
(a) **File Transfer Protocol (FTP)**
(b) Hyper Text Transmission Protocol (HTTP)
(c) Simple Mail Transfer Protocol (SMTP)
(d) Network Time Protocol (NTP)

123. FTP runs on port number 20
(a) 7 (b) 13
(c) 20 (d) 23

124. The FTP server which does not require login process is called
(a) Hyper Text Transmission Protocol
(b) Simple Mail Transfer Protocol
(c) Network Time Protocol
(d) **Anonymous File Transfer Protocol**

125. Using FTP, a file can be copied from remote system to the local system using the command
(a) `get` (b) `put`
(c) `cd` (d) `lcd`

126. Using FTP, a file can be copied from local host to remote host using the command
(a) `get` (b) `put`
(c) `cd` (d) `lcd`

127. Using FTP, working directory on the remote host can be changed using the command
(a) `pwd` (b) `put`
(c) `cd` (d) `lcd`

128. Using FTP, working directory on the local host can be changed using the command
(a) `pwd` (b) `by`e
(c) `cd` (d) `lcd`

129. Using FTP, list of files on the remote host can be viewed using the command
(a) `pwd` (b) `by`e
(c) `cd` (d) `lcd`

130. Using FTP, a file on the remote host may be deleted using the command
(a) `delete` (b) `by`e
(c) `cd` (d) `lcd`

131. Using FTP, connection to remote FTP server may be terminated using the command
(a) `delete` (b) `by`e/`quit`
(c) `cd` (d) `lcd`

132. Popular FTP clients are
(a) CoreFTP (b) FireFTP
(c) FileZilla (d) **all of them**

**FTP**

133. The network protocol which permits a person to login to a remote computer, access files, execute commands on the remote computer, etc. is called
(a) **FTP** (b) HTTP
(c) Telnet (d) SMTP

134. Port No. 23 is reserved for telnet protocol.
(a) 7 (b) 13
(c) 20 (d) 23

135. Usually, telnet connection is established using `telnet` command followed by name of host.
(a) `ftp` (b) `telnet`
(c) `ping` (d) `ls`
1.9.11 Logical and Physical Addresses

136. The address of the physical networking component (like ethernet, WiFi, etc.) is called ________ address.
   (a) virtual  (b) logical  (c) physical  (d) imaginary

137. The address assigned to a host on getting connected to a network (like the Internet) is called ________ address.
   (a) virtual  (b) logical  (c) physical  (d) imaginary

138. In networking, MAC stands for ________.
   (a) Media Address Control  (b) Machine Access Control  (c) Media Access Control  (d) none of them

139. Logical address of a host connected to a network is otherwise called ________ address.
   (a) IP address  (b) IP version 4 address  (c) IP version 6 address  (d) all of them

1.9.12 Classes of Networks

140. The addresses of class A network has subnet mask of ________.
   (a) 255.0.0.0  (b) 255.255.0.0  (c) 255.255.255.0  (d) none of them

141. The addresses of class B network has subnet mask of ________.
   (a) 255.0.0.0  (b) 255.255.0.0  (c) 255.255.255.0  (d) none of them

142. The addresses of class C network has subnet mask of ________.
   (a) 255.0.0.0  (b) 255.255.0.0  (c) 255.255.255.0  (d) none of them

143. First byte of class A network is in the range of ________.
   (a) 1 - 126  (b) 128 - 191  (c) 192 - 223  (d) none of them

144. First byte of class B network is in the range of ________.
   (a) 1 - 126  (b) 128 - 191  (c) 192 - 223  (d) none of them

145. First byte of class C network is in the range of ________.
   (a) 1 - 126  (b) 128 - 191  (c) 192 - 223  (d) none of them

146. Each class A network supports ________ hosts.
   (a) 1,67,77,214  (b) 65,534  (c) 254  (d) none of them

147. Each class B network supports ________ hosts.
   (a) 1,67,77,214  (b) 65,534  (c) 254  (d) none of them

148. Each class C network supports ________ hosts.
   (a) 1,67,77,214  (b) 65,534  (c) 254  (d) none of them

149. IPV4 has got ________ bits for addressing of hosts.
   (a) 128  (b) 64  (c) 32  (d) 16

150. IPV6 has got ________ bits for addressing of hosts.
   (a) 128  (b) 64  (c) 32  (d) 16

151. IPV4 has got ________ bytes for addressing of hosts.
   (a) 16  (b) 8  (c) 4  (d) 2

152. IPV6 has got ________ bytes for addressing of hosts.
   (a) 16  (b) 8  (c) 4  (d) 2

153. The address 2001:db8:a0b:12f0::1 is formatted in ________.
   (a) IPV0  (b) IPV2  (c) IPV4  (d) IPV6

1.9.13 Network Security & Firewall

154. Connection to the Internet requires enforcement of ________ security.
   (a) low  (b) high  (c) zero  (d) no

155. Filtering connections and disallowing prohibited connections is carried out using ________.
   (a) MODEM  (b) router  (c) firewall  (d) bridge

156. First general firewalls operated at layer ________ of the OSI model.
   (a) 3  (b) 4  (c) 5  (d) 7
157. Second general firewalls operated at layer _______ of the OSI model.
(a) 3  (b) 4  (c) 5  (d) 7

158. Third general firewalls operated at layer _______ of the OSI model.
(a) 3  (b) 4  (c) 5  (d) 7

159. First generation firewalls were otherwise called _________.
(a) packet filters  (b) stateful filters  (c) application filters  (d) none of them

160. Second generation firewalls were otherwise called _________.
(a) packet filters  (b) stateful filters  (c) application filters  (d) none of them

161. Third generation firewalls were otherwise called _________.
(a) packet filters  (b) stateful filters  (c) application filters  (d) none of them

162. IPS in firewall stands for _________.
(a) Intrusion Protection System  (b) Intrusion Prevention Software  (c) Internet Prevention System  (d) Intrusion Prevention System

163. The identity management system binds logical addresses to ________ for reputed servers.
(a) MAC address  (b) specific programs  (c) other computers  (d) none of them

164. Third generation of firewall offers ________ to prevent web fingerprint attacks.
(a) web application firewall  (b) packet filter  (c) stateful filter  (d) none of them

1.9.14 DHCP Server

165. The protocol used to automatically assign IP address to a newly connected host in a network is called _________.
(a) Dynamic Host Configuration Protocol (DHCP)  (b) Transmission Control Protocol (TCP)
(c) User Datagram Protocol (UDP)  (d) File Transfer Protocol (FTP)

1.9.15 Internet

166. The global network of networks is called _________.
(a) Local Area Network  (b) Internet  (c) Intranet  (d) Metropolitan Area Network

167. The global network established for a particular business (not for public access) is called _________.
(a) Local Area Network  (b) Internet  (c) Intranet  (d) Metropolitan Area Network

1.9.16 Introduction to the Internet

168. Internet may be used for _________.
(a) sharing information through World Wide Web  (b) sending and receiving emails
(c) sharing of large files  (d) all of them

169. Internet may be used for _______.
(a) cloud storage of data in remote computers  (b) secure operation of bank accounts through netbanking and mobile banking
(c) secure operation of wallet payments  (d) all of them

170. Internet helps scientists to _________.
(a) share their research results with other scientists  (b) learn what happens in the state of the art research
(c) download articles published by other researchers  (d) all of them

171. Internet helps in _________.
(a) conducting online examinations  (b) conducting online classes
(c) conducting online interaction sessions to clear the doubts of students  (d) all of them

172. Internet helps to _________.
(a) update correct time using Network Time Protocol (NTP)  (b) e-commerce
(c) job search  (d) all of them

Prepared by: Dr.V.Nagaradjane
1.9.17 Introduction to WWW

173. WWW stands for ____________.
(a) World Wide Web
(b) World Wire Web
(c) Work Wide Web
(d) World Wise Web

(a) document editor
(b) browser
(c) drawing program
(d) image editor

175. Microsoft Internet Explorer, Microsoft Edge, Firefox, Chrome, Safari, Konqueror, Seamonkey, etc. are ____________ applications.
(a) word processing
(b) spreadsheet
(c) browser
(d) presentation

176. The space at the top of browser for entering the address of web site is called ____________.
(a) bookmarks bar
(b) history bar
(c) status bar
(d) address bar

177. The list of addresses visited by a person during browsing is called ____________.
(a) history
(b) bookmark
(c) private browsing
(d) home page

178. The list of addresses saved by a person for easy revisit is called ____________.
(a) history
(b) bookmark
(c) private browsing
(d) home page

179. The method of browsing the web without storing any session information on the local device is called ____________.
(a) history
(b) bookmark
(c) private browsing
(d) home page

180. The web page which loads just as the browser opens is called ____________.
(a) history
(b) bookmark
(c) private browsing
(d) home page

181. ________ holds information about files downloaded from the Internet.
(a) history  (b) downloads
(c) tab  (d) home page

182. A ________ opens new web page inside the current browser window itself.
(a) history (b) downloads
(c) tab (d) home page

1.9.18 Web Browsers

183. The software used for viewing web pages is called ____________.
(a) browser (b) media player
(c) anti-virus (d) virus

184. Microsoft Internet Explorer, Firefox, Chrome, Opera, Microsoft Edge, Apple Safari, etc. are ____________ software.
(a) browser (b) media player
(c) anti-virus (d) virus

185. A browser has ________ for typing the address.
(a) address bar
(b) security lock icon
(c) history tab
(d) bookmarks

186. A browser shows ________ icon when an encrypted connection is present.
(a) address bar
(b) security lock icon
(c) history tab
(d) bookmarks

187. A browser shows the list of web pages visited in the recent past at ________.
(a) address bar
(b) security lock icon
(c) history tab
(d) bookmarks

188. A browser has ________ for storing important pages likely to be revisited in the future.
(a) address bar
(b) security lock icon
(c) history tab
(d) bookmarks

189. A browser has ________ for monitoring downloads.
(a) address bar
(b) downloads tab
(c) history tab
(d) bookmarks

190. When visiting unprotected websites, the lock icon is shown with ________.
(a) red X to denote unsafe connection
(b) Green tick to denote safe connection
(c) both a and b
(d) none of them

1.9.19 Internet servers

191. The computers which run software packages for web pages (HTTP), email (SMTP), file transfer (FTP), network time protocol (NTP), etc are called
(a) Internet servers
(b) clients
(c) browsers
(d) media players

192. Apache web server & Internet Information Server are examples of ________ servers.
(a) web
(b) email
(c) file transfer
(d) none of them

1.9.20 Search engines

193. An Internet service which helps online searching of information is called
(a) steam engine
(b) search engine
(c) email server
(d) video stream

194. Google, Bing, Yahoo, Rediff, Ask, AOL etc. are some of the well known ________.
(a) spread sheet programs
(b) search engines
(c) image editors
(d) video players

195. To get a particular type of files in the result list, one should use __________ option at the end of the search string.
(a) mailto (b) address
(c) filetype (d) option

196. To get only PDF files in the result list, __________ may be used.
(a) filetype:pdf
(b) filetype:mp3
(c) filetype:3gp
(d) filetype:docx

197. Before clicking the link provided in the result list of search engines, one should
(a) believe that the URL is correct
(b) naively click all links
(c) ensure that the URL is authentic
(d) click the links without consideration and pay the sums demanded therein

198. If the user wants a complete phrase to be included in verbatim search, the phrase should be ________________
(a) deleted
(b) enclosed in double quotes
(c) enclosed in brackets
(d) enclosed in curly braces

199. Clicking on links from untrusted search engines might take an innocent user to
(a) video sharing websites
(b) audio streaming web sites
(c) social media websites
(d) hackers web site which extracts login ID and password

200. Search terms entered in a search engine
__________
(a) can be traced back to the original source
(b) cannot be traced back to the source
(c) can never be traced back to the source
(d) may not be traced to the source

1.9.21 Domain naming Systems

201. All computers on a network are uniquely identified by ________
(a) IP address
(b) mobile number
(c) landline number
(d) none of them

202. Since IP address is difficult to remember, easy to remember names are assigned to ________
(a) server hosts
(b) clients
(c) mobile phones
(d) none of them

203. ________ server offers name for given IP address or IP address for given server name.
(a) Domain Name Service (DNS) server
(b) web server
(c) email server
(d) FTP server
1.9.22 E-mail

204. Transmission and delivery of information containing text, image, video, documents etc. to targeted recipient(s) over the Internet is called _________.
   (a) email
   (b) world wide web
   (c) e-commerce
   (d) social media

205. An email address contains _________ parts separated by a @ symbol.
   (a) 5 (b) 4
   (c) 3 (d) 2

206. The first part of email address identifies _________.
   (a) name of individual user
   (b) name of the email server
   (c) name of the mobile phone operator
   (d) name of bank

207. The second part of email address identifies _________.
   (a) name of individual user
   (b) name of the email server
   (c) name of the mobile phone operator
   (d) name of bank

208. The user name and email server parts of an email address are separated by _________ symbol.
   (a) @ (b) #
   (c) $ (d) &

209. Gmail.com, yahoo.com, yahoo.co.in, mail.com, rediff.com, rediffmail.com, fastmail.fm, etc. are popular _________.
   (a) FTP servers
   (b) social media sites
   (c) email servers
   (d) none of them

210. Content found in the web can be _________ to the local computer/device for reading at leisure.
    (a) uploaded (b) downloaded
    (c) transmitted (d) erased

211. An email may contain non-text information which may be _________.
    (a) uploaded (b) downloaded
    (c) transmitted (d) erased

212. To download an email attachment, the user _________ the attachment.
    (a) clicks
    (b) right clicks and chooses save
    (c) both a & b
    (d) neither a nor b

213. An image displayed on web page can be _________ to download the file.
    (a) right click and choose save image as
    (b) left click
    (c) double click
    (d) press delete button

214. Electronic communication between 2 persons having unique identifiers over the Internet is called _____________.
    (a) India post
    (b) Speed post
    (c) Registered post
    (d) email

215. ____________ is a technology that allows you to send and receive messages over the Internet without the delay of traditional postal services.
    (a) India post
    (b) Speed post
    (c) Registered post
    (d) email

216. Each user of a email communication should possess _____________.
    (a) a unique identifier, called email ID
    (b) pen drive
    (c) external hard disk
    (d) DVD writer

217. The email ID of a person contains ____________ parts.
    (a) 2 (b) 3
    (c) 4 (d) 5

218. The first part of an email ID contains _____________.
    (a) name of the city
    (b) name of the owner of the email service provider
    (c) name/identifier of the email user
    (d) name of the email server

219. The second part of an email ID contains _____________.
    (a) name of the city
    (b) name of the owner of the email service provider
    (c) name/identifier of the email user
    (d) name of the email server

220. In email communication, CC stands for _____________.
    (a) carbon copy
    (b) cold coffee
    (c) blind carbon copy
    (d) casual copy

221. In email communication, BCC stands for _____________.
    (a) carbon copy
    (b) cold coffee
222. The email ID of the primary recipient of email is entered in \textbf{To} field.
(a) To (b) CC (c) BCC (d) Subject

223. The email ID of the secondary recipient of email is entered in \textbf{CC} field.
(a) To (b) CC (c) BCC (d) Subject

224. The email ID of the anonymous recipient of email is entered in \textbf{BCC} field.
(a) To (b) CC (c) BCC (d) Subject

225. The crisp essence of email message is entered in \textbf{Subject} field.

226. The actual message of an email is called the \textbf{content}.
(a) content (b) attachment (c) subject (d) BCC

227. The file attached to an email is called the \textbf{attachment}.
(a) content (b) attachment (c) subject (d) BCC

228. An email sent from unknown persons for improving the sale, image, appeal or other characteristics of a product is called \textbf{Junk}.
(a) Junk (b) Important (c) Virus (d) Trojan

229. \textbf{Spam} mail refers to e-mail messages sent by an unknown sender, usually for commercial purposes.
(a) Junk (b) Important (c) Virus (d) Trojan

230. Unsolicited emails may be filtered and separated into \textbf{spam bin}.
(a) spam bin (b) inbox (c) sent mails (d) draft

231. The primary place for receiving an email is \textbf{inbox}.
(a) spam bin (b) inbox (c) sent mails (d) draft

232. All emails sent by the user may be saved in \textbf{sent mails}.
(a) spam bin (b) inbox (c) sent mails (d) draft

233. A half completed email may be saved for later editing and transmission to the receiver in \textbf{draft} folder.

234. Before entering user ID and password, one should ensure that the browser displays \textbf{lock} icon for safe communication with the server.
(a) print (b) lock (c) clock (d) lens

235. Logging into an email server from a dedicated application (APP) installed on a smartphone helps to \textbf{periodically check, retrieve and notify} email messages.
(a) auto delete (b) hide (c) periodically check, retrieve and notify (d) purge

236. It is a good practice to \textbf{avoid opening attachments in} email messages from unknown senders to avoid virus infection of computer.
(a) contain anti-virus (b) repair troubles in the operating system (c) help fast working of computers (d) contain trojens and virusses to attack a computer

237. Images and videos attached to a junk email may \textbf{contain trojens and virusses to attack a computer}.
(a) contain anti-virus (b) repair troubles in the operating system (c) help fast working of computers (d) contain trojens and virusses to attack a computer

238. Opening a new email ID requires entry of \textbf{all of them} in the email opening form.
(a) name and address (b) date of birth and father name (c) alternate email ID if necessary (d) all of them

239. The exchange of audio, video and text over the Internet is called \textbf{video chat}.
(a) video chat (b) audio chat (c) text chat (d) SMS

240. \textbf{Google video chat}, \textbf{Skype/ Viber}, \textbf{iChat/VSee} are some of the video chat applications.
(a) Google video chat (b) Skype/ Viber (c) iChat/VSee (d) all of them
1.9.24 VOIP

241. VOIP stands for ____________.
(a) Voice Over Internet Procedure
(b) Voice Over Internet Protocol
(c) Voice Over Instant Protocol
(d) Virtue Over Internet Protocol

242. VOIP permits ____________.
(a) calling of mobile and telephone numbers through Internet
(b) browsing web
(c) exchanging email
(d) text chat

243. VOIP can reduce the cost of long distance International calls when ____________.
(a) call charges are zero
(b) data charges are very high
(c) calls charges are cheaper than data charges
(d) data is cheaper than call charges

1.9.25 Social Media

244. The Internet repository for sharing casual information (text, documents, audio, images, videos, etc.) is called ____________.
(a) multi-media
(b) social media
(c) storage media
(d) email

245. Information stored in social media ____________.
(a) is highly secure
(b) encrypted and secured with password
(c) strongly secured
(d) not secure

246. The services like Facebook, Twitter, Linked-In are categorized under ____________.
(a) social media
(b) MS Officer
(c) PDF reader
(d) video player

247. Most of the social media websites require ____________ as user ID.
(a) Postal code
(b) PAN number
(c) email address
(d) Adhar ID number

248. Sharing personal information on social media is ____________.
(a) right
(b) unsafe
(c) appreciable
(d) commendable

249. Interacting with strangers on social media might ____________.
(a) result in great future
(b) might fetch good employment
(c) might result in unknown dangers to innocent users
(d) all of them

250. During natural calamities like earthquake, floods, Tsunami, etc., ____________ plays a vital role in damage assessment and rescue efforts.
(a) multi-media
(b) email
(c) social media
(d) SMS

251. Professional sites like Linked-In offer ____________ to its users.
(a) no benefits
(b) respectable job opportunities
(c) no profiles
(d) no professional contacts

252. A professional should ____________ the time allotted for social media, lest she/he begins to waste productive working hours in the social media.
(a) restrict
(b) increase
(c) not worry about
(d) be liberal about

253. Nowadays, it is possible to carry out little ____________ on social media sites like Facebook.
(a) exchange of legal papers
(b) financial transactions with the support of bank
(c) legal arguments
(d) trading of goods

254. An innocent user interacting with strangers in social media may be ____________ to share forbidden content with those stranger.
(a) commanded
(b) coerced
(c) threatened
(d) persuaded

255. Interaction with strangers on social media is as ____________ as it is exciting.
(a) appreciable
(b) happy
(c) dangerous
(d) laudable

1.9.26 Cloud storage

256. Permitting storage of files on a web based server is called ____________.
(a) cloud storage
(b) local storage
(c) email storage
(d) hard disk storage

257. Cloud storage can be accessed from any host having a ____________.
(a) RS232 port
Internet Security

Threats, attacks & Malicious Software

261. A malicious server posing as an authentic server is called __________.
   (a) spoofing
   (b) phishing
   (c) botnet
   (d) Distributed Denial of Service

262. A malicious email or SMS communication inviting the user to click a link and taking the user to a malicious website is __________.
   (a) spoofing
   (b) phishing
   (c) botnet
   (d) Distributed Denial of Service

263. A malicious email or SMS communication inviting the user to click a link and taking the user to a malicious website is __________.
   (a) spoofing
   (b) phishing
   (c) botnet
   (d) Distributed Denial of Service

264. A group of malware infected computers controlled by a remote system to carry out malicious tasks is called __________.
   (a) spoofing
   (b) phishing
   (c) botnet
   (d) Distributed Denial of Service

265. A group of sending fake service requests to a server to such an extent that the server buckles due to overloading is called __________.
   (a) spoofing
   (b) phishing
   (c) botnet
   (d) Distributed Denial of Service

266. An intrusive login to a protected system from a remote system to carry out malicious acts is called __________.
   (a) hacking
   (b) malware
   (c) pharming
   (d) ransomeware

267. A piece of software designed for ill intentions (virus), to steal user ID/password (trojan), erase data on computer (virus), etc. is called __________.
   (a) hacking
   (b) malware
   (c) pharming
   (d) ransomeware

268. Redirecting a legitimate web address to a malicious host is called __________.
   (a) hacking
   (b) malware
   (c) pharming
   (d) ransomeware

269. The malicious software which enters a computer, locks files and threatens to destroy files unless payment is made to a particular account is called __________.
   (a) hacking
   (b) malware
   (c) pharming
   (d) ransomeware

270. The piece of malware which spreads through attachments to emails is called __________.
   (a) worm
   (b) spam
   (c) spyware
   (d) trojan

271. The piece of malware which keeps sending junk message advertising certain products is called __________.
   (a) worm
   (b) spam
   (c) spyware
   (d) trojan

272. The simply records computer activities and transmits them to a malicious site is called __________.
   (a) worm
   (b) spam
   (c) spyware
   (d) trojan

273. The poses as an authenticator but steals login data is called __________.
   (a) worm
   (b) spam
   (c) spyware
   (d) trojan

274. The method of stealing user information by allowing the user to connect to a free WiFi network (as in a Coffee shop, Hotel, etc.) is called __________.
(a) WiFi eavesdropping
(b) spam
(c) spyware
(d) trojan

Internet security products

275. Anti-virus software packages help to

(a) protect files
(b) protect login data
(c) protect against online phishing, spoofing, pharming, etc.
(d) all of them

276. Internet security products mainly concentrate on

(a) firewall
(b) anti-spam
(c) parental control
(d) all of them

277. Popular internet security products are

(a) McAfee livescan/Internet security
(b) Kaspersky Internet Security
(c) Trend Micro Internet security/Bit defender Internet security
(d) all of them

278. A total security software protects a computer against

(a) offline attacks
(b) online attacks
(c) both a & b
(d) neither a nor b

279. Examples of total security software packages are

(a) Norton total security
(b) Kaspersky Total Security
(c) both a & b
(d) none of them

280. In addition to offering firewall, anti-spam control and parental control, total security software offers

(a) backup and restoration options for data
(b) tuning up the computer for better performance
(c) both a & b
(d) none of them

Answers (1402 - 1681)

1. (d) 2. (a) 3. (c) 4. (a) 5. (b) 6. (c) 7. (d) 8. (a) 9. (c) 10. (c) 11. (d) 12. (b) 13. (c) 14. (c) 15. (a) 16. (c) 17. (a) 18. (b) 19. (b) 20. (a) 21. (b) 22. (c) 23. (a) 24. (b) 25. (c) 26. (c) 27. (c) 28. (d) 29. (a) 30. (b) 31. (c) 32. (d) 33. (a) 34. (c) 35. (a) 36. (b) 37. (c) 38. (d) 39. (b) 40. (c) 41. (d) 42. (a) 43. (c) 44. (b) 45. (a) 46. (d) 47. (c) 48. (a) 49. (b) 50. (a) 51. (a) 52. (b) 53. (b) 54. (d) 55. (d) 56. (c) 57. (a) 58. (b) 59. (c) 60. (d) 61. (b) 62. (a) 63. (d) 64. (a) 65. (a) 66. (b) 67. (c) 68. (d) 69. (a) 70. (b) 71. (a) 72. (c) 73. (c) 74. (d) 75. (a) 76. (d) 77. (c) 78. (d) 79. (a) 80. (a) 81. (b) 82. (c) 83. (d) 84. (a) 85. (b) 86. (c) 87. (a) 88. (b) 89. (c) 90. (a) 91. (b) 92. (b) 93. (c) 94. (d) 95. (a) 96. (d) 97. (c) 98. (a) 99. (b) 100. (d) 101. (b) 102. (a) 103. (c) 104. (d) 105. (c) 106. (a) 107. (b) 108. (d) 109. (a) 110. (b) 111. (c) 112. (d) 113. (a) 114. (b) 115. (c) 116. (c) 117. (c) 118. (a) 119. (b) 120. (c) 121. (d) 122. (a) 123. (c) 124. (d) 125. (a) 126. (b) 127. (c) 128. (d) 129. (a) 130. (a) 131. (b) 132. (d) 133. (c) 134. (d) 135. (b) 136. (c) 137. (b) 138. (d) 139. (d) 140. (a) 141. (b) 142. (c) 143. (a) 144. (b) 145. (c) 146. (a) 147. (b) 148. (c) 149. (c) 150. (a) 151. (c) 152. (a) 153. (d) 154. (b) 155. (c) 156. (a) 157. (b) 158. (d) 159. (a) 160. (b) 161. (c) 162. (d) 163. (a) 164. (a) 165. (a) 166. (b) 167. (c) 168. (d) 169. (d) 170. (d) 171. (d) 172. (d) 173. (a) 174. (b) 175. (c) 176. (d) 177. (a) 178. (b) 179. (c) 180. (d) 181. (b) 182. (c) 183. (a) 184. (a) 185. (a) 186. (b) 187. (c) 188. (d) 189. (b) 190. (a) 191. (a) 192. (a) 193. (b) 194. (b) 195. (c) 196. (a) 197. (c) 198. (b) 199. (d) 200. (a) 201. (a) 202. (a) 203. (a) 204. (a) 205. (d) 206. (a) 207. (b) 208. (a) 209. (c) 210. (b) 211. (b) 212. (c) 213. (a) 214. (d) 215. (d) 216. (a) 217. (a) 218. (c) 219. (d) 220. (a) 221. (c) 222. (a) 223. (b) 224. (c) 225. (d) 226. (a) 227. (b) 228. (a)
229. (a) 230. (a) 231. (b) 232. (c) 257. (b) 258. (d) 259. (c) 260. (c)
233. (d) 234. (b) 235. (c) 236. (a) 261. (a) 262. (b) 263. (b) 264. (c)
237. (d) 238. (d) 239. (a) 240. (d) 265. (d) 266. (a) 267. (b) 268. (c)
241. (b) 242. (a) 243. (d) 244. (b) 269. (d) 270. (a) 271. (b) 272. (c)
245. (d) 246. (a) 247. (c) 248. (b) 273. (d) 274. (a) 275. (d) 276. (d)
249. (d) 250. (c) 251. (b) 252. (a) 277. (d) 278. (c) 279. (c) 280. (c)
253. (b) 254. (d) 255. (c) 256. (a)
### 1.10 Web Design

#### 1.10.1 Web server

1. Web pages are designed primarily in
   (a) HTML (b) C++
   (c) Basic (d) Fortran

2. Web pages are stored in a remote host called the _________.
   (a) client (b) email server (c) database server (d) web server

3. The client of a web server uses ________ for display of the page.
   (a) word processor (b) spreadsheet (c) web browser (d) power point

4. ________ is the name of the software which fulfills the request of a browser based client.
   (a) email server (b) web server (c) database server (d) FTP server

5. Apache HTTP, Microsoft Internet Information Sever (IIS), IBM Websphere, etc. are some of the popular _________.
   (a) email servers (b) web servers (c) database servers (d) FTP servers

6. ________ is the consortium responsible for maintaining the web standards.
   (a) World Wide Web Consortium (b) World Wide Water Consortium
   (c) Write Wide Web Consortium (d) World Wide Web Condition

7. W3C (the International body for web standards) stands for _________.
   (a) World Wide Web Consortium (b) World Wide Water Consortium
   (c) Write Wide Web Consortium (d) World Wide Web Condition

8. Web pages containing script to be processed by the web server (in languages like PHP, Perl, Python, ASP.NET, etc.) are said to contain ________ side script.
   (a) client (b) server

9. Web pages containing script to be processed by the browser (in languages like Javascript, VisualBasic.NET, etc.) are said to contain ________ side script.
   (a) client (b) server (c) machine (d) binary

#### 1.10.2 Static and Dynamic Web pages

10. HTML stands for _________.
    (a) Hyper Text Machine Language (b) Higher Text Markup Language
        (c) Hyper Text Markup Language (d) Hyper Tension Markup Language

11. Web pages which do not change to interact with user are called _________.
    (a) intrinsic (b) righteous (c) dynamic (d) static

12. Web pages which interact with user are called _________.
    (a) intrinsic (b) extrinsic (c) dynamic (d) static

13. Dynamic HTML pages can be coded using _________.
    (a) Adobe Flash (b) Javascript (c) VBScript (d) all of them

14. The portion of script code (written in Javascript/ VBScript) executed inside a browser is called ________ side scripting.
    (a) client (b) server (c) right (d) left

15. Most of the dynamic pages deploy ________ to create dynamic interaction.
    (a) server side script (b) client side script (c) shell script (d) SQL script

16. DHTML stands for _________.
    (a) Dynamic Hyper Text Machine Language (b) Drastic Hyper Text Markup Language
        (c) Dynamic Hyper Text Markup Language (d) Dynamic Higher Text Markup Language

17. CSS in web scripting stands for _________.
    (a) Cascading System Sheet (b) Crisp Style Sheet (c) Cascading Style Set
Cascading Style Sheet

CSS helps to
(a) alter the colour of the document
(b) alter the font size of the document
(c) alter the default font faces of the document
(d) all of them

DOM stands for
(a) Document Object Model
(b) Dynamic Object Model
(c) Document Object Model
(d) Document Offset Model

The method of treating document elements (like input, button, etc.) as program elements is called
(a) Different Object Model
(b) Dynamic Output Model
(c) Document Object Model
(d) Desktop Object Model

Ajax is a side scripting system for creating user interaction.
(a) client
(b) server
(c) right
(d) left

Dynamic web pages provide interaction through
(a) input response
(b) keyboard response
(c) mouse response
(d) all of them

Introduction to HTML

Default extension for a HTML document is
(a) .htm
(b) .html
(c) both a & b
(d) none of them

HTML tag begins with symbol.
(a) <
(b) >
(c) <!--
(d) -->

HTML tag ends with symbol.
(a) <
(b) >
(c) <!--
(d) -->

HTML comment begins with symbol.
(a) <
(b) >
(c) <!--
(d) -->

HTML comment ends with symbol.
(a) <
(b) >
(c) <!--
(d) -->

HTML was created by
(a) Brian Kernighan
(b) Tim Berners-Lee
(c) Dennis Ritchie
(d) James Gosling

SGML stands for
(a) Standard Grand Markup Language
(b) Synchronized Generalized Markup Language
(c) Standard Generalized Markup Language
(d) Simple Generalized Markup Language

DTD stands in markup language for
(a) Document Type Definition
(b) Data Type Definition
(c) Digital Type Definition
(d) Design Type Definition

DDL stands for
(a) Data Description Library
(b) Data Description Language
(c) Data Description Liberty
(d) Data Description License

Most of the HTML tags have a corresponding closing tag, which begins with symbol.
(a) < --
(b) < /
(c) < .
(d) < &nbsp;

If a HTML tag does not have explicit closing tag, the tag may be closed with symbol instead of a simple > symbol.
(a) >
(b) .>
(c) >
(d) @>

Various tags in HTML

HTML document is contained inside a set of tags.
(a) < HTML > ...
(b) < HEAD > ...
(c) < TITLE > ...
(d) < BODY > ...

The top portion of a HTML document containing many meta items and script functions is called
(a) < HTML > ...
(b) < HEAD > ...
(c) < TITLE > ...
(d) < BODY > ...

The title to be displayed at the top of the browser window or browser tab is enclosed in
(a) < HTML > ...
(b) < HEAD > ...

Prepared by: Dr.V.Nagaradjane
(c) \(<TITLE>... </TITLE>\)
(d) \(<BODY>... </BODY>\)

37. The main portion of a HTML document is contained between ________ tags.
(a) \(<HTML>... </HTML>\)
(b) \(<HEAD>... </HEAD>\)
(c) \(<TITLE>... </TITLE>\)
(d) \(<BODY>... </BODY>\)

38. Paragraph is contained inside ________ HTML tags.
(a) \(<p>... </p>\)
(b) \(<center>... </center> or <div align="center">... </div>\)
(c) \(<div align="left">... </div>\)
(d) \(<div align="right">... </div>\)

39. Elements to be centre aligned in browser display are enclosed inside ________ HTML tags.
(a) \(<p>... </p>\)
(b) \(<center>... </center> or <div align="center">... </div>\)
(c) \(<div align="left">... </div>\)
(d) \(<div align="right">... </div>\)

40. Elements to be left aligned in browser display are enclosed inside ________ HTML tags.
(a) \(<div align="justified">... </div>\)
(b) \(<center>... </center> or <div align="center">... </div>\)
(c) \(<div align="left">... </div>\)
(d) \(<div align="right">... </div>\)

41. Elements to be right aligned in browser display are enclosed inside ________ HTML tags.
(a) \(<div align="justified">... </div>\)
(b) \(<center>... </center> or <div align="center">... </div>\)
(c) \(<div align="left">... </div>\)
(d) \(<div align="right">... </div>\)

42. Elements to be justified (aligned flush with left and right edges) in browser display are enclosed inside ________ tags in HTML.
(a) \(<div align="justified">... </div>\)
(b) \(<center>... </center> or <div align="center">... </div>\)
(c) \(<div align="left">... </div>\)
(d) \(<div align="right">... </div>\)

43. ________ HTML tag displays an image in HTML page.
(a) \(<img src = "file.jpg">\)
(b) \(<tableborder = 1>... </table>\)
(c) \(<tableborder = 0>... </table>\)

44. ________ HTML tag displays a table without border.
(a) \(<img src = "file.jpg">\)
(b) \(<tableborder = 1>... </table>\)
(c) \(<tableborder = 0>... </table>\)
(d) \(<ahref = "target.htm">... </ahref>\)

45. ________ HTML tag creates a click-able hyper link for navigation inside the same page or between different pages.
(a) \(<img src = "file.jpg">\)
(b) \(<table border = 1>... </table>\)
(c) \(<table border = 0>... </table>\)
(d) \(<ahref = "target.htm">... </ahref>\)

46. ________ HTML tag displays a table with border thickness of 1 pixel.
(a) \(<img src = "file.jpg">\)
(b) \(<table border = 1>... </table>\)
(c) \(<table border = 0>... </table>\)
(d) \(<ahref = "target.htm">... </ahref>\)

47. ________ HTML tag can control font face, size and colour.
(a) \(<font face = "Arial" size = "+1" color = "red">...</font>\)
(b) \(<H1>... </H1>\)
(c) \(<H2>... </H2>\)
(d) \(<H3>... </H3>\)

48. ________ HTML tag displays headings of the largest size.
(a) \(<font face = "Arial" size = "+1" color = "red">...</font>\)
(b) \(<H1>... </H1>\)
(c) \(<H2>... </H2>\)
(d) \(<H3>... </H3>\)

49. ________ HTML tag displays headings of the second largest size.
(a) \(<H4>... </H4>\)
(b) \(<H1>... </H1>\)
(c) \(<H2>... </H2>\)
(d) \(<H3>... </H3>\)

50. ________ HTML tag displays headings of the third largest size.
(a) \(<H4>... </H4>\)
(b) \(<H1>... </H1>\)
(c) \(<H2>... </H2>\)
(d) \(<H3>... </H3>\)

51. ________ HTML tag displays headings of the smallest size.
(a) \(<H4>... </H4>\)
(b) \(<H1>... </H1>\)
(c) \(<H2>... </H2>\)
(d) \(<H3>... </H3>\)
52. In HTML, text size ________ represents the normal size of text.
   (a) -4 (b) 0 (c) +4 (d) +8

53. In HTML5, font tag has been ________.
   (a) appreciated (b) reinstated (c) deprecated (d) beautified

54. In HTML5, font name can be controlled using ________ tag sets.
   (a) <span style= "font-weight: bold">...</span>
   (b) <span style= "font-size: 16px">...</span>
   (c) <span style= "color: red">...</span>
   (d) <span style= "font-family: verdana">...</span>

55. In HTML5, font colour can be controlled using ________ tag sets.
   (a) <span style= "font-weight: bold">...</span>
   (b) <span style= "font-size: 16px">...</span>
   (c) <span style= "color: red">...</span>
   (d) <span style= "font-family: verdana">...</span>

56. In HTML5, font size can be controlled using ________ tag sets.
   (a) <span style= "font-weight: bold">...</span>
   (b) <span style= "font-size: 16px">...</span>
   (c) <span style= "color: red">...</span>
   (d) <span style= "font-family: verdana">...</span>

57. ________ among the given HTML5 tags sets font size to 16px.
   (a) <span style= "font-weight: bold">...</span>
   (b) <span style= "font-size: 16px">...</span>
   (c) <span style= "color: red">...</span>
   (d) <span style= "font-family: verdana">...</span>

58. ________ among the given HTML5 tags sets font weight to bold.
   (a) <span style= "font-weight: bold">...</span>
   (b) <span style= "font-weight: normal">...</span>
   (c) <span style= "font-weight: 1200">...</span>
   (d) <span style= "font-weight: 900">...</span>

59. ________ among the given HTML5 tags sets font weight to normal.
   (a) <span style= "font-weight: bold">...</span>
   (b) <span style= "font-weight: normal">...</span>
   (c) <span style= "font-weight: 1200">...</span>
   (d) <span style= "font-weight: 900">...</span>

60. Colour can be specified using colour name (like red, gray, blue, cyan, magenta, etc.) or numeric value in ________ colour order.
   (a) Red-Green-Blue (b) Blue-Green-Red (c) Green-Red-Blue (d) Blue-Green-Blue

61. Colour code of #FF0000 stands for ________ colour.
   (a) blue (b) green (c) red (d) black

62. Colour code of #00FF00 stands for ________ colour.
   (a) blue (b) green (c) red (d) black

63. Colour code of #0000FF stands for ________ colour.
   (a) blue (b) green (c) red (d) black

64. Colour code of #000000 stands for ________ colour.
   (a) blue (b) green (c) red (d) black

65. Colour code of #FFFFFF stands for ________ colour.
   (a) white (b) green (c) red (d) black

66. In HTML, the two digit color code value ranges from 00 to ________ in hexadecimal.
   (a) AA (b) 11 (c) FF (d) CC

67. ________ tag is used to display different HTML pages in a single window (not recommended for mobile viewing).
   (a) font (b) frameset (c) table (d) img

Prepared by: Dr.V.Nagaradjane
68. **Width of elements like image, table, etc. can be controlled using _______ attribute.**
   (a) width  
   (b) height
   (c) length  
   (d) breadth

69. **Height of elements like image, table, etc. can be controlled using _______ attribute.**
   (a) width  
   (b) height
   (c) length  
   (d) breadth

70. **Width and height value can be specified in _______ or in pixels.**
   (a) metre  
   (b) kilometre
   (c) percentage  
   (d) inches

71. **__________ HTML tag creates a break.**
   (a) `<center>` ...
   (b) `<table>` ...
   (c) `<img width="80%" src="globe.jpg"` >
   (d) `<br/>`

72. **__________ HTML tag displays an image named globe.jpg at 80% of the total width available in the browser.**
   (a) `<center>` ...
   (b) `<table>` ...
   (c) `<img width="80%" src="globe.jpg"` >
   (d) `<br/>`

73. **Scrolling text may be created using __________ tag in HTML.**
   (a) `<marquee>` ...
   (b) `<span>` ...
   (c) `<p>` ...
   (d) `<font>` ...

74. **Text scrolling to left may be created using __________ tag in HTML.**
   (a) `<marquee direction = “left”` ...
   (b) `<marquee direction = “right”` ...
   (c) `<marquee direction = “up”` ...
   (d) `<marquee direction = “down”` ...

75. **Text scrolling to right may be created using __________ tag in HTML.**
   (a) `<marquee direction = “left”` ...
   (b) `<marquee direction = “right”` ...
   (c) `<marquee direction = “up”` ...
   (d) `<marquee direction = “down”` ...

76. **Text scrolling upwards may be created using __________ tag in HTML.**
   (a) `<marquee direction = “left”` ...
   (b) `<marquee direction = “right”` ...
   (c) `<marquee direction = “up”` ...
   (d) `<marquee direction = “down”` ...

Hyperlink in HTML

78. **__________ tag in HTML creates a clickable hyperlink.**
   (a) `<p>` ...
   (b) `<img src="globe.png"` >
   (c) `<table border = 1>` ...
   (d) `<a href="page.html"` >

Table in HTML

79. **__________ HTML tag displays a table without border.**
   (a) `<tr>` ...
   (b) `<th>` ...
   (c) `<table border = 1>` ...
   (d) `<table border = 0>` ...

80. **__________ HTML tag displays a table with border thickness of 1 pixel.**
   (a) `<tr>` ...
   (b) `<th>` ...
   (c) `<table border = 1>` ...
   (d) `<table border = 0>` ...

81. **__________ HTML tag is used to mark header column for a table.**
   (a) `<tr>` ...
   (b) `<th>` ...
   (c) `<table border = 1>` ...
   (d) `<table border = 0>` ...

82. **__________ HTML tag is used to mark a row for a table.**
   (a) `<tr>` ...
   (b) `<th>` ...
   (c) `<table border = 1>` ...
   (d) `<table border = 0>` ...
83. _______ HTML tag is used to mark a column inside a row.
   (a) <td> ... </td>
   (b) <th> ... </th>
   (c) <table border = 1> ... </table>
   (d) <table border = 0> ... </table>

84. Among the following options, _______ HTML tag merges 3 columns to create a large column.
   (a) <tr> ... </tr>
   (b) <td> ... </td>
   (c) <td colspan = 3> ... </td>
   (d) <td rowspan = 4> ... </td>

85. Among the following options, _______ HTML tag merges 4 rows to create a large row.
   (a) <tr> ... </tr>
   (b) <td> ... </td>
   (c) <td colspan = 3> ... </td>
   (d) <td rowspan = 4> ... </td>

86. _______ creates an ordered list.
   (a) <ul> ... </ul>
   (b) <ol> ... </ol>
   (c) <li> ... </li>
   (d) none of them

87. _______ creates an unordered list.
   (a) <ul> ... </ul>
   (b) <ol> ... </ol>
   (c) <li> ... </li>
   (d) none of them

88. _______ declares a list item which may be part of ordered list or unordered list.
   (a) <ul> ... </ul>
   (b) <ol> ... </ol>
   (c) <li> ... </li>
   (d) none of them

1.10.5 Creating Forms with controls using HTML

89. HTML form controls commonly use _______ tag for taking form input.
   (a) <input>
   (b) <table> ...
   (c) <img>
   (d) <form> ...

90. HTML form is contained inside _______ tag.
   (a) <input>
   (b) <form> ...
   (c) <img>
   (d) <form> ...

91. Input tag in HTML supports _______ attribute.
   (a) type
   (b) value
   (c) name/ID
   (d) all of them

92. _______ among the following tags displays a text field named address.
   (a) <input type = "text" name = "address" value = "" autocomplete = "on">
   (b) <input type = "number" name = "height" value = "" autocomplete = "on">
   (c) <input type = "email" name = "email" value = "" autocomplete = "on">
   (d) <input type = "tel" name = "phone" value = "" autocomplete = "on">

93. _______ among the following tags displays a text field named phone.
   (a) <input type = "text" name = "address" value = "" autocomplete = "on">
   (b) <input type = "number" name = "height" value = "" autocomplete = "on">
   (c) <input type = "email" name = "email" value = "" autocomplete = "on">
   (d) <input type = "tel" name = "phone" value = "" autocomplete = "on">

94. _______ among the following tags displays a text field named height.
   (a) <input type = "text" name = "address" value = "" autocomplete = "on">
   (b) <input type = "number" name = "height" value = "" autocomplete = "on">
   (c) <input type = "email" name = "email" value = "" autocomplete = "on">
   (d) <input type = "tel" name = "phone" value = "" autocomplete = "on">

95. _______ among the following tags displays a text field named email.
   (a) <input type = "text" name = "address" value = "" autocomplete = "on">
   (b) <input type = "number" name = "height" value = "" autocomplete = "on">
   (c) <input type = "email" name = "email" value = "" autocomplete = "on">

Prepared by: Dr.V.Nagaradjane
To display a button in HTML form, ______ attribute is used in the input tag.
(a) button  (b) checkbox  (c) color  (d) date

To display a checkbox in HTML form, ______ attribute is used in the input tag.
(a) button  (b) checkbox  (c) color  (d) date

To display a colour selection input in HTML form, ______ attribute is used in the input tag.
(a) button  (b) checkbox  (c) color  (d) date

To display a date input in HTML form, ______ attribute is used in the input tag.
(a) button  (b) checkbox  (c) color  (d) date

To display a date and time input in HTML form, ______ attribute is used in the input tag.
(a) button  (b) checkbox  (c) color  (d) date

To create a hidden field in HTML form, ______ attribute is used in the input tag.
(a) email  (b) file  (c) hidden  (d) image

To create an image selection tool in HTML form, ______ attribute is used in the input tag.
(a) email  (b) file  (c) hidden  (d) image

To create month selection field in HTML form, ______ attribute is used in the input tag.
(a) month  (b) number  (c) password  (d) radio

To create number input field in HTML form, ______ attribute is used in the input tag.
(a) month  (b) number  (c) password  (d) radio

To create password input field in HTML form, ______ attribute is used in the input tag.
(a) month  (b) number  (c) password  (d) radio

To create radio button input field in HTML form, ______ attribute is used in the input tag.
(a) month  (b) number  (c) password  (d) radio

To create an input field to display numbers with specific start, end and step values in HTML form, ______ attribute is used in the input tag.
(a) range  (b) reset  (c) search  (d) tel

To create an input field to reset all input elements of a form in HTML form, ______ attribute is used in the input tag.
(a) range  (b) reset  (c) search  (d) tel

To create search field (behaviour depends upon server implementation) in HTML form, ______ attribute is used in the input tag.
(a) range  (b) reset  (c) search  (d) tel

To create field for telephone number input in HTML form, ______ attribute is used in the input tag.
(a) range  (b) reset  (c) search  (d) tel

To create field for submitting the contents of HTML form to the server, ______ attribute is used in the input tag.
(a) submit  (b) text  (c) time  (d) url

To create a text input field in HTML, ______ attribute is used in the input tag.
(a) submit  (b) text  (c) time  (d) url

To create a time input in HTML, ______ attribute is used in the input tag.
116. To create a field for taking a web address in HTML, _______ attribute is used in the input tag.
(a) submit (b) text (c) time (d) url

117. To create a field for taking a web address in HTML, _______ attribute is used in the input tag.
(a) week (b) text (c) time (d) url

1.10.6 Concepts of CSS

118. CSS stands for _______.
(a) Cascading System Sheet (b) Crisp Style Sheet (c) Cascading Style Set (d) Cascading Style Sheet

119. CSS is used to control _______ of a HTML document.
(a) content (b) styles aspects like colour, size, background, etc. (c) server type (d) browser type

120. CSS definitions are contained inside _______ tags.
(a) <style> ... </style> (b) <h1> ... </h1> (c) <table> ... </table> (d) <form> ... </form>

121. CSS may be defined _______.
(a) at the header section (b) in a separate file (c) inline as an attribute to a HTML tag (d) all of them

122. External style sheet may be embedded in HTML header section using the _______ tag.
(a) <link rel="stylesheet" href="styleset.css" > (b) <a href="styleset.css" > (c) <img src="globe.gif" > (d) <p> ... </p>

123. A CSS tag has _______ main components.
(a) 1 (b) 2 (c) 3 (d) 6

124. _______ component(s) are important for marking CSS in HTML.
(a) Selector (b) Property (c) Value (d) all of them

125. Selector in CSS means _______.
(a) the browser (b) the tag which uses a particular CSS component (c) the property which is modified (d) the new value assigned to the given property

126. Property in CSS means _______.
(a) the browser (b) the tag which uses a particular CSS component (c) the property which is modified (d) the new value assigned to the given property

127. Value in CSS means _______.
(a) the browser (b) the tag which uses a particular CSS component (c) the property which is modified (d) the new value assigned to the given property

128. The format for applying CSS style to selector is _______.
(a) selector{property:value;}
(b) value{property:selector;}
(c) property{selector:value;}
(d) selector{value:property;}

129. _______ among the following CSS elements declares that headings shall have red colour.
(a) h1{color:red;}
(b) h2{color:red;}
(c) h1{color:blue;}
(d) body{bgcolor: gray;}

130. _______ among the following CSS elements declares that the entire document will be rendered in blue colour.
(a) *{color : blue;}
(b) h1{color:red;}
(c) *{color : blue;}
(d) body{bgcolor: gray;}

131. The method of applying CSS attribute using an identifier (number/alphanumeric) is called _______ selector method.
(a) class (b) attribute (c) ID (d) style

132. _______ CSS tag among the defines blue colour for headings having ID of blue.
(a) h1#blue {color:blue;}
(b) *{color : blue;}
(c) p#redpara{color:red; text-align:justified;}

Prepared by: Dr.V.Nagaradjane
133. ________ CSS tag among the defines red colour for all h2 tags enclosed in a block of red ID.
   (a) h1#blue {color:blue;}
   (b) #red h2 {color:red;}
   (c) p#redpara{color:red; text-align:justified;}
   (d) p#centerpara{color=blue; text-align=center;}

134. ________ CSS tag among the makes a paragraph justified and having red colour text.
   (a) h1#blue {color:blue;}
   (b) #red h2 {color:red;}
   (c) p#redpara{color:red; text-align:justified;}
   (d) p#centerpara{color=blue; text-align=center;}

135. ________ CSS tag among the makes a paragraph centre aligned and having blue colour text.
   (a) h1#blue {color:blue;}
   (b) #red h2 {color:red;}
   (c) p#redpara{color:red; text-align:justified;}
   (d) p#centerpara{color=blue; text-align=center;}

136. ________ in CSS applies given style to direct child elements.
   (a) Child selector
   (b) ID selector
   (c) class selector
   (d) none of them

137. ________ among the following child selector makes all paragraphs which are direct children of body HTML tag to have green text with justified alignment and bold style.
   (a) body > p{color : green; text - align = justified; font - style : bold}
   (b) table > td{color : green; text - align = center; font - style : italic}
   (c) ul > li{color : magenta; text - align = left; font - style : normal}
   (d) ol > li{color : magenta; text - align = left; decoration : underline}

139. ________ among the following child selector makes all items of an unordered list to have magenta colour text, left alignment and normal font style.
   (a) body > p{color : green; text - align = justified; font - style : bold}
   (b) table > td{color : green; text - align = center; font - style : italic}
   (c) ul > li{color : magenta; text - align = left; font - style : normal}
   (d) ol > li{color : magenta; text - align = left; decoration : underline}

140. ________ among the following child selector makes all items of an ordered list to have red colour text, left alignment and underline decoration.
   (a) body > p{color : green; text - align = justified; font - style : bold}
   (b) table > td{color : green; text - align = center; font - style : italic}
   (c) ul > li{color : magenta; text - align = left; font - style : normal}
   (d) ol > li{color : red; text - align = left; decoration : underline}

1.10.7 Applying CSS to HTML

141. CSS may be applied to HTML using
   (a) <link type = "text/css" rel = "stylesheet" href = "stylesheetname.css" > in the header section of HTML document
   (b) declaration through class and ID selectors
   (c) inline application of styles
   (d) all of them

1.10.8 Open source CMS

142. CMS in web content stands for
   (a) Content Maintenance System
   (b) Content Management Symbol
   (c) Content Management System
   (d) Client Management System

143. Open source stands for software for which ________
   (a) source code is available
   (b) source code is not available
   (c) source code is lost
   (d) source code is bugged
144. Joomla, wordpress, Apache Roller, OpenCMS, AmetysCMS, Dot CMS, Drupal, Django CMS, etc. are some of the ________ software packages.
(a) professional/paid
(b) escrow source
(c) none of them
(d) open source

Joomla

145. Joomla is a Content Management System based on ________ scripting language.
(a) Python    (b) PHP
(c) Ruby      (d) Perl

146. Joomla requires creation of a ________ in MySQL database for effective CMS with data support.
(a) database
(b) user
(c) both database and user
(d) none of them

147. To begin working with Joomla, the contents of the zip file need to be ________.
(a) deleted
(b) extracted to Downloads folder
(c) copied to the web server root directory (htdocs/html)
(d) divided into several pieces

Wordpress

148. Wordpress files need to be copied to ________ to start creating a website.
(a) Documents
(b) root directory of the web server
(c) Downloads
(d) Pictures

149. After copying Wordpress, the URL < wordpress_root >/______ should be opened to start the configuration process.
(a) index.html
(b) index.php
(c) readme.html
(d) wp-admin/install.php

1.10.9 Web authoring tools

Kompozer

150. KompoZer is a ________ tool.
(a) web page creation
(b) web page editing
(c) both a & b
(d) none of them

FrontPage

152. Frontpage is a ________ tool.
(a) web page creation
(b) web page editing
(c) both a & b
(d) none of them

153. Frontpage was part of Microsoft ________ package.
(a) Office
(b) Visual Studio
(c) Windows
(d) none of them

154. Frontpage was discontinued from Microsoft office version ________.
(a) 1997    (b) 2001
(c) 2003    (d) 2007

Answers (1682 - 1835)

1. (a)  2. (d)  3. (c)  4. (b)
5. (b)  6. (a)  7. (a)  8. (b)
9. (a)  10. (c) 11. (d) 12. (c)
13. (d) 14. (a) 15. (b) 16. (c)
17. (d) 18. (d) 19. (a) 20. (c)
21. (b) 22. (d) 23. (c) 24. (a)
25. (b) 26. (c) 27. (d) 28. (b)
29. (c) 30. (a) 31. (a) 32. (b)
33. (c) 34. (a) 35. (b) 36. (c)
37. (d) 38. (a) 39. (b) 40. (c)
41. (d) 42. (a) 43. (a) 44. (c)
45. (d) 46. (b) 47. (a) 48. (b)
49. (c) 50. (d) 51. (a) 52. (b)
53. (c) 54. (d) 55. (c) 56. (b)
57. (b) 58. (a) 59. (b) 60. (a)
61. (c) 62. (b) 63. (a) 64. (d)
65. (a) 66. (c) 67. (b) 68. (a)
69. (b) 70. (c) 71. (d) 72. (c)
73. (a) 74. (a) 75. (b) 76. (c)
77. (d) 78. (d) 79. (d) 80. (c)
81. (b) 82. (a) 83. (a) 84. (c)
85. (d) 86. (b) 87. (a) 88. (c)
89. (a) 90. (b) 91. (d) 92. (a)
93. (d) 94. (b) 95. (c) 96. (a)

Prepared by: Dr.V.Nagaradjane
97. (b) 98. (c) 99. (d) 100. (d) 101. (a) 102. (b) 103. (c) 104. (d) 129. (b) 130. (a) 131. (c) 132. (a)
105. (a) 106. (b) 107. (c) 108. (d) 109. (a) 110. (b) 111. (c) 112. (d) 133. (a) 134. (c) 135. (d) 136. (a)
113. (a) 114. (a) 115. (c) 116. (d) 117. (a) 118. (d) 119. (b) 120. (a) 141. (d) 142. (c) 143. (a) 144. (d)
121. (d) 122. (a) 123. (c) 124. (d) 145. (b) 146. (c) 147. (c) 148. (b)
125. (b) 126. (c) 127. (d) 128. (a)